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Safety Information
Important Information

NOTICE
Read these instructions carefully, and look at the equipment to become familiar with 
the device before trying to install, operate, or maintain it. The following special 
messages may appear throughout this documentation or on the equipment to warn 
of potential hazards or to call attention to information that clarifies or simplifies a 
procedure.
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PLEASE NOTE
Electrical equipment should be installed, operated, serviced, and maintained only by 
qualified personnel. No responsibility is assumed by Schneider Electric for any 
consequences arising out of the use of this material.

A qualified person is one who has skills and knowledge related to the construction 
and operation of electrical equipment and its installation, and has received safety 
training to recognize and avoid the hazards involved.
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About the Book
At a Glance

Document Scope
This manual presents the Web Designer for FactoryCast HMI software and 
describes the installation and operation.

NOTE: In this manual, the term "Web Designer" will be used for "Web Designer for 
FactoryCast HMI".

Validity Note
This documentation applies to Web Designer software.

The characteristics presented in this manual should be the same as those that 
appear online. In line with our policy of constant improvement we may revise content 
over time to improve clarity and accuracy. In the event that you see a difference 
between the manual and online information, use the online information as your 
reference.

Related Documents

You can download these technical publications and other technical information from 
our website at www.schneider-electric.com.

Title of Documentation Reference Number

FactoryCast HMI 1.7 User Manual 35007632

Communications Setup Manual TLX DS COMPL7 V4

Ethernet Network - Reference Manual TSX DR ETH

Modbus - User Guide TSX DG MDB
35016143 12/2011 9



Product Related Information
The information provided in this documentation contains general descriptions and/or 
technical characteristics of the performance of the products contained herein. This 
documentation is not intended as a substitute for and is not to be used for 
determining suitability or reliability of these products for specific user applications. It 
is the duty of any such user or integrator to perform the appropriate and complete 
risk analysis, evaluation and testing of the products with respect to the relevant 
specific application or use thereof. Neither Schneider Electric nor any of its affiliates 
or subsidiaries shall be responsible or liable for misuse of the information contained 
herein. If you have any suggestions for improvements or amendments or have found 
errors in this publication, please notify us. 

No part of this document may be reproduced in any form or by any means, electronic 
or mechanical, including photocopying, without express written permission of 
Schneider Electric.

All pertinent state, regional, and local safety regulations must be observed when 
installing and using this product. For reasons of safety and to help ensure 
compliance with documented system data, only the manufacturer should perform 
repairs to components.

When devices are used for applications with technical safety requirements, the 
relevant instructions must be followed. 

Failure to use Schneider Electric software or approved software with our hardware 
products may result in injury, harm, or improper operating results.

Failure to observe this information can result in injury or equipment damage.

Anyone who has access to a configuration tool and to your embedded server can 
override your security settings and download new settings to the 
server.Unauthorized or incorrect changes to data may change the behavior of your 
application in ways that may be undesirable or even hazardous.

WARNING
UNINTENDED EQUIPMENT OPERATION
Use only Schneider Electric software or approved software with our hardware 
products.

Failure to follow these instructions can result in death, serious injury, or 
equipment damage.
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User Comments
We welcome your comments about this document. You can reach us by e-mail at 
techcomm@schneider-electric.com.

WARNING
UNINTENDED EQUIPMENT OPERATION
 

Password-protect access to the embedded server.
Carefully select the symbols and direct addresses you authorize to be modified 
online.
Do not authorize online modification of variables of critical nature.

Failure to follow these instructions can result in death, serious injury, or 
equipment damage.
35016143 12/2011 11
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Introduction
Scope of this Chapter
This chapter introduces the Web Designer for FactoryCast HMI software. It shows 
you how to install it. It also provides you a description of the graphical interface. 

What’s in this Chapter?
This chapter contains the following topics:

Topic Page

Presentation 14

Preparing for Web Designer installation 16

Interface Presentation 17
13



Introduction
Presentation

Introduction 
Web Designer for FactoryCast HMI is a state-of-the-art software application with 
which you can create Web based operator panels and configure operating 
parameters for Web human machine interface (Web HMI) devices. It provides all the 
tools needed to design an HMI project, from the data acquisition to the creation and 
display of animated Web drawings.

Web Designer handles the following for the device website:
editing,
configuration,
modification.

Web Designer offers two levels of personalization:
the creation of a variable base of devices that can be viewed and modified in Web 
pages, 
the addition of your own Web pages on the device site.

Web Designer provides an interface to configure Services:

Devices
In the Schneider product range, Web Designer for FactoryCast HMI unites website 
configuration with services carried out in the coupling unit or device. A project can 
simultaneously manage several devices.

The following list indicates the devices managed by Web Designer for FactoryCast 
HMI. This list includes:

TSX WMY 100
140 NWM 100 00

Name Description

Email It sends notification periodically or when a specific event occurs.

Calculation It performs arithmetic and logical operations on a combination of variables.

Database It archives internal or processed data into a database.

Active Pages It enables you to create your own HTML pages that can be used to view 
variables in real time.

Datalogging It enables you to save information such as configuration, variable’s values, 
log files into a file system.

Recipe Used to change the values of a set of variables when a predefined event 
occurs.

Recipe 
Database

Used to update values of a set of variables with values contained in a 
database table when a predefined event occurs.
14 35016143 12/2011



Introduction
Simulation
Web Designer for FactoryCast HMI enables you to simulate devices in order to 
debug the application. This means you can verify the behavior of Web pages and 
services without being physically connected to the device or to the module.

Required configuration
To use this software at an optimal level, we recommend that your PC has the 
following configuration:

CPU 1GHz,

512 Mb RAM,

80 Mb Hard disk,

 800x600 screen,

Windows 2000 SP2, Windows XP Professional or Windows Vista Business,

Java Virtual Machine 1.4.2 minimum.

NOTE: For Windows XP or Windows Vista, you need administration privileges to 
install the Web Designer Software. You also need administration privileges to run 
the software under Windows Vista.
35016143 12/2011 15



Introduction
Preparing for Web Designer installation

Foreword
If a previous version of Web Designer is already installed, it must be uninstalled first 
(Web Designer offers to perform the uninstall for you if this is the case).

NOTE:  
Once installed, you can access Web Designer by clicking Start → All programs 
→ Schneider Electric → Vijeo Designer Suite → Web Designer.
For Windows XP or Windows Vista, you need administration privileges to install 
the Web Designer Software. You also need administration privileges to run the 
software under Windows Vista.

Installation
The installation procedure is as follows: insert the CD-ROM into the CD drive. The 
CD is Auto-run, therefore if your PC is set up for this feature you should see the 
Web Designer main window. If Auto-run is disabled or does not work:

Importing Previous Projects
Previous projects are visible in the navigator once Web Designer is reinstalled.

Step Action

1 Click Start → Settings → Control panel.

2 Click Add/Remove Programs in the Control Panel.

3 Click Add New Programs in the menu on the left, then CD-ROM and follow 
the instructions.

4 The Install Tool will automatically find the WebDesigner.exe program on the 
CD and will also display the path and file name then prompt you to perform the 
installation.
16 35016143 12/2011



Introduction
Interface Presentation

Main Window Contents
The following illustration describes the elements of the Web Designer main window:
35016143 12/2011 17



Introduction
6 main zones compose this screen which are: 

Navigator
This zone displays all the files and folders associated with existing projects. It 
provides an overall view of the application displayed as a file tree.

The following figure describes the navigator:

Zone Description

1 Menu (see page 298): list of options available.

2 Toolbar: shortcuts to frequently used functions.

3 Navigator (see page 18): it displays all the files related to the projects.

4 Editing zone: Web Designer uses this zone to edit, create or configure services 
associated with the project.

5 Console zone: list of the last errors detected. 

6 Information zone: it displays the connection status and the available memory of the 
selected module.

7 Site Explorer View: it displays all the target files.
18 35016143 12/2011



Introduction
3 main zones compose the navigator which are: 

Toolbar
The toolbar enables you to access the main functions of the program directly by 
clicking its icons.

The figure below shows you the toolbar:

The following table describes the elements of the toolbar:

Zone Description

1 This zone displays the name of the project as root directory. By clicking +, all the 
targets associated with the project appear.

2 This folder displays the name of the target associated with the project and its IP 
address. By clicking +, all the folders and files associated with the target appear.

3 5 main directories are visible for each target associated with the project:
Device: it displays the devices (CPUs connected to the module) associated with 
the target.
GraphicScreens: it contains pages created using the Graphic editor 
(see page 156).
DataTables: it contains tables created using the Data editor (see page 146).
Service: it displays the services created by the user (availability depending on the 
target).
Website: it contains all the website files for the project. You can therefore 
customize the website (see page 215) by changing these files or by adding your 
own pages.

Icon Function

New: by clicking the down arrow, you can:
create a new project,
add a target to the project,
add a device to the target,
create a new service,
create a folder,
create a file.

Open an existing project.

Save: save the currently edited window.

Save All: save all items modified in the project.
35016143 12/2011 19



Introduction
Cut: destruction of the selected object and putting it on the clipboard.

Copy: copy the object to the clipboard.

Paste: paste the clipboard.

Undo: cancel last action.

Find: open the Search window in which you can search for a text located in a 
file of the project.

Lookup: open the Lookup window in which you can search a variable.

Global Transfer: download all the project’s modules (and all the files).

Target -> PC: transfer a project from the target to the PC.

PC -> Target: transfer a project from the PC to the target.

Connection to the module: connect Web Designer to the target.

Connection to the local simulator: connect Web Designer to the simulator.

Disconnect: disconnect from the target or the simulator.

Statistics: view statistics for the selected service (incoming messages, 
outgoing messages, etc.).

Icon Function
20 35016143 12/2011



Introduction
Stop: shut down current service.

Run: start current service.

Icon Function
35016143 12/2011 21
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Getting Started
Scope of this Chapter
The purpose of this document is to show you the procedure for creating a 
Web Designer for FactoryCast HMI application.

What’s in this Chapter?
This chapter contains the following topics:

Topic Page

Presentation 24

Creating a New Project 25

Device Selection 26

Target Properties 28

Variable Selection 30

Email Service 32

Data Editor 38

Graphic Editor 41

Transfer 43

Accessing the Website 46
23



Getting Started
Presentation

Introduction
This getting started covers from project creation to visualizing it on a PC with a 
browser. The project is made with a TSX WMY 100 module and a Premium Unity 
PLC connected on the same rack. The Web server will be hosted by the 
TSX WMY 100 module, which will periodically scan the values of variables located 
in the PLC. The IP address for the module will be a.b.c.d. 

NOTE: If you use a 140 NWM 100 00 module instead of a TSX WMY 100, the 
procedures are identical.

Architecture
The following diagram shows the architecture of the getting started example:

The following table describes the elements of the example:

Reference Type Description

TSX WMY 100 Target Ethernet module

Premium Unity Device PLC
24 35016143 12/2011



Getting Started
Creating a New Project

 

Step Action

1 Click Project → New → Project.
Result: the Web Designer Project Creation Wizard window appears. 

2 Enter the project name (example) in the Project field.

3 In the target box, scroll over the drop down menu of the FactoryCast HMI and 
select the module you require (for example, TSX WMY 100) and click the > 
button.
Result: the chosen module appears in the Selected Target(s) box on the right.

4 Enter the Name of the target (WMY) in the Selected Target(s) box.

5 Enter the IP Address (a.b.c.d) in the Selected Target(s) box. For more 
information about IP addressing, refer to the FactoryCast HMI 1.7 User 
Manual.

6 Repeat steps 3 to 5 if you want to select more than one target.

7 Click Next.
Result: The second window of the Web Designer Project Creation Wizard 
appears.
35016143 12/2011 25



Getting Started
Device Selection

Introduction
For each target you can configure the devices that are connected to it.

Device creation
The following table shows how to attach devices to a target:

Step Action

1 Select a device in the Device List box and click the > button. 
Result: the device appears in Selected Target(s) Device(s).

2 In the selected Target(s)/Device(s) zone, enter the device name in the Name 
column and its address in the Address column. For more information about 
addressing refer to the FactoryCast HMI 1.7 User Manual.

3 If the device supports several protocols, enter the desired protocol in the 
Protocol column.

4 If you want to attach more than one target, repeat steps 1 to 4 until you have 
selected all devices required.

5 Click Finish.
Result: the project example appears in the browser.
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6 Save your project by clicking:

Step Action
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Target Properties

Introduction
Target properties allow you to:

change the name of the target and its address,
change the different passwords (see page 290) to access the device.

This example shows you how to manually configure the IP parameters for a 
TSX WMY 100. 

Accessing the Target Properties Page
You can access the Target Properties page in one of the following ways:

On the Web Designer browser, right-click the device name and click Properties.
On the Target menu, click Properties.

Result: the Target Properties window appears.

Setting Up the IP Parameters
Use the IP parameters area to define the IP configuration of the module.

Having two devices with the same IP address can cause unpredictable operation of 
your network.
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NOTE: In this example, we manually assign the a.b.c.d address to the module. For 
details about managing IP address, refer to the FactoryCast HMI 1.7 User Manual.

The following table shows how to manually configure the TSX WMY 100 module:

WARNING
UNINTENDED OPERATION — DUPLICATE IP ADDRESS
 

Make sure that this device will receive a unique IP address.
Always obtain your IP address from your system administrator to avoid the 
possibility of duplicate addresses.

Failure to follow these instructions can result in death, serious injury, or 
equipment damage.

Step Action

1 Access the Target Properties page.

2 Enter the IP address for the TSX WMY 100 in the IP Address field.

3 Click OK to validate.

4 Save the new configuration by clicking:
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Variable Selection

Introduction
The Select Symbol window lets you configure the variables for various devices that 
can be used in website pages.

All device variables used in a project are grouped in a file called Namespace. The 
Data Editors and Graphic Editors as well as the Services in a project use variables 
in this Namespace.

Types of Symbols
For Premium Unity PLCs, symbols that can be used come from the PLC application 
(.stu or .xvm file type). 

Selecting PLC Symbols
The following table shows how to select PLC symbols:

Step Action

1 In the browser, extend the menu tree in the example.

2 In the Devices directory, double-click a PLC type device (Premium Unity in our 
example).
Result: 

3 Click Import PLC symbols.
Result: the Open window appears.

4 Select the (.stu or .xvm) file in which the application symbols are.
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Namespace
By clicking the Namespace file of the project in the browser, a table that groups all 
symbols previously selected for targets or devices appears.

5 Click Open.
Result: the Select Variables to Import window appears.

6 Select the required symbols by double cliking the 1st column.

7 Click Import Selected Variables.

8 Save the project by using the menu Project → Save All. 

Step Action
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Email Service

Introduction
The email service is used to send an email when an alarm is triggered, for example, 
when there is a change in the status of a variable or a threshold is overrun.

NOTE:  
Web Designer for FactoryCast HMI enables you to configure other Web HMI 
services such as:

Calculation
Database
Datalogging
Active Pages
Recipe
Recipe Database

For more information on Services configuration refer to the Service chapter 
(see page 91).
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Creating an Email Service
The table below describes how to create an email service:

Step Action

1 Click the name of your project in the browser.

2 To add the new service you can:
Click Project → New → Service or,
Right-click the Services directory in the browser, then click New Service.

Result: the following window appears.

3 Select Email in the Service Type list box.

4 Enter the service name, or click Finish to keep the name by default.
Result: the Email Service configuration window appears.
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Email Configuration Window
The configuration properties screen for the email service is shown below:

1 This button is used to configure emails sent by the email service.
2 This button is used to configure email properties.

Sending an Email
First of all, you must create the email to be sent. It is almost the same procedure as 
writing a normal email except that you need to define a trigger event. The procedure 
below shows you the steps needed to create such an email:

Step Action

1 Type a name for the email in the Identifier field.
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2 Select the variable that will trigger the email by clicking: 

Result: the Variable Selection window appears.

3 Select the variable that will trigger the email.

4 Click Validate.

5 Select the type of event that will trigger the email:
NY (Notify): Triggered by bit status change or word value change.
RE (Rising Edge): Triggered by a rising edge bit or by an increasing word 
value.
FE (Falling Edge): Triggered by a falling edge bit or by a decreasing word 
value.
BQ (Bad Quality): Triggered if the trigger status is Bad quality.

6 Type the email address of the recipient in the Destination field.

7 Type the subject of the email in the Subject field.

8 Type the body of the email in the Content field.
Result: the email appears in the email table in the bottom of the screen.

9 You can attach a file to the email by clicking:

 
Specify the file path of the file in the Path field.

Step Action
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Access Parameters
To configure the access parameters for the email service, follow the procedure 
below: 

Step Action

1 Click the properties tab.
Result: the email properties window appears.

2 Type the address of the email (SMTP) server in the SMTP Server Address field.
Note: the SMTP Server Port field is unavailable and thus cannot be modified.

3 Select the Require Secure Authentication box if access to the server is protected.
In this case, fill in the Login and Password fields.

4 Type a Sender Address which will identify the module when the user receives the 
email.

5 Type a Reply Address to which a reply will be sent if the user clicks the Reply 
button.

6 Define the maximum number of emails that can be stored in the buffer memory 
before being sent by filling in the Maximum Size of Send Queue field:

Default value = 100,
Minimum value = 30,
Maximum value= 200.

7 Specify the delay before emails stored in the buffer memory are re-sent after 
interruption in the Time Before Retry to Send field.
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8 Finally, select a variable to determine the status of the email service in the Service 
status variable field.

9 Save the new email service by clicking:

Step Action
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Data Editor

Introduction
Data Editor enables you to create Web pages in which the values of variables are 
displayed in table format. In certain cases these values can be modified by the user.

Allowing write access can change system behavior.

Selecting Editor Symbols

WARNING
UNINTENDED OPERATION
 

Make sure variables that can be written are accessible by trained personnel 
only (password protect).
Do not give write access to critical control variables.

Failure to follow these instructions can result in death, serious injury, or 
equipment damage.

Step Action

1 In the browser, extend the menu tree in the example.

2 Right-click the DataTables directory to open the contextual menu and choose 
New Table.

3 In the Table Name field, enter a name for the data table.

4 Click OK.
Result: An empty data table appears.
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5 To access the configuration zone:
Double-click a line of the Table window,
Or right-click the Table window to open the contextual menu and choose 
New.

Result: The configuration zone appears.

6
Click , to obtain a list of available symbols. 
Result: The search panel for symbols appears.

Note: The list corresponds to the variables coming from the devices connected 
to the target.

Step Action
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7 Select the symbols that you wish to monitor.

8 Click OK.

9 Save your table by clicking:

Step Action
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Graphic Editor

Introduction
The Graphic Editor enables you to create Web pages in which the values of 
variables are displayed as graphic objects, such as VU meters, indicators, etc.

Some graphic objects allow values to be entered. In this case, the variable must be 
write authorized and, in order to be able to use it, the user must have entered the 
write authorization password. 

In the configuration phase, the Graphic Editor allows you to edit and view screens 
at the same time. In the operation phase, you can only visualize one screen at a time 
in order to optimize memory resources.

Selecting Graphic Objects
The following table shows how to open the Graphic Editor:

Step Action

1 In the menu tree, select the target.

2 Right-click the GraphicScreens directory to open the contextual menu and 
choose New Graphic Page.
Result: the Graphic Editor panel appears.

3 Click Edit.

4 Select graphic objects from the Graphic Editor toolbar on top of the screen.

5 Click the sub-window under the main window to place them.

6 Open the Properties window by double-clicking on the graphic object.

7 You can specify a name, a label, the data type and many other parameters. 

Click  on the right of the Address field to associate a variable with the 
object.
Result: the Lookup Variables window appears.

8 Select the variable that you want to associate with the object.
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9 Repeat steps 4 to 8 to add other objects.

10 Once you have finished, click Done.

11 Click Save and enter a name for the graphic (graph).

Step Action
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Transfer

Introduction
Once you have completed the site construction on the configuration PC, you should 
transfer it to a target.

Transferring the Website to a Target

Step Action

1 Select TSX WMY 100 in the menu tree.

2 Click Target → Transfer → PC ->Target. 
Result: the Target Validation window appears.

If there are detected errors in your project, the transfer cannot be performed. 
Refer to the Project Validation part (see page 69) for more information.
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3 Click OK.
Result: the Transfer Status window appears.

Note: if there are differences between the firmware version of the project and 
the target, the transfer cannot be performed.

Step Action
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4 Click Transfer.
Result: the Configuration Password window appears if a configuration 
password has already been set. Otherwise the project is transferred.

5 Enter the configuration password and click OK.
Result: the Progress Information window appears. The files are displayed one 
at a time in the Status Bar.

Step Action
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Accessing the Website

Introduction
At this time, you have:

created a project,
selected the devices and the variables of your choice,
created data and graphic table to monitor the installation,
transferred your application from the PC to the target.

The last step consists of connecting to the website. The Data Editor and the Graphic 
Viewer are used to view graphic animation pages related to the device variables or 
internal module variables.

Accessing the Website

Step Action

1 Open a Web browser.

2 Type the IP address of the module in the address bar. In this example, we set 
the IP address of the module to a.b.c.d (see page 25). Therefore type a.b.c.d in 
the address bar.

3 Click Go.
Result: the module website appears.

4 Click Monitoring on the horizontal menu bar of the website.
Result: the monitoring home page appears.
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5 Click Data Editor on the vertical menu bar of the website to see the animation 
tables created with the Data Editor.
Select the table created previously on the left side of the Data Editor applet and 

click  to launch the animation.
The following figure shows the Data Table:

Step Action
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6 Click Graphic Viewer on the vertical menu bar of the website to see the 
animation pages created with the Graphic Editor.
The following figure shows the graphics page:

Step Action
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Scope of this Chapter
This chapter explains how to manage a project. It concerns: 

Modifying a project,

Opening and closing a project,

Importing a project from a file.

What’s in this Chapter?
This chapter contains the following topics:

Topic Page

Adding/Removing Targets 50

Adding/Removing a Device 52

Adding/Removing Items 54

Opening/Closing a Project 56

Import 57

Importing a FactoryCast Project and Web Site into Web Designer 58

Upgrading the Target Version of a Project 62
49
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Adding/Removing Targets

Adding a New Target

Step Action

1 Select a project.

2 Click Project → New → Target.
Result: the Web Designer Project Creation Wizard opens, initialized with 
targets that already exist in the project.

3 In the Target List, select the targets to add.

4 Click [>].
Result: the new target appears in the Selected Target(s) list.

5 Type a name and an address for that target.

6 Click Next.
Result: the device selection wizard appears.
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Window Fields
The following table gives a description of the elements of the Web Designer Project 
Creation Wizard window:

The button > enables you to add one of the targets in the list. The button < enables 
you to remove a target in the list.

Deleting a Target
To remove a target from the project, right-click the target in the navigator to open the 
contextual menu and select Delete.

NOTE: If you delete a target of the project, all the files associated with that target 
(including devices) are also deleted.

Number of Targets
A project can contain up to 16 targets. It’s possible to select the same type of target 
several times, on condition that you attribute a different name and IP Address for 
each target.

Field Function

Project Project name.

Target List List of available targets.

Target Target types selected in the Module List.

Name Target Name, to distinguish targets of the same type.

Address IP address of the target.
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Adding/Removing a Device

Adding a Device

NOTE: If you have more than one target in your project, select the target in the 
Target List to which you want to attach the device before achieving step 3.

Step Action

1 Select the Devices directory of your project.

2 Click Project → New → Device, or
Right-click the Devices directory and then click New Device.
Result: Web Designer Project Creation Wizard window appears, initialized with 
devices that already exist in the project.

3 Select the devices to add in the Device List field and validate with the button >.

4 Type a name and an address for that device.

5 Click Finish to validate the project targets and devices.
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Window Fields
The following table shows the fields in the Web Designer Project Creation Wizard 
for the Device window.

Removing a Device
To remove a device from the project, right-click the device in the navigator to open 
the contextual menu and select Delete.

NOTE: When you delete a device, all variables relating to the Namespace of the 
device are also deleted.

Device selection
The maximum number of selectable devices for a target depends on the type of 
target. Each target must have at least one device.

If your using a TSX WMY 100, you can select a maximum of 5 devices. Those 
devices must belong to the same family products (Premium or Premium Unity). 

If your using a 140 NWM 100 00, you can select only 1 device. 

Module Device
For a target in a rack, the default address is localhost.

Protocol
You can associate one or several protocols with each device. When a device 
supports several protocols, the protocol column is active and the user can choose 
one from the list. The address in the previous column depends on the protocol 
selected.

Field Function

Target List List of targets created in the previous panel.

Device List List of available devices.

Selected 
Target(s)/Device(s)

Device selected (from the Device List).

Name Name given to the device to distinguish it from other devices of the 
same type.

Address Address of the Target device.

Protocol Protocol supported by the device (the Protocol List is determined by 
the type of device).
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Adding/Removing Items

Presentation
The following pages show how to add elements of the following type to the project:

Data Tables,

Graphic Pages,

Services,

Folders,

Files.

Adding a Graphics Page
The following table shows how to add a graphics page:

Adding a Data Table
The following table shows how to add a Data table:

Adding a Service
The following table shows how to add a service:

Step Action

1 Select the project.

2 Select the sub-directory GraphicScreens in the target directory.

3 Click Project → New → Graphic, or 
Right-click the GraphicScreens directory and click New Graphic Page.
Result: The Graphic Editor opens with a blank page to edit.

Step Action

1 Select the project.

2 Select the sub-directory DataTables in the target directory.

3 Click Project → New → Data, or
Right-click the DataTables directory and click New Table.
Result: The Data Editor opens with a blank table.

Step  

1 Select the target.

2 Click Project → New → Service, or
Right-click the Service directory and click New Service.
Result: A window opens with a list of services that can be created.
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Adding a Folder
The following table shows how to add a folder:

 
NOTE: you cannot create new folders outside of the Website menu tree.

Adding a File
The following table shows how to add a file:

 
NOTE: You cannot create new files outside the Website menu tree.

Removing Items
To remove an item from the project, right-click the item in the navigator to open the 
contextual menu and select Delete.

3 Select the desired service from the list.

4 Click OK.
Result: The Service window opens.

Step  

Step Action

1 Select one of the Website folders or Website itself.

2 Click Project → New → Folder, or
Right-click the Website directory and click New → Folder.
Result: The Create a Folder window opens.

Step Action

1 Select one of the Website folders or Website itself.

2 Click Project → New → File, or
Right-click the Website directory and click New → File.
Result: The Create a File window opens.
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Opening/Closing a Project

Presentation
This section shows how to:

open/close a project,
save a project,
close Web Designer for FactoryCast HMI.

Opening an Existing Project

Closing a Project

Saving all Modifications
To save all modifications made, select Save All in the project menu or click the save 
all icon in the tool bar. This operation saves all modifications made in open windows. 
These modifications cover all open projects.

Closing Web Designer
When you close Web Designer for FactoryCast HMI, it memorizes the open or close 
state of projects. Projects that are open when you close Web Designer for 
FactoryCast HMI will automatically reopen the next time you launch the software.

Step Action

1 Click Project → Open Project. 
Result: the Open Project window opens. This window displays the list of 
projects in the workspace.

2 Select a project.

3 Click Open. 
Result: the project appears in the menu tree.

Step Action

1 Select the project.

2 Click Project → Close Project. 
Result: the project disappears from the menu tree.
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Import

List of sources 
Web Designer for FactoryCast HMI can import a project from the following sources 
to recuperate previous developments:

a .zip file exported by Web Designer for FactoryCast HMI,
a Web Designer for FactoryCast HMI project outside the Workspace,
a FactoryCast HMI project.

Import
To import a project, click Project → Import.
Import window:

After import, the project appears in the menu tree.

FactoryCast
The .cfg files used for importing a FactoryCast project do not describe the type of 
module used. Web Designer  therefore gives you a list of available modules.

Export
To export a project as a .zip file, click Project → Export. This function is useful for 
saving a complete project before modifying it. The project stays open after being 
exported.
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Importing a FactoryCast Project and Web Site into Web Designer

Introduction
You can use Web Designer to import a project—including its embedded web site—
that was created with the FactoryCast Configurator tool. The import process 
consists of three parts:

Using the FactoryCast Configurator tool:
save the project as a configurator (.cfg) file
back up the web site as a compressed (.zip) file

Using Web Designer, import both the saved configurator file and the compressed 
web site

The steps to accomplish these tasks are described below.

Saving the FactoryCast Configurator File using the FactoryCast Configurator Tool
Follow these steps to save a configurator (.cfg) file using the FactoryCast 
Configurator tool:

Step Action

1 Open the project you want to save in the Factory Cast Configuration tool.

2 Select File → Save As to open the Save As dialog.

3 Use the Save As dialog to save the project to the desired location.
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Backing Up the Web Site using the FactoryCast Configurator Tool
Follow these steps to back up the web site that is associated with the saved 
configurator file using the FactoryCast Configurator tool:

Step Action

1 With the project still open in the Factory Cast Configuration tool, select 
Transfer → Backup to open the Backup dialog:

2 In the Target Host section, type in the Host name or IP address of the device 
on which the web site resides.

3 In the Archive File section, type in (or click the ellipsis to open a dialog where 
you can select) the Path and file name (*zip) where the files are to be saved.

4 Click OK to close the Backup dialog. 
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Importing the FactoryCast Configuration and Web Site Using Web Designer
Follow these steps to use Web Designer to import both the FactoryCast 
configuration file and the Web Site you previously saved:

Step Action

1 In Web Designer, with no project open, select Project → Import to open the 
Import dialog:
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2 Select Factory Cast project then click Next, as shown above. 
The Import Project From File System dialog opens:

3 Use the Import Project From File System dialog to perform the following tasks:

i In the Project contents field, type in (or click the Browse... button to 
navigate to and select) the path and name of the FactoryCast 
configuration file you want to import.

ii In the module list, select the Factory Cast module to which you want to 
import the Factory Cast configuration.

iii (Optional) To import a web site, select Association of Web site, then in 
the Zip file field, type in (or click the Browse... button to navigate to and 
select) the path and name of the compressed web site files you want to 
import to the selected module.

iv Click Finish.

Step Action
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Upgrading the Target Version of a Project

Presentation
The Upgrade Target Version function enables you to easily upgrade your target from 
its current version to the latest version available. It updates the website, services 
and monitoring features remain identical.

NOTE:  
The Upgrade Target Version is only available if a more recent version of your 
target exists.
Once upgraded to the last version, the target cannot go back to a prior version

Upgrading Target Version

Step Action

1 Select the target you want to upgrade in the navigator.

2 Click Target → Upgrade Target Version.
Result: the Confirm Update dialog box appears.

3 Click OK.
Result: the Progress Information window appears.

4 Once the upgrade is finished, the Progress Information window disappears and 
the Upgrading Successful dialog box appears.
Click OK.
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Subject of this Chapter
This chapter describes how to transfer a website. You can transfer it from the 
configuration PC to the module or vice-versa. The transfer concerns the Web pages 
generated by Web Designer for FactoryCast HMI as well as those created by the 
user. The transfer can be more general and it can include files describing services.

What’s in this Chapter?
This chapter contains the following topics:

Topic Page

Transfer 64

Project Validation 69

Connecting/Disconnecting to/from the Module 72
63
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Transfer

Introduction
These functions enable you to transfer the Data Editor tables, the Graphic Editor 
pages, the services, the website and its associated files, either from the 
configuration PC to the target, or from the target to the configuration PC. You must 
previously advise the target address. Web Designer for FactoryCast HMI carries out 
a validation on the structure of the project before transferring files to the target. 

Setting Up the IP Address
You must set the IP address of the module to perform a transfer. The following table 
shows how to advise the physical address of the module. Having two devices with 
the same IP address can cause unpredictable operation of your network.

WARNING
UNINTENDED OPERATION — DUPLICATE IP ADDRESS
 

Make sure that this device will receive a unique IP address.
Always obtain your IP addresses from your system administrator to avoid the 
possibility of duplicate addresses.

Failure to follow these instructions can result in death, serious injury, or 
equipment damage.

Step Action

1 Select the target in the browser.

2 Click Target → Set Target Address.
The following window appears:

3 Enter an IP Address.

4 Click Validate.
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NOTE: You can also advise the address during the creation of the project with the 
Creation Wizard.

Transferring from the PC to the Target
The following table shows how to transfer data to the module:

Step Action

1 In the browser, select the target.

2 Click Target → Transfer → PC ->Target. 
Result: the Target Validation window appears.

If there are detected errors in your project, the transfer cannot be performed. 
Refer to the Project Validation part (see page 69) for more information.

3 Click OK.
Note: if there are differences between the version of firmware for the project 
and the target, the transfer cannot be performed.
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4 The Transfer Status window appears:

5 Select the files you want to transfer.

6 Click Transfer.
Result: the Configuration Password window appears if a configuration 
password has already been set. Otherwise the project is transferred.

Step Action
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Transferring from the Target to the PC
The following table shows how to transfer data from the module to a PC:

7 Enter the configuration password and click OK.
Result: the Progress Information window appears. The files are displayed one 
at a time in the Status Bar.

Step Action

Step Action

1 In the browser, select the target.

2 Click Target → Transfer → Target ->PC. 
The Transfer Status window appears:

3 Select the files you want to transfer.
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Global Transfer 
This function lets you transfer the entire project to all the targets associated with it. 
The transfer is done target by target. The global transfer only works in 1 way, you 
can transfer from the PC to the targets but not from the targets to the PC. In the last 
case, you have to manually transfer the files target by target.

To activate the transfer, click Project → Global transfer. The procedure is exactly 
the same than a transfer from the PC to the target (see page 65). 

Partial Transfer
To save time, it’s possible to do only a partial transfer. In the Website, gdt (graphic 
pages), rdt (data tables) and Service directories, the contextual menu authorizes a 
partial transfer limited to files located in these directories. In this way, you don’t have 
to transfer the entire project if you just modified a small part.

Documentation
To manage online documentation, the user can add Word (.doc) or Acrobat (.pdf) 
files to the website in the site directory. The Transfer function lets you copy these 
files to the target.

Site Explorer
The Site Explorer View tab displays all the target files in the lower window. This is 
especially useful before or after a data transfer, in order to analyze the contents of 
the target.

4 Click Transfer.
Result: the Configuration Password window appears if a configuration 
password has already been set. Otherwise the project is transferred.

5 Enter the configuration password and click OK.
Result: the Progress Information window appears. The files are displayed one 
at a time in the Status Bar.

Step Action
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Project Validation

Introduction
Web Designer carries out a validation on the structure of the project before 
transferring files to the target. If the verification detects anomalies, the transfer is 
cancelled. Web Designer also performs a comparison between the PC configuration 
and the target configuration.

Validating a Project
When you start a transfer, Web Designer performs a project validation. You can also 
validate a project at any time by selecting Project Validation in the Project menu.

The Project Validation window looks like this:

The validation process monitors the following points:
the available space on the target is bigger than the size of the website,

the use of a user page or a service, with variables that will not be in the 
Namespace (file Namespace.dat),
the number of variables is less that the maximum number authorized for the 
target (1000 variables),
the detected errors related to services.

Click a line with a message to display the details of detected errors encountered.
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Transfer Status
The following figure shows the Transfer Status window:

The information has not been found on the remote target. 

Inconsistent, non-blocking information between the target and the PC. 

Inconsistent, blocking information between the target and the PC. 

Consistent information between the target and the PC. 
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Use the Select area to specify the files you want to transfer: 

Parameter Action

Transfer Website Select this box to transfer files located in the Website directory.

Transfer only Modified 
Files

Select this box to transfer only files of the website that have been 
modified since the last transfer.

Transfer DataTables 
and GraphicScreens 
Files

Select this box to transfer data tables (rdt directory) and graphic 
pages (gdt directory).

Transfer Configuration 
Files

Select this box to transfer configuration files. This feature is not 
available for FactoryCast HMI modules.

Destination Specify the media on which the files will be transferred. This 
feature is not available for FactoryCast HMI modules.
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Connecting/Disconnecting to/from the Module

Introduction
The information below explains the procedure for executing an application once the 
services have been created.

Transferring a project to the module permanently erases the existing project. When 
a project is transferred, the old project is overwritten.

Anyone who has access to Web Designer for FactoryCast HMI can modify the value 
of PLC variables that have been write enabled and also modify your security 
settings. Unauthorized or incorrect changes to data change the behavior of your 
application or your process in ways that can be undesirable or even hazardous.

NOTE: if an application is in RUN mode, the new project will be taken into account 
after a module reboot.

WARNING
UNAUTHORIZED SECURITY ACCESS
 

Change or disable default passwords on all devices, since default settings are 
often easy to find in user manuals.
Change your passwords monthly.
Do not choose simple user names and passwords. 

Failure to follow these instructions can result in death, serious injury, or 
equipment damage.

CAUTION
LOSS OF DATA
Backup important information before transferring a new application.

Failure to follow these instructions can result in injury or equipment damage.
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Transfer
Connecting to the Module and Recovering a Project from the Module
The following table shows the procedure for connecting to the module with a view to 
recovering its application:

Disconnecting from the Module
The following table shows the procedure for disconnecting from the module:

Step Procedure

1 Select the target in the browser.

2 Click Target → Connect → Target.
Web Designer for FactoryCast HMI analyses the changes between your project 
and the module content.
If you have modified the project, the software will ask you to transfer the project. 
Otherwise the application moves automatically to online mode.
Result: the Configuration Password window appears if a configuration 
password has already been set. Otherwise Web Designer connects to the 
module.

3 Enter the configuration password and click OK.
Result: Web Designer connects to the module.

Step Function Procedure

1 Disconnecting 
from the 
module

Click Target → Disconnect. 
Result: Web Designer for FactoryCast HMI has just switched 
back to offline mode.
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Simulation Mode
Scope of this Chapter
This chapter describes the simulation mode. It is a question of debugging the data 
tables, graphic pages and services without being connected to the target. 

What’s in this Chapter?
This chapter contains the following topics:

Topic Page

Simulation 76

Connecting/Disconnecting to/from the Simulator 79
75



Simulation Mode
Simulation

Objective
You can simulate your website or your application without using actual devices. This 
allows you to verify your configuration and test the behavior of your application even 
if devices are not yet available.

Simulation Mode
Simulation Mode is available with protocols:

UMAS,
UNITE,
Modbus.

Simulation Mode enables you to test the behavior of your application without running 
it in the module. In this case, the application runs in the configuration PC. 

The user can enter pertinent values for variables (symbols). The default values are 
set to zero. The values are entered manually in the window associated with the 
device (double-click the device in the menu tree) or they can be automatically 
incremented.

Using the Simulator Icon
The following table shows how to use the simulator icon:

Use of Simulator for Data Tables and Graphic Pages
The following table describes how to use the simulator with Data Tables and Graphic 
Pages:

Step Action

1 In the task bar, right-click on the simulation icon .

2 If you check AutoIncrement the variables will be automatically incremented.
If you uncheck AutoIncrement, the variables will no longer be incremented and 
you can modify the value of R/W variables.
If you check StopServer, the simulation stops.

Step Action

1 Select a target in a project.

2 Extend the target directory.

3 Select a table in the DataTables directory or a graphic in the GraphicScreens 
directory.
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Simulation Mode
4 Right-click and select Open.
Result: an Internet Explorer window appears in which the selected table 
appears or the drop-down menu to select the graphic.

5 For graphics, select a graphic in the drop-down menu.
Result: the following figure shows an example of a graphic being simulated.

6 Apply the values to simulate to the variables or the graphic objects.

Step Action
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Simulation Mode
Use of Simulator for Device windows
The following table describes how to use the simulator with variable and device 
windows:

Step Action

1 Double-click the desired device in the Devices directory. 
Result: the following window appears.

2 Click Animate persistent.
If the AutoIncrement function is checked, the variables are automatically 
incremented. In the Value column, the simulated values are displayed.
Else, the variables are no longer incremented. For R/W variables, double-click 
the Value column to modify the values.
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Simulation Mode
Connecting/Disconnecting to/from the Simulator

Introduction
The following information describes the operating mode for launching an application 
through the simulator.

The simulator enables you to execute an application without having to connect to a 
module. It is therefore possible to test the application from a PC before transferring 
it to the module.

NOTE: The graphic and data editors (see page 145) are both active in simulation 
mode. You can therefore modify these pages in simulation mode.

Once the changes are made, carry out a part transfer in order to reduce transfer 
time.

Connecting to the Simulator
The following table shows the procedure for connecting to the simulator and 
transferring the application:

 
NOTE: Simulation does not work if a FTP server is running on the system.

Disconnecting from the Simulator
The following table shows the procedure for disconnecting from a module:

Animations
In simulation mode, the variables are animated as follows (value update frequency 
depends on the update frequency setting):

bit: value change, 0 or 1,
word: increment step 1.

Step Procedure

1 Select a target in a project.

2 Click Target → Connect → Simulation.
You are now connected to the simulator, the application is in simulation mode.

Step Procedure

1 Click Target → Disconnect → Simulation. You have just switched back to 
configuration mode.
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Managing Variables
Subject of this Chapter
This chapter explains how Web Designer for FactoryCast HMI handles variables. 
This concerns importing variables, either from a file describing a piece of equipment, 
or from a file exported by software from the automated program, listing variables 
from the automated program. 

This chapter also presents the file called Namespace which groups all these 
variables. The data and graphics publishers as well as services use these variables.

What’s in this Chapter?
This chapter contains the following topics:

Topic Page

Namespace 82

Importing from a Programmable PLC 83

Manual Edit 87

Author Rights in Namespace 88
81



Managing Variables
Namespace

Introduction
Namespace groups all variables (symbols) previously selected for targets or 
devices. Data Editors, Graphic Editors, and services get symbols from Namespace.

Variables come from either connected devices or from PLC applications. If you 
connect a device type to the same target several times, compose the name as 
follows in order to have a unique name: device.name, variable name. If the device 
is a PLC, compose the names of variables declared in the PLC like this: PLC 
device.name, PLC variable name.

Accessing the Namespace

Step Action

1 Select the project.

2 Extend the target directory.

3 Double-click the Namespace icon. 
Result: the Namespace window appears.
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Managing Variables
Importing from a Programmable PLC

Introduction
It is possible to access databases with the function Import Symbols:

PL7,
Concept,
Unity Pro.

NOTE: 
Depending on the devices that you connect to the target, the type of variables you 
can access through the target might be different. Refer to the FactoryCast HMI 
1.7 User Manual for more information on supported variables.
The number of variables stored in the namespace is limited to 1,000.

Accessing the Software Database
The following table shows how to access the software database:

Step Action

1 Double-click the desired device in the Devices directory. 
Result: the following window appears.

Symbol Name of the variable.
Variable Address of the variable.
Type Type of variable.
Access Access right to the variable.
Persistent Access mode to the variable. It cannot be changed.
Rate Frequency at which the variable value will be refreshed.
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Managing Variables
2 Click Import PLC symbols. 
Result: a file explorer window opens.

3 Select the file to import. The types of files supported are: .prj, .fef, .xvm, .stu.

Step Action
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Managing Variables
4 Click Open.
Result: a window displaying symbols opens.

5 Select the variables you want to import by double clicking the variables in the 
list.
Note: Select the ReadOnly box if you want the variable to be read only, 
unselect it if you want the variable to be write enabled.

6 Click Import selected variables.
Result: the variables appear in the Device window.

Step Action
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Managing Variables
Description of the Window
The following table shows the buttons in the preceding window:

Accessing the Concept Base
In order to access a Concept database, you must install the Concept software on 
your computer. Concept database files have a .prj extension. 

NOTE: You must set the ExportVariables parameter to 1 in order to be able to import 
Concept variables. This parameter is located in the concept.ini file. It has to be done 
before saving the project in Concept. 

Accessing the PL7 Base
A PL7 database is accessible from any allocated drive. PL7 database files have a 
.fef extension. 

Accessing the Unity Pro Base
In order to access a Unity Pro database, you must install the Unity Pro software on 
your computer. Unity Pro database files have .stu extension. It’s also possible to use 
an Unity Pro export file (extension .xvm).

Button Function

Remove Delete the variable.

Duplicate Duplicate the variable.

Import PLC Symbols Open a selection window of variables.

Animate persistent This button is used to switch to animation mode. You must be 
connected to the module or in simulation mode.

Import from CSV Import all the variables from a CSV file.

Export to CSV Export the variables to a CSV file.
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Managing Variables
Manual Edit

Presentation
You can manually add variables by directly entering a symbol, an address, its type 
and define the access right in the Variables window of each device.

NOTE: Depending on the devices that you connect to the target, the type of 
variables you can access through the target might be different. 

Automatic Input
Automatic Input is an option that makes easier the manual creation of variables by 
incrementing the value of the last record.

If you select this option, the value of the fields is automatically filled when you add a 
new variable. The values correspond to those of the previous line incremented by 1.

Activating / Desactivating Automatic Input:

Options → Automatic Input
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Managing Variables
Author Rights in Namespace

Presentation
This table enables you to specify which variables can be accessed in read/write 
mode.

NOTE: Write access is controlled by a password (Security) whose default value is 
USER.

Unauthorized or incorrect changes to data may change the behavior of your 
application in ways that may be undesirable or even hazardous.

WARNING
UNAUTHORIZED CHANGES TO VARIABLES OR DIRECT ADDRESSES.
Carefully select the variables (symbols) and the direct addresses you authorize to 
be modified online, and the people authorized to do so.

Failure to follow these instructions can result in death, serious injury, or 
equipment damage.
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Managing Variables
Managing Author Rights 
Use the following procedure to manage author rights:

Step Action

1 In the navigator: 
double-click the NameSpace Write Access file or,
rigth-click the NameSpace Write Access file and select Open.

Result: the Window manager for author rights in Namespace appears.

2 Define the intervals at which variables can be written. Outside these intervals, variables with direct 
access are only accessible to read.
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Services
Scope of this Chapter
This chapter describes all the built-in FactoryCast services:

Email,
Calculation,
Database,
Active Pages,
Datalogging,
Recipe,
Recipe Database.

NOTE:  
The maximum number of services for

a 140 NWM 100 00 module is 6.
a TSX WMY 100 module is 7.

What’s in this Chapter?
This chapter contains the following topics:

Topic Page

Email Service 92

Calculation Service 98

Database Service 103

Datalogging Service 111

Active Pages Service 118

Recipe Service 124

Recipe Database Service 130

Service Status 140
91



Email Service

General
Use the Email service to send an email if an alarm is triggered, if there is a change 
in the status of a variable, or if a threshold is overrun, for example.

You can associate Email service with variables coming from your Namespace or the 
calculation service.

NOTE: Schneider Electric does not guarantee:

integrity of data sent by the module with the email or SMS service,
the exactness of the time at which the message has been sent.

Configuration properties screen for Email service:

1 Use this button to configure Emails sent by the email service.
2 Use this button to configure Email properties.
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Creating an Email Service
The table below describes how to create an Email service:

Step Action

1 Click the name of your project in the browser.

2 To add the new service you can:
Click Project → New → Service or,
Right-click Services in the browser, then click New Service.

Result: the following window appears.

3 Select Email in the Service Type list box.

4 Enter a service name or click on Finish to keep the name by default.

5 The Email service has been created. 
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Configuring the Server
The following table introduces you the properties configuration screen of the Email 
service:

The following table introduces you the properties configuration screen:

Fields Function

SMTP server

SMTP server address Address of the SMTP server.

SMTP server port TCP port used by the SMTP server (generally port 
25).

Secure Authentication Select this box if authentication is needed to access 
the SMTP server.

Login Login to access the SMTP server.
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NOTE: When the maximum number of mails is reached (100), no further messages 
can be stored. 

Configuring the Email Service
The Email configuration screen is shown below:

Password Password to access the SMTP server.

Sender

Sender Email address of the sender of the message

Reply address Email address to which a reply will be sent if the user 
clicks Reply.

Module

Maximum size of the send queue Maximum number of emails that can be stored in the 
buffer memory before being sent:

Default value = 100,
Minimum value = 30,
Maximum value= 200.

Time before retry is sent (in seconds) Delay before emails stored in the buffer memory are 
re-sent after failure:

Default value = 15 s,
Minimum value = 5 s,
Maximum value= 3,600 s.

Service

Service status variable Used to determine the status of the Email service.

Fields Function
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The fields in the Email screen are:

NOTE:  
You can include dynamic data in the message. You can include dynamic data in 
2 ways:

manually by placing brackets before and after the variable name. If, for 
instance, you want to know the value of the value1 variable created in the 
device service, type write {plc.plc1.value1}. You can also include comments 
before and after the brackets.
automatically by double clicking the location where you want to include 
dynamic data. The lookup table appears and you can select the variables that 
will appear in the email.

The following fields are mandatory to record and save an Email: Identifier, 
Trigger and Destination.

Limitation
The number of message you can configure in the project is restricted to 100.

The maximum number of Email service is 2.

NOTE: The SMTP server must allow PLAIN or LOGIN authentication. Other 
authentication protocols are not supported.

Fields Function

Send SMS This function is not available for FactoryCast HMI products. Select this box 
to send a SMS instead of an email.

Identifier Email address or phone number (SMS) of the sender of the message.

Trigger Event that will trigger the Email.

Type NY: Notify Triggered by bit status change or word value change.

RE: Rising Edge Triggered by a bit rising edge or by an increasing word 
value.

FE: Falling Edge Triggered by a bit falling edge or by a decreasing word 
value.

BQ: Bad Quality Triggered if the trigger status is Bad quality.

Destination Email address(es) of the receiver(s) of the message.

Subject A brief summary of the contents of the message.

Contents Type the content of the message in this area.

Click this button to attach a file to the email.

Source Select the source from which the attached file comes from.

Path Specify the path of the file.
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Calculation Service

General
Use the Calculation service to perform operations on or to combine variables. You 
can also use it to view the result of operations in real time to facilitate application 
debugging.

The configuration properties screen for the Calculation service is shown below:

1 Use this button to configure formula.
2 Use this button to configure properties common to all formula.
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How to Create a Calculation Service
The table below describes how to create a Calculation service:

Step Action

1 Click the name of your project in the browser.

2 To add the new service you can:
Click Project → New → Service or,
Right-click Services in the browser, then click New Service.

Result: the following window appears.

3 Select Calculation in the Service Type list box.

4 Enter the service name or click Finish to keep the name by default.

5 The Calculation service has been created.
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Configuring the Properties
The following table introduces you the properties configuration screen of the 
Calculation service:

This table describes the fields of the Calculation configuration screen:

Fields Function

Calculation rate (in ms) Frequency of execution of formula using variables.

Service status variable Used to determine the status of the calculation service.
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Configuring Formulas
The formula configuration screen for the Calculation service is shown below:

This table describes the fields of the formula configuration screen:

Fields Function

Variable Name of the variable. It can be the name of a PLC variable that you set 
to the value of the calculation result.

Formula Formula associated with the variables. The operators are limited.

Value Gives the result of the formula (value of the variable) in real time if your 
are connected to the module and in animation mode.

Description Comment on the variable.

Buttons

Remove Delete the selected variable from the table.

Duplicate Duplicate the selected variable.

Animate Use this button to switch to animation mode. You must be connected 
to the module or in simulation mode.
35016143 12/2011 101



List of Available Operators
The following list provides details of numeric binary, boolean and unary operators. 
The result of the operation is displayed in the Result type column:

Execution of Formula
The calculation service periodically executes formula, according to the frequency 
configured in the Properties screen. The formula cells are interpreted then 
executed one by one from top to bottom. The calculation service updates the 
associated variable configured in the variable field with the new value.

Limitation
The number of calculations you can configure in the project is restricted to 100.

The maximum number of calculation services is 2.

Import from CSV This button enables you to import symbols from a .csv file. You can 
create this file using Excel or a text editor (in this case, change the .txt 
file extension to .csv). You must use the following syntax: 
variable;formula;description. 

Export to CSV This button enables you to export the variable table to a .csv file.

Fields Function

Type Operator Description Example

Binary 
numeric

+ addition 1+2 displays the result "3"

- subtraction 5-2 displays the result "3"

* multiplication 5*2 displays the result "10"

/ division 15/3 displays the result "5"

< less than 1<2 displays the result "true"

> greater than 1>2 displays the result "false"

<= less than or equal to 1<=2 displays the result "true"

>= greater than or equal to 2>=2 displays the result "true"

== equal to 3==2 displays the result "false"

!= not equal to 1!=2 displays the result "true"

Boolean 
numeric

& and 1+1 displays the result "1"

| or 1 | 0 displays the result "1"

Unary ! inverse !1 displays the result "0"

- sign inversion -1 displays the result -1

.<. ? . : . a<b ? c:d returns c if a<b otherwise 
the result is d
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Database Service

Presentation
This connection enables all internal or process data to be archived so that it can be 
logged and traced. The data can be archived (written) periodically or for a specific 
event. These variables can be from PLCs (I/O bits, internal bits, internal words and 
registers) or local to the module.

Types of database supported:

SQL server 6.5, 7, 2000, 2005
MySQL 4.1 or above
Oracle 8i, 9i, 10i

NOTE: Schneider Electric does not guarantee:

integrity of data sent by the module with the database service,
the exactness of the time at which data are logged.
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The configuration screen for the Database service is shown below:

1 Use this button to configure the actions.
2 Use this button to configure the general properties of the database.
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How to Create a Database Service
The following table describes how to create a Database service:

Step Action

1 Click on the name of your project in the browser.

2 To add the new service you can:
Click Project → New → Service or,
Right-click Services in the browser, then click New Service.

Result: the following window appears.

3 Select database in the Service Type list box.

4 Enter the service name or click Finish to keep the name by default.

5 The Database service has been created.
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Configuring the Properties
The following table introduces the properties configuration window of the Database 
service:
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The following table describes the parameters of the database service:

Fields Function

Type Oracle
MySql
SQL Server

Address IP address of the database server.

Port Used to validate a default address.

Use Default Port Port used by the database to access the server.

Database Name Name of the database that will contain all data configured by the user.

User Name & 
Password

Username and password for database access (database connection 
string).

Timeout Period of time that will be allowed to elapse before the system kills the 
current process when it improperly operates.

Service status 
variable

Used to determine the status of the database service.

Timestamp server The date is taken directly from the server for the dating values it 
receives.

Timestamp Target The date is taken directly from the module for the dating values it 
receives.
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Configuring the Log Files
The configuration screen for the Database service is shown below:
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The following table describes the fields in the log file configuration screen:

Database Properties
The table below shows the equivalents of Xopen types for other databases: 

Fields Function

Actions list of 
database

List of all tables configured on the server. Use the Add, Remove and 
Duplicate buttons to create, delete or copy a table. When you duplicate 
an existing database, the new name will have the suffix _copy added to its 
original name.

Actions 
parameters

Name of the new archiving table.
If the table does not exist in the database, the database service will create 
it on the first connection.
To trigger variable logging, you must specify an event. This will either be 
a periodic event (use periodic log), in which case you need to set a time 
base, or it will be an event associated with a variable (use trigger), in which 
case you need to provide the name of the variable (for example, 
calculation.calculation1.Pressure1).

SQL Request Two options are available:
create SQL requests in the Free Text SQL Request window, or
use the table provided to specify the name of the column and the 
variable type and name. In this case, the column name syntax must 
comply with the database syntax. As a general rule, avoid using 
punctuation marks, upper case letters and hyphens, (refer to your 
database documentation).

Xopen type MySql Oracle SQL Server

BOOLEAN SMALLINT NUMBER(1) SMALLINT

TINYINT SMALLINT SMALLINT SMALLINT

SMALLINT SMALLINT NUMBER SMALLINT

INTEGER INTEGER NUMBER INTEGER

BIGINT DECIMAL(200) NUMBER NUMERIC(38,0)

DOUBLE DECIMAL(50,80) NUMBER FLOAT(32)

REAL REAL REAL REAL

TIMESTAMP TIMESTAMP TIMESTAMP TIMESTAMP

DATE DATETIME DATE DATETIME

VARCHAR VARCHAR(255) VARCHAR(255) VARCHAR(255)

All other types VARCHAR(255) VARCHAR(255) VARCHAR(255)
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Limitation
The maximum number of columns is 50 per table.

The maximum number of database connections that can be configured is 10 per 
service.

The maximum number of database services is 3.

NOTE: The service database contains a buffer that allows it to store a limited 
number of events in case of communication failure or network disruption. The 
number of events must not exceed 5000.
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Datalogging Service

General
The Datalogging service enables you to backup information such as configuration 
parameters, variable’s values, log files coming from the devices connected to the 
FactoryCast module into the internal memory of the module.

This can be achieved periodically, or when a specific event occurs (configured by 
the user).

The file system of the FactoryCast module is accessible from any FTP client. You 
can specify a URL for automatic sending of the information to a remote FTP server.

You can use the log file to animate a Datalogging history object (see page 189) in 
the Graphic Editor.

NOTE:  
To prolong the internal Flash life, rerun the log file at intervals greater than 30 
minutes. 
Schneider Electric does not guarantee the exact time at which data have been 
logged.
Back up any log files that are stored in the module’s volatile memory so that you 
are able to restore any lost data.
In case of loss of power during datalogging, the file that is being backed up is lost. 
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The properties configuration screen of the datalogging service is shown below:

1 Use this button to configure the parameters to be archived.
2 Use this button to configure the general properties of the database.
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How to Create a Datalogging Service
The following table describes how to create a datalogging service:

Step Action

1 Click the name of your project in the browser.

2 To add the new service you can:
click Project → New → Service or,
right-click Services in the browser, then click New Service.

Result: the following window appears.

3 Select datalogging in the Service Type list box.

4 Enter the service name or click Finish to keep the name by default.

5 The datalogging service has been created.
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Configuration of Properties
The properties configuration screen of the datalogging service is shown below:

The following table describes the fields of the datalogging configuration screen:

Fields Function

Backup parameters

Action 
parameters

To trigger variable logging, an event must be configured. This will either 
be a periodic event (use periodic log), in which case you need to set a 
time base, or it will be an event associated with a variable (use trigger), 
in which case you need to provide the name of the variable (for example, 
calculation.calculation1.Pressure1).

Media target Select the media on which the data will be backup:
Select Internal Flash to store the information on the internal memory 
of the module.
Select Internal Saved RAM to store the information on the internal 
RAM of the module (not available for FactoryCast HMI modules).
Select CF card to store the information on the memory card of the 
module (not available for FactoryCast HMI modules).
Select USB Storage to store the information on a USB memory key 
connected to the module (not available for FactoryCast HMI modules).

Path Specify the path of the media selected in Media target.
The default path is: NAND\FLASH1\USERDATA. You can create 
subdirectories in the USERDATA directory. If you want to attached a 
subdirectory (i.e. NAND\FLASH1\USERDATA\SUBD1\SUBD2) to the 
email, specify its path without typing the default path (i.e. 
SUBD1\SUBD2). 
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Log File Configuration
The configuration screen of the datalogging service is shown below:

Log maximum 
size

Specify the maximum size of the log file.

Purge parameters

Use of a trigger Define the event that will purge the current log file(s) and start new one(s) 
on service restart. 

Service properties

Service status 
variable

Used to determine the status of the database service.

Fields Function
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The following table describes the fields of the datalogging configuration screen:

Fields Function

Log Tables List the current log files stored on the module. It is possible to:
Create a new log file using the Add button.
Remove a log file using the Remove button.
Duplicate a log file using the Duplicate button.

Table name Name of the log file that will contain all data configured by the user.

Log parameters

Trigger criteria To trigger logging of variables, an event must be configured. This will 
either be a periodic event (use of a timer), in which case you need to set 
a timebase, or it will be an event associated with a FactoryCast variable 
(use of a trigger), in which case you need to provide the name of this 
variable (for example, calculation.calculation1.Pressure1). It is possible to 
use both criteria at the same time.

Erase on restart If the box is checked, the log file will be deleted on restart of the module.

Timestamp Check this box if you want to have the hour and the date of each event 
included in the log file.
Note: Timestamps are mandatory if you want to use the log file for a 
Datalogging History (see page 189).

Optimized log 
format

Check this box for optimizing the log file format (see page 117) of the .csv 
file. In this case, the variable name doesn’t appear in each record.

Table status 
variable

Used to determine the status of the selected table. 

Maximum 
Records

Configure the maximum of records that can be stored in a log file. If that 
number is reached, a new log file overwrites the old file.

Log variables

Log variables This section is used to configure the log files content. If the Timestamp 
checkbox has been checked, the hour and the date of each event is 
included in the log file. The variable name part lists the variables (PLC or 
Calculation variables) that will be stored in the log file.

FTP settings

FTP trigger Specify the event that will trigger logging of variables via FTP.

FTP address Type the address of the FTP server.

Login and 
Password

Protection of FTP access by username and password (default: 
userdata/userdata).
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File Format
The file format is fixed and cannot be modified by the user. The file is encoded in 
pure ASCII format in a text file with a .csv extension. Microsoft Excel is able to open 
these files.

Example of log file:

2003-10-01 02:44:55;plc.plc1.height;150;plc.plc1.length;200;plc.plc1.width;50; 
2003-10-01 03:48:08; plc.plc1.height;140;plc.plc1.length;150;plc.plc1.width;30;

2003-10-01 04:55:10; 
plc.plc1.height;220;plc.plc1.length;280;plc.plc1.width;80;2003-10-01 06:01:05; 
plc.plc1.height;170;plc.plc1.length;220;plc.plc1.width;60;

Example of optimized log file:

Date;plc.plc1.height;plc.plc1.length;plc.plc1.width;

2003-10-01 02:44:55;150;200;50;2003-10-01 03:48:08;140;150;30;2003-10-01 
04:55:10;220;280;80;2003-10-01 06:01:05;170;220;60;

Limitation
The memory space allocated to the datalogging service is limited to 500ko.

You must pay attention to the file size of your log file in order to do not reach the limit 
of 500ko. The estimation of the log file size table (see page 295) shows you an 
estimation of the log file size depending on number of variables and the number of 
logs.
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Active Pages Service

Presentation
The Active Pages service enables you to create your own HTML pages to view 
variables in real time.

This technology has two benefits:

The Web page displayed only includes data useful for viewing, meaning data size 
is kept to a minimum (a few KBs).
The only protocol used for communication with the browser is HTTP, so this 
technology can bridge all firewalls used in an internet infrastructure. 

The configuration properties screen of the Active Pages service is shown below:

1 Use this button to configure the Active Pages service.
2 Use this button to configure properties of the pages.
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How to Create an Active Pages Service
The following table describes how to create an Active Pages service:

Step Action

1 Click the name of your project in the browser.

2 To add the new service you can:
Click Project → New → Service or,
Right-click Services in the browser, then click New Service.

Result: the following window appears.

3 Select active pages in the Service Type list box.

4 Enter the service name or click Finish to keep the name by default.

5 The Active Pages service has been created.
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Configuring the Properties
The properties configuration screen of the Active Pages service is shown below:

The following table describes the fields of the properties configuration screen:

NOTE: It is possible to create two Actives Pages services. In this case, you must 
configure the two services with different port numbers.

Configuring Pages
The configuration screen of the Active Pages service is shown below:

Fields Function

Port Active pages port number for the server IP address. The port 
numbers are between 1024 and 65535. By default, the first port 
declared will be assigned number 1606.

Service status variable Used to determine the status of the Active Pages service.
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The following table describes the fields of the configuration screen:
35016143 12/2011 121



Accessing the Pages
To access the pages, use the following syntax:

http://IP address of module: Active Pages port or
http://domain name of module: Active Pages port

Example:
http://139.160.234.166:1606
http://hmi4:1606

To access a specific page, you must use the following syntax:
http://IP address of module: Active Pages port / name of page
http://domain name of module: Active Pages port / name of page

Example:
http://139.160.234.166:1606/page0
http://hmi4:1606/page0

Fields Function

List List of all the active HTML pages created with the calculation service on the 
server. Use the Add, Remove and Duplicate buttons to create, delete or 
copy a page. When you duplicate an existing page, the new name will have 
the suffix _copy added to its original name.

Import Use this button to import complete HTML code from an .htm or .txt file. You 
can create the file with Frontpage or a text editor. It overwrites the code 
already written.

Name Name of the page currently being created. You can rename the page using 
this field.

Page Use this field to write HTML code of the current page or to view code which 
has been imported. Double-clicking in the field enables you to display the list 
of variables. If you select one of these variables, it is directly incorporated into 
the code. You can incorporate calls to applets, bitmaps or HTML tags into the 
page’s HTML code.
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The following diagram illustrates Active Pages:

NOTE: Automatic refresh of the page called up is not available by default but you 
can include a refresh command in the HTML code of the page. 

Example of HTML code you can use in a page to be refreshed:

<meta http-equiv="refresh" content="1";url=page1>

where content= "refresh time in seconds";url=name of page to 
be reloaded

Limitation
The maximum number of active pages is 2 per project.

The active pages service may include up to a maximum of 64 pages in the project.

1,000 variables can be declared for the entire set of project pages.
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Recipe Service

General
The Recipe service is used following an event to initialize a group of variables set at 
predetermined values. The predetermined values are stored in an XML file.

For this particular event, the recipe service accesses the recipe file (in XML format) 
through an HTTP server, reads the values that correspond to the variables, then 
updates the PLC variables.

This XML file can be created either by using the Recipe Editor, or by using an 
external tool.

The Recipe service configuration screen is shown below:
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The numbered references are as follows:

How to Create a Recipe Service
The following table describes how to create a Database connection service:

Reference Function

1 View the Recipe service’s status with this tab.

2 Configure recipes’ properties with this tab.

3 Configure a recipe’s values with this tab.

Step Action

1 Click on the name of your project in the browser.

2 To add the new service you can:
click Project → New → Service or,
right-click Services in the browser, then click New Service.

Result: the following window appears.

3 Select recipe in the Service Type list box.
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Configuring the Properties
The configuration screen of the Recipe service is shown below:

This table describes the various fields that make up the configuration screen:

4 Enter the service name or click Finish to keep the name by default.

5 The Recipe service has been created.

Step Action

Field Function

Recipe URL Location of the recipe file, with a .xml extension. If the file is stored in the 
module, the URL for accessing it is: 
http://localhost/directory/filename.xml, or http://IP address of HTTP 
server/directory/filename.xml.

Username Username for connecting to the HTTP server.

Password Password for connecting to the HTTP server.

Status Variable Variable that describes the recipe’s status:
0: no action
1: recipe writing in progress
60: detected error in recipe configuration
61: detected error when writing the value
62: communication interruption
63: detected error in recipe file

Trigger Variable from which the event is triggered.
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Recipe Editor
The Recipe Editor screen is used to input a recipe’s values in an XML-format recipe 
file: 

The following table describes the fields of the recipe editor configuration screen.

Type NY: Notify Triggered on a bit or word value state change.

RE: Rising Edge Triggered on a rising edge for a bit, or a value 
increase for a word.

FE: Falling Edge Triggered on a falling edge for a bit, or a value 
decrease for a word.

BQ: Bad Quality Triggered if the trigger status is "Bad quality".

Remove To remove a recipe from the list.

Field Function

Field Function

Variable Name of the variable to which a value is to be given.

Value Value to attribute.

Ingredient Optional comment to describe the variable’s role.

Open To open an XML-format recipe file.

Save To save a recipe as an XML file.

Close To close the Recipe Editor.
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Adding Variables
This table describes how to add variables:

Saving a Recipe File
This table describes how to save a recipe file:

Transferring a recipe file to a module
This table describes how to transfer a recipe file to a module

Note
For a recipe file that is not local to the module, you must first transfer it to the target 
HTTP server without using the FactoryCast HMI configuration application.

Add... To add a variable.

Remove To remove a variable.

Field Function

Step Action

1 Click Add.
Result: the variable selection box is displayed.

2 Select the variables to insert into the recipe file. Multiple variables may be 
selected by holding down the Ctrl or Shift keys while left-clicking.

3 Close the window by clicking Confirm.
Result: the selected variables are added to the recipe file.

Step Action

1 Click Save. 
Result: the Save as dialog box is displayed.

2 The file must be saved on the disk in order to be transferred to an HTTP server 
later. If you would like the file to remain local to the FactoryCast HMI module, 
you must save it in a directory located in the website root of the project currently 
being configured. For example: C:\Program Files\Schneider 
Electric\FactoryCast HMI\workspace\project_name\wwwroot\recipes\my 
recipe.xml.

3 Close the window with the Save button.
Result: the recipe file is saved.

Step Action

1 In the navigator, select the recipe file to transfer in the directory located under 
the website root (wwwroot).

2 Right-click on Partial transfer -> :PC -> Module.
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Example of an XML File
<?xml version="1.0" encoding="utf-8" ?> -

<table>-

 <data>

  <name>plc.localRTDB.VarRecette403</name>

   <value>4</value>

   <ingredient>douwn part black</ingredient>

   </data>- <data>

  <name>plc.localRTDB.VarRecette402</name>

   <value>3</value>

   <ingredient>up part blue</ingredient>

   </data>- <data>

  <name>plc.localRTDB.VarRecette401</name>

   <value>2</value>

   <ingredient>left part red</ingredient>

   </data>- <data>

  <name>plc.localRTDB.VarRecette400</name>

   <value>1</value>

  </data>

</table>

Limitations
Recipe files must be accessible by an HTTP server.
A HMI application can only manage a single recipe service.
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Recipe Database Service

Presentation
The Recipe database service enables you to set the value of variables to 
predetermined values stored in database tables. You can create a scenario or 
initialize system variables of your system with values stored in a database 
(SQLServer, MySql and Oracle).

You can also save the state of your system by storing the value of your system 
variables in database tables.

This can be achieved periodically, or when a specific event occurs (configured by 
the user).
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The Recipe database service configuration screen is shown below:

1 Configure the properties of the recipe database system with this tab.
2 Configure the actions to be undertaken with this tab.
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How to Create a Recipe Database Service
The following table describes how to create a recipe database service:

Step Action

1 Click the name of your project in the browser.

2 To add the new service you can:
click Project → New → Service or,
right-click Services in the browser, then click New Service.

Result: the following window appears.

3 Select recipedb in the Service Type listbox.

4 Enter the service name or click Finish to keep the name by default.

5 The recipe database service has been created.
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Configuration of Properties
The properties configuration window of the Database connection service is shown 
below:
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The following table describes the fields of the database server configuration screen:

Configuring the Actions
The action screen of the recipe database service is shown below:

Fields Function

Type Oracle 8i, 9i, 10i
MySql 4.1 or above
SQL Server 6.5, 7, 2000, 2005

Address IP address of the database server.

Port Used to validate a default address.

Use Of Default Port Port used by the database to access the server.

Database Name Name of the database that will contain all data configured by the 
user.

User Name & 
Password

Username and password (database connection string) to access the 
database server.

Timeout Period of time that will be allowed to elapse before the system kills 
the current process when it improperly operates.

Service status 
variable

Used to determine the status of the recipe database service.
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This table describes the fields that make up the action screen:

Field Function

Name of the status 
action variable

List the actions already configured.

Action parameters

Table name Type a name to identify the action.

Action status variable Type the variable name that will represent the action status.

Action type

Database -> PLC Initialization of your system variable with the value of the database.

PLC -> Database Save the current state of the system in the database.

Trigger criterion

Trigger use Specify the variable that will trigger the action. 

NY: Notify Triggered on a bit or word value state change.

RE: Rising Edge Triggered on a rising edge for a bit, or a value 
increase for a word.

FE: Falling Edge Triggered on a falling edge for a bit, or a value 
decrease for a word.

BQ: Bad Quality Triggered if the trigger status is "Bad quality".

Timer use Specify the period at which the action will be triggered. 

SQL request

Use a free SQL request Type your SQL request using the SQL syntax.
In this case the screen looks like this:
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Automatic Request Example
In this example, you will update the block1 table in the database with PLC values 
when the state of the device.plc.control1 variable changes.

The following figure shows you the window that corresponds to the example:

Use of an automatic 
request

This function enables you to update tables without using a SQL 
syntax. Refer to the following paragraph for more information.
Use the table provided for this purpose specifying the name of the 
column and the type of the variable. In this case, the column name 
syntax must comply with the database syntax. As a general rule, 
avoid using punctuation marks, upper case letters and hyphens 
(refer to your database documentation).
Note: The name of the action and the name of the table are 
identical if you use Automatic Request therefore you cannot read 
and write to the same table in that case. Use the free SQL request 
to precise the name of the table.

Associated request for 
a free SQL request

This part displays the SQL request syntax corresponding to the 
automatic request you have entered.

Field Function
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Limitations
Web Designer for FactoryCast HMI only manages a single recipe database service.

The maximum number of tables is 20 per service.

The maximum number of columns is 50 per table.

Step Action

1 Create a recipe database service.

2 Click the Actions tab.

3 Type the name of the table you want to update (i.e. block1) in the Table name 
field.

4 Specify a variable that will represent the action status (i.e. ACTION1) in the 
Name of the action status variable field.

5 Select Database -> PLC in the Action type area.

6 Select use of a trigger in the Trigger criterion area and select the variable that 

will trigger the action by clicking . 
You also have to specify the type of event that will trigger the action (i.e. NY).

7 Select use of an automatic request.

8 Click Add and type tankPressure for the column name. The column name 
syntax must comply with the database syntax.

9
Select the corresponding variable (i.e. device.plc.pres1) by clicking  on 
the left side of the Variable field.

10 Redo step 8 and 9 to add the values of device.plc.flow1 in the flow1 column.

11 Specify a name for the index of the table and select a variable to store the index 
value.
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Service Status

Presentation
The main purpose of the service status is to provide feedback on the services.

The status value of the service (email, plc, database, calculation...) is copied to a 
device variable using the Service properties screen. By default, each service has a 
FactoryCast HMI module internal status variable named as follows: "service 
type.service name.sstatus" (e.g. device.plc1.sstatus). 

This status variable can be used to send out an email (alarm), to trigger archiving to 
a database, for management (sending alarm in supervision mode) or for any other 
action possible in the FactoryCast HMI application.

Example:

To send an email with the database service, you must:

declare a dbStatus variable in the device and assign it to an address (integer, for 
example), then import this variable into the device service,
define the dbStatus variable to trigger an email in the email service.

The service property configuration screens all have a ‘service status variable’ field. 
An illustration of what it looks like and how it is configured is shown below:

Simply click on... to display a variable selection window which can be configured, by 
selecting from a list of INT, UINT, SHORT and USHORT type. 

The status values are:

0 for a stopped service,
1 for a service that is running,
≥2 for a service on which an anomaly has occurred,

The codes are assigned in ascending order of severity.

In case of 2 events, the status value corresponds to the most important one.

When a new action is operational (log, creation of a table, etc.), the service is 
assigned the value 1 to inform you that the service is operating correctly.

Each service has its own codes.
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Device Service Codes

NOTE: Value 2 will only be accessible from the service’s internal status variable (i.e. 
device.plc.SSTATUS). This value will not be copied to the device variable (except if 
the variable belongs to another accessible device).

RecipeDB Services Codes

NOTE:  
The value 20 should be considered to be a system message, not an alarm. It may 
occur when: 

the service is started (value not ready), 
the PLC has not had the time to send the data as part of the request,
the signature of the PLC application is different to that of the FactoryCast HMI 
application.

The high values take priority. Code 23 has priority over code 21. When code 23 has 
been corrected, the value 21 can then be sent to the variable declared for the status 
of the service. 

Value Comment

0 The service is stopped.

1 The service is running.

2 The PLC application’s signature is different from the one contained in the 
FactoryCast HMI application for the device service.

Value Comment

0 The service is in stop mode.

1 The service is in run mode.

20 Log in table delayed.

21 No access to table.

22 Table no longer exists.

23 Database connection anomaly.

24 Incorrect service configuration.

25 Fatal detected error.
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Database Services Codes

NOTE: Code 50 : buffer full - The database buffer is full, the new events are not 
stored anymore. A reconnection of the database or the ethernet cable is required to 
send the values to the database and store new coming values.

NOTE:  
The value 20 should be considered to be a system message, not an alarm. It may 
occur when: 

the service is started (value not ready), 
the PLC has not had the time to send the data as part of the request,
the signature of the PLC application is different to that of the FactoryCast HMI 
application.

The high values take priority. Code 23 has priority over code 21. When code 23 has 
been corrected, the value 21 can then be sent to the variable declared for the status 
of the service. 

Email Service Codes

NOTE: The high values take priority. The value 12 has priority but becomes 11 
subsequently. Code 11 disappears once the email has been sent correctly.

Value Comment

0 The service is in stop mode.

1 The service is in run mode.

20 Log in table delayed.

21 Access to table.

22 Table no longer exists.

23 Database connection anomaly.

50 Buffer is full.

100 Anomaly database configuration.

200 Database undefined.

1000 Fatal detected error.

Value Comment

0 The service is in stop mode.

1 The service is in run mode.

10 Email refused by SMTP server.

11 Email not sent, due to a connection interruption.

12 No more connections or queue saturated. 
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Datalogging Service Codes

NOTE:  
The value 2 should be considered as a warning, not an alarm.
The high values take priority. For example: code 17 has priority over code 12. 
When code 17 has been corrected, the value 12 can then be sent to the variable 
declared for the status of the datalogging service
If all tables status values are 0, the service status is set to 1 (for running state).
The values of the table status variable are identical to the values of the 
datalogging service status variable. 

Recipe Service Codes

Value Comment

0 OK.

2 The current file ‘.csv’ is renamed ‘.cs0’.

10 The module cannot reach a variable that should be logged because:
the variable does not appear in the Web Designer namespace.
the variable is not write enabled.
the preceding value has not been updated yet.

11 FTP transfer interruption.

12 The URL specified for FTP cannot be accessed.

13 The internal flash is full

14 The internal RAM is full.

15 The module cannot write on the media specified.

16 The module cannot access the namespace.

17 The maximum number of tables has been reached (10 maximum) in your .xml 
file. 

18 The maximum number of variables has been reached in a table.

19 The service is empty, no table defined.

Value Comment

0 The service is in stop mode.

1 The service is in run mode.

60 Detected error in recipe configuration.

61 Detected error when writing the value.

62 Communication error.

63 Error in recipe file.
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Codes for Other Services
The other services (calculation, active pages) do not have any specific values. The 
code only specifies whether the service is stopped (0) or running (1).

Value Code Comment

0 Stop The service is in stop mode.

1 Run The service is in run mode.
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Subject of this Chapter
This chapter presents the different ways provided by Web Designer for 
FactoryCast HMI to monitor your system.

What’s in this Chapter?
This chapter contains the following sections:

Section Topic Page

8.1 Data Editor 146

8.2 Graphic Editor 156

8.3 Operator Screens 205

8.4 PLC Program Viewer 208
145



Monitoring
8.1 Data Editor

Overview
The Data Editor allows you to edit/create data monitoring tables or to display Data 
tables. Data tables provide read/write access to application data and devices 
registers. Write access is password protected.

Allowing write access can change system behavior.

This section shows how to use the Data Editor to display and modify the values of 
the symbol variables and direct addresses.

What’s in this Section?
This section contains the following topics:

WARNING
UNINTENDED OPERATION
 

Make sure variables that can be written are accessible by trained personnel 
only (password protect).
Do not give write access to critical control variables.

Failure to follow these instructions can result in death, serious injury, or 
equipment damage.

Topic Page

Data Editor 147

Creating a Data Template 148

Data Editor Spreadsheet 149

Inserting a Symbol (Variable) in a Data Template 152

Inserting a Direct Address in a Data Template 154

Using an Existing Data Template 155
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Monitoring
Data Editor

Overview
Data Editor is a Java applet that enables you to create dynamic data tables that can 
be updated with run-time data from the PLC.

Elements of Data Editor
The following illustration shows you the Data Editor:

Number Description

1 List of the variables included in this table.

2 The configuration area makes it possible to:
select and/or modify a symbol,
select and/or modify an address,
select the variable type,
select the variable’s display format,
check the read-only option.
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Monitoring
Creating a Data Template

Overview
To display some symbols (variables), you must create a new data template.

Creating a Data Template
Follow the steps in the table below to create a data template: 

NOTE: Save the current spreadsheet before selecting a new spreadsheet. Selecting 
a new spreadsheet deletes the current spreadsheet.

Step Description

1 Right click the DataTables directory in the navigator and select New Table.
Result: the New Table window appears.

2 Enter a name of the new Data template.

3 Click OK.
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Monitoring
Data Editor Spreadsheet

Overview
Depending on the target, the Data Editor displays data in a spreadsheet with the 
following fields:

name,
address,
type,
read only,
format,
status.

This section describes the spreadsheet screen and gives an explanation of each 
field.

Spreadsheet
The following figure shows the Data Editor spreadsheet:
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Monitoring
Field Name
The fields in the Data Editor screen are:

Type Field
The Data Type field contains the data type of the symbol variable or direct address. 
The types of data of the symbolic variable appear automatically when the symbol 
variable is located. Direct address data types must be set by the user from a drop-
down list.

The following data types are valid:

Fields Function

Name The Name column contains the names of symbolic variables from the 
Namespace.
The symbolic variables which may be used in the Data Editor are those 
that have been predefined by the configuration tool. The symbolic 
variables are grouped in a file called Namespace.

Address The Address column contains the addresses of the symbols. You can 
display any direct address by entering its reference in this field. This direct 
address does not need to be referenced in Namespace. However, a 
symbol must be associated with this direct address.

Type Data type (see page 150): input or output register, input or output bit.

Format Format (see page 151) of the data value.

Read Only If this box is selected the variable cannot be output directly.

Abbreviation Data type

INT 16-bit signed integer

UINT 16-bit unsigned integer

DINT 32-bit signed integer

UDINT 32-bit unsigned integer

REAL 32-bit IEEE floating point

TIME 32-bit unsigned integer (in ms)

DATE Date (32-bit BCD)

TOD Date/time (32-bit BCD)

BOOL 1 internal bit (boolean)
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Monitoring
Format Field
The Format field contains the format type for displaying the value of the symbol 
variable or direct address. The following formats are accepted:

Status Field
The Status column contains messages about the status of communications with the 
symbol variable or direct address. If communications are normal, the status 
message is "OK". 

If communication with a simple variable or a direct address is not operational, the 
Status column displays a message describing the event.

Abbreviation Format Type

bool Boolean

dec Decimal

hex Hexadecimal

binary Binary

ASCII Bytes displayed as ASCII characters

time Day_hr_min_sec_ms

date YYYY-MM-DD or HH:MM:SS
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Monitoring
Inserting a Symbol (Variable) in a Data Template

Overview
If you want to view or modify the value of a symbol (variable) in the Namespace, you 
must insert that symbol (variable) in a data template.

WARNING
UNINTENDED EQUIPMENT OPERATION
 

Password-protect access to the embedded server.
Carefully select the symbols and direct addresses you authorize to be modified 
online.
Do not authorize online modifications of critical process variables.

Failure to follow these instructions can result in death, serious injury, or 
equipment damage.
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Monitoring
Inserting a Symbol (Variable)
Follow the steps in the table below to insert a Symbol (variable):

Step Action

1 Double-click on an empty row in the spreadsheet.
Result: The data editor’s configuration area appears. 

2
In the configuration area, click on the button.
Result: The Lookup window appears.

3 Select the symbols (variables) you want to insert in the data template by clicking 
them in the list.

4 Click OK.
Result: New rows corresponding to the symbols (variables) you selected 
appear in the spreadsheet.

5

Save your data table by clicking .
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Monitoring
Inserting a Direct Address in a Data Template

Presentation
If you want to view or modify the value of a direct address, you must insert that direct 
address in a data template.

Allowing write access can change system behavior.

Inserting a Direct Address

WARNING
UNINTENDED EQUIPMENT OPERATION
 

Limit embedded server access to qualified personnel.
Password-protect access to the embedded server.
Carefully select the symbols and direct addresses you authorize to be modified 
online.
Do not authorize online modifications of critical process variables.

Failure to follow these instructions can result in death, serious injury, or 
equipment damage.

Step Action

1 Double-click on an empty row in the spreadsheet.
Result: The data editor’s configuration area appears. 

2 In the Address field of the configuration area, enter the variable’s Direct 
address.

3 In the configuration area, click on Apply.
Result: A new row that corresponds to the variable address is displayed in the 
spreadsheet.
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Monitoring
Using an Existing Data Template

Overview
Once you have created data templates, you may want to access or modify them. 

Accessing a Data Template
The following procedure shows you how to access a existing data template.

Step Action

1 Extend the DataTables directory in the navigator.
Result: The existing tables appear in the navigator.

2 Double click the table you want to modify in the list or,
Right click the table you to modify and select Edit.

Result: The selected table appears in the editing zone.
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Monitoring
8.2 Graphic Editor

Subject of this Section
This section describes the functions and characteristics of the Graphic Editor. The 
Graphic Editor is a Web page that enables the user to create dynamic graphic 
displays with a browser and using a predefined set of graphic objects. The Graphic 
Editor is both a graphic editor that can be used to create and modify displays, and a 
Runtime environment that allows the user to view animated displays using data from 
the PLC.

What’s in this Section?
This section contains the following topics:

Topic Page

Overview of the Graphic Editor 157

Toolbar 159

User Functions of the Display Window 164

Property Sheet 167

Security 169

Parameters of the Graphic Editor Applet 170

Graphic Objects 172

Extended Graphic Objects 193
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Overview of the Graphic Editor

Top Window
The Graphic Editor is made up of three windows. The top window features an area 
for presenting the user commands and dialog boxes for creating, saving, reading 
and editing a graphic display.

Display Window
The display window proposes a presentation area of the current graphic display. 
When you create a new graphic display, this window turns into a blank space into 
which you can add the graphic objects that will make up the required graphic display.

Message Window
This window proposes a scrolling message window used to display the messages 
generated by the Graphic Editor. The figure below shows the Graphic Editor with its 
initial top window and display window.
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Graphic Objects
All the graphic objects supplied with the Graphic Editor are able to communicate with 
the PLC. They are also designed as standalone objects, which means no connection 
is needed between the objects, and that each object is capable of operating on its 
own.

Allowing write access can change system behavior.

NOTE: Write access is controlled by a password (Security) whose default value is 
USER.

Creating and Modifying Graphic Displays
If you wish to create and modify a graphic page, click Modify... which will give you 
access to the specific editing functions. Then, simply select the objects from the 
palette, place them in a space, move them and adjust their size, and define their 
properties. You can immediately test the graphic display updated with the PLC data 
by quitting edit mode (click Done). If you want to keep the graphic display you have 
created, you can save it in the PLC for future use by clicking Save..., on condition 
you have entered the correct password.

NOTE: Be careful when you modify and save a graphic page, the last modifications 
will be saved and will overwrite the existing page even if someone else has created 
it.

WARNING
UNINTENDED EQUIPMENT OPERATION
 

Password-protect access to the embedded server.
Carefully select the symbols and direct addresses you authorize to be modified 
online.
Do not authorize online modifications of critical process variables.

Failure to follow these instructions can result in death, serious injury, or 
equipment damage.
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Toolbar

Overview
The Graphic Editor applet’s top window consists of several "dialog panels," only one 
of which is shown at a time. Switching from one dialog to another is done by clicking 
buttons on the current dialog. This section describes the dialog panels that comprise 
the top window.

Top Dialog
The Edit Dialog allows you to select a graphic object for placement in the display 
window, and provides access to all graphic editing functions. The available graphic 
objects are presented in a set of palettes, with one palette visible at a time. There 
are two palettes.

The standard palette:

The extended palette:

The controls in the top dialog box provide the following functions.
Drop-down List. The drop-down list box shows all the graphic pages that have 
been saved to the FactoyCast HMI module, and are available for retrieving. When 
you select a graphic page from this list, the graphic display currently visible in the 
window is replaced with the one selected. If the current graphic page has been 
modified since it was last saved, you will be asked for confirmation that the 
changes are to be discarded. If the special entry <new> is chosen from the list, 
then the display window is cleared, and a new graphic page can be created.
Save. The Save button causes the Save dialog box to become visible. This 
button is disabled until you have entered a correct write-enable password.
Delete. The Delete... button causes the Delete dialog box to become visible. 
This button is disabled until you have entered a correct password, or if the current 
graphic display has not yet been saved.
Edit. The Edit... button causes the Edit dialog box to become visible.
Password. The Password... button causes the Password dialog box to 
become visible.
Information display area. The information display area shows the name and 
version of the Concept, PL7 or Unity Pro program that is running in the connected 
PLC.
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Save Dialog
The Save dialog box allows you to save the current graphic display.

When the Save dialog box is presented, the name of the current graphic page is 
shown in the dialog’s text field. If the current graphic page has never been saved 
(i.e., a "new" graphic display), then the text field is blank. Once you have either 
accepted the current name (a "save" operation) or provided a new name (a "save 
as" operation), then you can click the OK button to save the contents of the current 
graphic display to the Web server module. The Cancel button will cause the Top 
dialog box to be shown again, with no action being taken.

Delete Dialog
The Delete dialog box allows you to delete the current graphic page.

If you click the Yes button, the existing graphic display window is cleared and the 
graphics file on the Web server module is deleted. Clicking the No button will cause 
the Top dialog box to be shown again, with no action being taken.

Password Dialog
The Password dialog box allows you to enter the password that enables those 
user functions that modify graphic display files or PLC run-time data values.

If you enter the correct password and click the OK button, then you will be allowed 
to save and delete the current graphic display. Correct password entry also permits 
you to write new values to the PLC (via those graphic objects that support writing 
values to a PLC, if any). If you click the OK button when the text field is empty, then 
the current password permissions, if any, are cleared. The Cancel button will cause 
the Top dialog box to be shown again, with no changes made to current password 
permissions.
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Edit Dialog
The Edit dialog box allows you to create or modify a graphic page, by selecting a 
graphic object for placement in the display window, and accessing all the graphic 
editing functions. The graphic objects available are presented in a single object 
palette.

The controls of the Edit dialog box provide the following functions:
The Drop-down List Box shows the set of palettes that are available. When you 
select the name of a palette from the list, the palette area of the dialog displays 
the selected one’s graphic objects.
The Palette shows the graphic objects that are in the current palette with an icon 
that depicts each graphic object’s type (meter, button, etc.). When you click any 
of the icons in the palette, a graphic object of the corresponding type becomes 
selected for insertion. While the Graphic Editor is in "insert mode," if you click in 
an open area of the display window, an instance of the selected graphic object is 
inserted into the graphic display.
The Information Area shows the name and size of the graphic object that is 
currently selected.
The Cut button causes the currently selected graphic object(s) to be removed 
from the graphic display and saved to a buffer (i.e., an internal clipboard), 
replacing any existing contents of the buffer.
The Copy button causes the currently selected graphic object(s) to be copied to 
the buffer, replacing any existing contents.
The Paste button causes the content of the clipboard to be inserted into the upper 
left corner of the graphic display. The pasted graphic objects can then be moved 
to the desired location in the display.
The Properties button causes the Properties Sheet for the currently selected 
graphic object to be shown.
The Customize button causes the Customizer for the currently selected object to 
be shown, if the graphic object has been provided with one.
The Layout button shows the Layout dialog box.
The Options button shows the Options dialog box.
The Done button causes the Top dialog box to be shown again.
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Layout Dialog
The Layout dialog box allows you to change the position and size of a group of 
graphic objects.

The controls of the Layout dialog box provide the following functions.
The Right, Bottom, Left, and Top buttons can be used to align the edges of the 
selected graphic objects so that their specified sides are at the same position. At 
least two graphic objects must be selected for these buttons to be enabled.
The Horizontal, and Vertical buttons are used to align the centers of the graphic 
objects. At least two graphic objects must be selected for these buttons to be 
enabled.
The Horizontal and Vertical buttons are used to space the selected graphic 
objects regularly, in order that the horizontal or vertical spacing between the 
objects is the same. At least three graphic objects must be selected for these 
buttons to be enabled.
The Width and Height buttons are used to achieve parity in dimensions of the 
graphic objects, so the selected width or height corresponds. At least two graphic 
objects must be selected for these buttons to be enabled.
The Done button causes the Edit dialog box to be shown again.

NOTE: For all layout operations (except Space evenly) one of the selected objects 
is considered the "reference object" to which all other selected objects refer in order 
to know their new position or dimension. For example, when the "Width" button is 
pressed, all of the selected objects will have their width changed to match the width 
of the reference object. The reference object is differentiated from the other selected 
objects by making its selection box a different color than the others.
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Options Dialog
The Options dialog box is used to change the settings related to a grid drawn in 
the display window. The grid is solely for assistance in editing or creating a graphic 
display and is shown only when the Graphic Editor is in "edit mode."

The controls of the Options dialog box provide the following function.
The cell size of the grid can be changed by the entering the grid’s column width 
and row height into the dialog’s text fields.
If the Show grid check-box is checked, the grid will be drawn; otherwise, no grid 
will be shown.
If the Snap to grid check-box is checked, then, when you change the size or 
position of a graphic object, the changed coordinate(s) or dimension(s) is 
automatically adjusted so that it coincides with a grid point.
The OK button causes the current option settings to become active, and the Edit 
dialog box to be shown again.
The Cancel button causes the Edit dialog box to be shown again, with no option 
settings being changed.
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User Functions of the Display Window

Overview
The user functions available in the display window of the Graphic Editor are used 
to select and move objects, and redefine their size. All moving or size redefinition 
operations require the graphic object(s) to be selected before being modified. The 
object selected appears framed on the screen. 

The figure below shows the Graphic Editor screen.
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Selecting Graphic Objects
The selection status of a graphic object (selected/deselected) can be defined by the 
following user actions:

You can select a single graphic object by simply clicking on it. If other objects are 
already selected, they are automatically deselected.
You can select several graphic objects by creating a rectangle over them in the 
display window. Left-click with the mouse in an open area of the display window 
(not on a graphic object) and, holding down the button, drag the curser to draw a 
dotted frame. One of the corners of the rectangle will be where you first clicked, 
and the corner diagonally opposite will follow the path of the curser. When you 
release the button, all the objects within the box will be selected. All objects 
outside this box will be deselected.
You can select or deselect a graphic object by holding down the CTRL key and 
clicking on an object. Here, the selection status of all other objects will remain 
unchanged. With this action, each graphic object can be added to the current 
group of selected or deleted objects.
You can select a graphic object by holding down the SHIFT key and clicking on 
an object. Here, the selection status of all other objects will remain unchanged. 
With this method, when one object is selected it becomes the reference object 
(see the layout dialog box in section Toolbar, page 159) for the group of objects 
selected. The main aim of this action is to change the reference object in a group 
of selected objects. The layout operations come later.
You can deselect all the graphic objects by clicking in an open area of the display 
window (and not on a graphic object).

Defining the Size of the Graphic Objects
You can modify the size of a graphic object by first selecting it then using the mouse 
to change the size of the object’s selection box. As you move the curser on an 
object’s selection box, this changes to reflect the type of operation to perform to 
redefine the size. If you press the left mouse button with the curser on an object’s 
selection box, then hold down the button and move the object, a dotted frame 
appears. When you release the button, the size of the object is modified to 
correspond to the frame you have drawn. There are eight possible ways of 
redefining the size, according to the part of the object’s selection box from which you 
drag the mouse. The corners of the frame will only move the adjacent sides, and 
each side of the frame can be moved on its own.
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Moving Graphic Objects
The position of a graphic object in the display window can be modified using the 
mouse. If you press the left mouse button with the curser on an object, then hold 
down the button and move the object, a dotted frame appears. When you release 
the button, the position of the object is modified to correspond to the frame you have 
drawn.

You can move several graphic objects by first selecting the objects to move, then 
moving the whole group as you would a single object. When you move a group of 
objects, a box delimits each object of the group.

Defining the Properties of the Graphic Objects
You can define the properties of a graphic object using the Property Sheet (see 
property sheet in section Property Sheet, page 167). If the property sheet is 
displayed, the characteristics of the graphic object selected can be edited. You can 
display the property sheet by clicking Properties...  or double-clicking anywhere on 
the selected object in the display window.

Customizing Complex Graphic Objects
Certain complex graphic objects have a large number of properties. The 
configuration process for graphic objects like these using the property sheet can be 
long. To simplify the configuration of complex graphic objects, you can use a 
customization module. This is a dialog window designed specially to configure 
associated graphic objects. . This button presents the customization module of the 
graphic object. When you double-click on a graphic object with a customization 
module, this is what is presented, not its properties sheet. If a graphic object has a 
customization module, the only characteristic to appear in its properties sheet is its 
name.

Displaying a Background Image
The Graphic Editor display has a Background Image characteristic which can be 
used to specify an image to appear in the background of the display. This image can 
be a GIF file or a JPEG file. All files are placed in the /wwwroot directory of the 
embedded server. For example, if the image "cool.gif" was placed in the 
/wwwroot/images directory of the embedded server, the background image property 
must be set to /wwwroot/images.
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Property Sheet

Overview
The Property Sheet is a "floating" (non-modal) dialog that presents all the settable 
properties of the currently selected graphic object.

The properties of a graphic object are specific to an object’s type. The properties are 
presented in a scrollable list, with the name and the value of each property listed. 
See Graphic Objects, page 172 for a description of the graphic objects provided with 
the Graphic Editor.
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Find variables dialog box
For each of the graphic objects provided with the Graphic Editor, a property editor is 
provided for its Address property. This property editor not only allows you to directly 
enter the address of a Quantum/Premium/Micro register (or Concept/PL7/Unity Pro 
variable name), but also provides access to the Find variables dialog box. The 
Lookup Dialog allows you to pick a Concept/PL7/Unity Pro symbol (variable) name 
from a list of symbol (variables) that have been "Web enabled" by Web Designer.

This is the Find variables dialog box.
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Security

Security
Your API data is protected by three security measures.

The HTML page containing the Graphic Editor applet has been placed in a 
"secure" directory on the Web module; the Web browser user is therefore asked 
to enter a password enabling him/her to download the HTML page.
You must enter the correct password in the Password dialog box to be able to 
save/delete the files or send the data values to the connected PLC. For the 
transfer of data values to the PLC, the Graphic Editor reinforces the "read only" 
mode by deactivating the user commands of all the graphic objects.
The FactoryCast configuration program lets you indicate that an element is in 
read only. The Graphic Editor reinforces the "read only" attribute of a symbol 
variable or address by rejecting all requests in order to define a new value for the 
data, and warning the user through the message window Graphic Editor.
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Parameters of the Graphic Editor Applet

Overview
The Graphic Editor supports three applet parameters for customizing its behavior. 
The applet parameters are indicated by the <PARAM> labels in the <APPLET> label 
of the Graphic Editor HTML page. The parameters recognized by the Graphic 
Editor applet are:

LOAD—This parameter asks the Graphic Editor to automatically load a graphic 
file when it is launched. If the specified file does not exist, a message is delivered. 
If the parameter does not appear in the <APPLET> label, no graphic file is 
automatically loaded on startup. In this case you must select the initial table file 
from the list provided by the Graphic Editor.
MODE—This parameter tells the Graphic Editor whether it has to start normally 
in edit mode or in view mode. If it is launched in view mode, it will only display 
the display window. When this parameter is used with the LOAD parameter, a 
website can be designed using HTML pages that are reserved for specific graphic 
display. The user is not required to explicitly select any graphic files, which is 
typical HMI behavior. The possible values for this parameter are

EDIT—The Graphic Editor starts normally in edit mode (default value).
VIEW_RO—The Graphic Editor starts normally in read only. The Web 
browser user will not be authorized to send values to the PLC.
VIEW_RW—The Graphic Editor starts normally in read/write. The Web 
browser user will be authorized to send values to the PLC, having first entered 
the write access password.

AUTO_LOGIN—This parameter tells the Graphic Editor to automatically enter 
the password required to write access the PLC. If the MODE parameter is set to 
VIEW_RW or EDITI and also set to TRUE, the Graphic Editor grants write 
access to the PLC without asking the user to enter the password. The possible 
values for this parameter are FALSE (by default) and TRUE.
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Example
The following example shows an applet invocation marker that starts the Graphic 
Editor in view mode and automatically changes the graphic file called UNIT_1. The 
Web browser user will be authorized to send values to the PLC though graphic 
objects that take into account the sending of values if the password for write access 
in entered.

<APPLET codebase="/classes"
archive="SAComm.jar,GDE.jar,Widgets.jar"
code="com.schneiderautomation.gde.GdeApplet"
width="700" height="514">
<PARAM name="LOAD" value="UNIT_1">
<PARAM name="MODE" value="VIEW_RW">
<PARAM name="AUTO_LOGIN" value="FALSE">
</APPLET>
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Graphic Objects

Presentation
The set of graphic objects provided in the Graphic Editor is intended to support 
building graphic displays that mimic conventional instrument panels. All of the data 
monitoring and control objects have built-in communication capabilities and are 
designed as stand-alone graphic objects.

Additionally, to support customers that want to put several simple applets on a single 
HTML page, each object in the Graphic Editor set is provided in an applet version. 
When used in conjunction with the LiveBeanApplet, the Graphic Editor graphic 
objects can be used in the same way as the LiveLabelApplet.

This section provides a description of the standard graphic objects and their 
properties.

Horizontal Indicator
A Horizontal Indicator provides an analog representation of the value of a symbol 
(variable) or direct address in a PLC by drawing a horizontal bar whose length is 
proportional to the value as a percentage of its range in engineering units. 
Optionally, a digital indication of the value can be shown in the center of the bar area.

The properties for the Horizontal Indicator are listed below:

Property Description Limits

Name The name for the graphic object

Address The direct address (or the name of a symbol 
(variable)) to monitor

See Note 1,Notes, 
page 192

Data Type The data type of the direct address or symbol 
(variable)

See Note 2,Notes, 
page 192

Background The background color for the graphic object

Label The label to be displayed as part of the graphic 
object

Label Color The color for the label

Label Font The font for the label

Major Scale 
Divisions

The number of major (labeled) scale divisions 0 to 100

Minor Scale 
Divisions

The number of minor (unlabeled) scale divisions 0 to 100

Scale Color The color for the scale and its labels

Scale Font The font for scale labels
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Scale Precision The number of fractional digits to be shown for 
scale labels (Set to -1 to use a general 
exponential format.)

-1 to 6

Maximum EU 
Value

The maximum value, in engineering units, of the 
direct address or symbol (variable)

Minimum EU 
Value

The minimum value, in engineering units, of the 
direct address or symbol (variable)

Maximum PLC 
Value

The maximum raw (unscaled) value of the direct 
address or symbol (variable) in the PLC

See Note 3,Notes, 
page 192

Minimum PLC 
Value

The minimum raw (unscaled) value of the direct 
address or symbol (variable) in the PLC

See Note 3,Notes, 
page 192

Value Visible Indicates whether a digital display of the scaled 
value is to be shown

Value Font The font for the digital display of the value, if 
shown

Bar Background The background color for the bar indicator area

Bar Color The color for the indicator bar (when scaled value 
within High/Low limits)

High High Limit 
Value

The value in engineering units for the ’High High’ 
limit

High High Limit 
Color

The color for the indicator bar when scaled value 
is greater than the ‘High High’ limit

High Limit Value The value in engineering units for the ‘High’ limit

High Limit Color The color for the indicator bar when scaled value 
is greater than the ‘High’ limit

Low Limit Value The value in engineering units for the ‘Low’ limit

Low Limit Color The color for the indicator bar when scaled value 
is less than the ‘Low’ limit

Low Low Limit 
Value

The value in engineering units for the ‘Low Low’ 
limit

Low Low Limit 
Color

The color for the indicator bar when scaled value 
is less than the ‘Low Low’ limit

Limit Deadband The deadband (as percentage of EU range) to 
apply to High/Low limit checking

0 to 10

Border Width The width (in pixels) for the graphic object’s 
border

0 to 32

Border Color The color for the graphic object’s border

PLC Value A simulated, raw (unscaled) input value for testing 
the graphic object

See Note 3,Notes, 
page 192

Property Description Limits
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Vertical Indicator
A Vertical Indicator provides an analog representation of the value of a symbol 
(variable) or direct address in a PLC by drawing a vertical bar whose length is 
proportional to the value as a percentage of its range in engineering units.

The properties for the Vertical Indicator are listed below:

Property Description Limits

Name The name for the graphic object

Address The direct address (or the name of a symbol 
(variable)) to monitor

See Note 1,Notes, 
page 192

Data Type The data type of the direct address or symbol 
(variable)

See Note 2,Notes, 
page 192

Background The background color for the graphic object

Label The label to be displayed as part of the graphic 
object

Label Color The color for the label

Label Font The font for the label

Major Scale 
Divisions

The number of major (labeled) scale divisions 0 to 100

Minor Scale 
Divisions

The number of minor (unlabeled) scale divisions 0 to 100

Scale Color The color for the scale and its labels

Scale Font The font for scale labels

Scale Precision The number of fractional digits to be shown for 
scale labels (Set to -1 to use a general 
exponential format.)

-1 to 6

Maximum EU 
Value

The maximum value, in engineering units, of the 
direct address or symbol (variable)

Minimum EU 
Value

The minimum value, in engineering units, of the 
direct address or symbol (variable)

Maximum PLC 
Value

The maximum raw (unscaled) value of the direct 
address or symbol (variable) in the PLC

See Note 3,Notes, 
page 192

Minimum PLC 
Value

The minimum raw (unscaled) value of the direct 
address or symbol (variable) in the PLC

See Note 3,Notes, 
page 192

Bar Background The background color for the bar indicator area

Bar Color The color for the indicator bar (when scaled value 
within High/Low limits)

High High Limit 
Value

The value in engineering units for the ’High High’ 
limit
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Horizontal or Vertical Slider
A Horizontal or Vertical Slider provides an analog representation of the value of a 
symbol (variable) or direct address in a PLC by drawing a scroll bar whose "thumb" 
position is proportional to the value as a percentage of its range in engineering units. 
With a mouse, a user can change the value of the scroll bar and cause a new value 
to be sent to the PLC.

The properties for the Horizontal or Vertical Slider are listed below:

High High Limit 
Color

The color for the indicator bar when scaled value 
is greater than the ‘High High’ limit

High Limit Value The value in engineering units for the ‘High’ limit

High Limit Color The color for the indicator bar when scaled value 
is greater than the ‘High’ limit

Low Limit Value The value in engineering units for the ‘Low’ limit

Low Limit Color The color for the indicator bar when scaled value 
is less than the ‘Low’ limit

Low Low Limit 
Value

The value in engineering units for the ‘Low Low’ 
limit

Low Low Limit 
Color

The color for the indicator bar when scaled value 
is less than the ‘Low Low’ limit

Limit Deadband The deadband (as percentage of EU range) to 
apply to High/Low limit checking

0 to 10

Border Width The width (in pixels) for the graphic object’s 
border

0 to 32

Border Color The color for the graphic object’s border

PLC Value A simulated, raw (unscaled) input value for testing 
the graphic object

See Note 3,Notes, 
page 192

Property Description Limits

Property Description Limits

Name The name for the graphic object

Address The direct address (or the name of a symbol 
(variable)) to monitor

See Note 1,Notes, 
page 192

Data Type The data type of the direct address or symbol 
(variable)

See Note 2,Notes, 
page 192

Background The background color for the graphic object

Label The label to be displayed as part of the graphic 
object

Label Color The color for the label

Label Font The font for the label
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Horizontal or Vertical Selector
A Horizontal or Vertical Selector allows a user to make a selection from a set of 
choices. When a selection is made, the value corresponding to the choice is sent to 
the PLC. The choices are shown as labels of a "scale," with the current selection 
indicated by the position of the "thumb" of a scroll bar.

Major Scale 
Divisions

The number of major (labeled) scale divisions 0 to 100

Minor Scale 
Divisions

The number of minor (unlabeled) scale divisions 0 to 100

Scale Color The color for the scale and its labels

Scale Font The font for scale labels

Scale Precision The number of fractional digits to be shown for 
scale labels (Set to -1 to use a general 
exponential format.)

-1 to 6

Maximum EU 
Value

The maximum value, in engineering units, of the 
direct address or symbol (variable)

Minimum EU 
Value

The minimum value, in engineering units, of the 
direct address or symbol (variable)

Maximum PLC 
Value

The maximum raw (unscaled) value of the direct 
address or symbol (variable) in the PLC

See Note 3,Notes, 
page 192

Minimum PLC 
Value

The minimum raw (unscaled) value of the direct 
address or symbol (variable) in the PLC

See Note 3,Notes, 
page 192

Block Increment The amount that the scaled value should change 
when the scroll bar’s scroll area is clicked

Unit Increment The amount that the scaled value should change 
when the scrollbar’s arrow buttons are clicked

Border Width The width (in pixels) for the graphic object’s 
border

0 to 32

Border Color The color for the graphic object’s border

Property Description Limits
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The properties for the Horizontal or Vertical Selector are listed below:

Digital Indicator
A Digital Indicator provides a numeric representation of the value of a symbol 
(variable) or direct address in a PLC. The value can be shown in various formats, 
and can be made to change color when a preset high or low limit is exceeded.

The properties for the Digital Indicator are listed below:

Property Description Limits

Name The name for the graphic object

Address The direct address (or the name of a symbol 
(variable)) to monitor

See Note 1,Notes, 
page 192

Data Type The data type of the direct address or symbol 
(variable)

See Note 2,Notes, 
page 192

Background The background color for the graphic object

Choices The choices for the selector. Each choice is given 
as a ‘label=value’ entry (when a user selects 
‘label,’ ‘value’ is sent to PLC)

Minimum of two 
choices required

Label The label to be displayed as part of the graphic 
object

Label Color The color for the label

Label Font The font for the label

Scale Visible Indicates whether a "scale," labeled with the 
choices, is to be shown

Scale Color The color for the scale and its labels

Scale Font The font for scale labels

Border Width The width (in pixels) for the graphic object’s 
border

0 to 32

Border Color The color for the graphic object’s border

Property Description Limits

Name The name for the graphic object

Address The direct address (or the name of a symbol 
(variable)) to monitor

See Note 1,Notes, 
page 192

Data Type The data type of the direct address or symbol 
(variable)

See Note 2,Notes, 
page 192

Background The background color for the graphic object

Label The label to be displayed as part of the graphic 
object

Label Color The color for the label
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Label Font The font for the label

Value Format The format (decimal, hex, etc.) to use in displaying 
the scaled value

Value Precision The number of fractional digits to be shown for the 
scaled value (Set to -1 to use a general exponential 
format.)

-1 to 6

Value 
Background

The background color for the value display area

Value Color The text color for the digital display of the value

Value Font The font for the digital display of the value

Units The label for the engineering units of the value 
(appended to the numeric display of the value)

Maximum EU 
Value

The maximum value, in engineering units, of the 
direct address or symbol (variable)

Minimum EU 
Value

The minimum value, in engineering units, of the 
direct address or symbol (variable)

Maximum PLC 
Value

The maximum raw (unscaled) value of the direct 
address or symbol (variable) in the PLC

See Note 3,Notes, 
page 192

Minimum PLC 
Value

The minimum raw (unscaled) value of the direct 
address or symbol (variable) in the PLC

See Note 3,Notes, 
page 192

High High Limit 
Value

The value in engineering units for the ’High High’ 
limit

High High Limit 
Color

The color for the indicator bar when scaled value is 
greater than the ‘High High’ limit

High Limit Value The value in engineering units for the ‘High’ limit

High Limit Color The color for the indicator bar when scaled value is 
greater than the ‘High’ limit

Low Limit Value The value in engineering units for the ‘Low’ limit

Low Limit Color The color for the indicator bar when scaled value is 
less than the ‘Low’ limit

Low Low Limit 
Value

The value in engineering units for the ‘Low Low’ 
limit

Low Low Limit 
Color

The color for the indicator bar when scaled value is 
less than the ‘Low Low’ limit

Limit Deadband The deadband (as percentage of EU range) to 
apply to High/Low limit checking

0 to 10

Border Width The width (in pixels) for the graphic object’s border 0 to 32

Border Color The color for the graphic object’s border

Property Description Limits
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Message Display
A Message Display shows a text message based on the value of a symbol (variable) 
or direct address in a PLC. For each specified message, a value is also specified 
that will trigger its display.

The properties for the Message Display are listed below:

PLC Value A simulated, raw (unscaled) input value for testing 
the graphic object

See Note 3,Notes, 
page 192

Property Description Limits

Property Description Limits

Name The name for the graphic object

Address The direct address (or the name of a symbol 
(variable)) to monitor

See Note 1,Notes, 
page 192

Data Type The data type of the direct address or symbol 
(variable)

See Note 2,Notes, 
page 192

Background The background color for the graphic object

Messages The set of messages to display. Each message is 
given as a ‘value=text’ entry (when the PLC value 
equals ‘value’, ‘text’ is displayed as the message)

Minimum of one 
message required

Message 
Background

The background color for the message display 
area

Message Color The color for the message text

Message Font The font for the message text

Label The label to be displayed as part of the graphic 
object

Label Color The color for the label

Label Font The font for the label

Border Width The width (in pixels) for the graphic object’s 
border

0 to 32

Border Color The color for the graphic object’s border

PLC Value A simulated input value for testing the graphic 
object

See Note 3,Notes, 
page 192
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Push Button
A Push Button allows a user to send preset value(s) to a PLC when clicked with the 
mouse.

The properties for the Push Button are listed below:

Direct Output Station
The Direct Output Station allows a user to enter a value into a text input field directly 
with their keyboard. When the entered text represents a numeric value that is within 
preset high and low limits, a Set button is enabled. While the Set button is enabled, 
the entered value will be sent to the PLC whenever the user presses either the Set 
button or the ENTER key (if the input field has keyboard input focus).

Property Description Limits

Name The name for the graphic object

Address The direct address (or the name of a symbol 
(variable)) to monitor

See Note 1,Notes, 
page 192

Data Type The data type of the direct address or symbol 
(variable)

See Note 2,Notes, 
page 192

Background The background color for the graphic object

Values The value(s) to send to the PLC See Note 4,Notes, 
page 192

Reset Values The value(s) to send to the PLC after the reset 
delay time has expired. If no reset values are 
provided, no reset action will occur.

Reset Delay The delay time (milliseconds) that the Push 
Button should wait after sending the value(s) to 
the PLC before sending the reset value(s).

0-2000

Label The label to be displayed as part of the graphic 
object

Label Color The color for the label

Label Font The font for the label

Button Label The text label for the button

Button 
Background

The color for the knob 0 to 100

Button Label 
Color

The color for the button label

Button Label Font The font for the button label

Border Width The width (in pixels) for the graphic object’s 
border

0 to 32

Border Color The color for the graphic object’s border
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The properties for the Direct Output Station are listed below:

LED
The Indicator Light provides a dual-state indication of the value of a symbol 
(variable) or direct address in a PLC. Unless the Input Inverted property is set to 
TRUE, an input value of zero is deemed OFF and a non-zero value is deemed ON. 
If the Flash Interval property is set to greater than zero, the light will flash while the 
input value is on.

Property Description Limits

Name The name for the graphic object

Address The direct address (or the name of a symbol 
(variable)) to monitor

See Note 1,Notes, 
page 192

Data Type The data type of the direct address or symbol 
(variable)

See Note 2,Notes, 
page 192

Background The background color for the graphic object

Label The label to be displayed as part of the graphic 
object

Label Color The color for the label

Label Font The font for the label

Maximum EU 
Value

The maximum value, in engineering units, of the 
direct address or symbol (variable)

Minimum EU 
Value

The minimum value, in engineering units, of the 
direct address or symbol (variable)

Maximum PLC 
Value

The maximum raw (unscaled) value of the direct 
address or symbol (variable) in the PLC

See Note 3,Notes, 
page 192

Minimum PLC 
Value

The minimum raw (unscaled) value of the direct 
address or symbol (variable) in the PLC

See Note 3,Notes, 
page 192

Maximum Input The maximum value, in engineering units, that is 
valid for the entered input value

Minimum Input The minimum value, in engineering units, that is 
valid for the entered input value

Border Width The width (in pixels) for the graphic object’s 
border

0 to 32

Border Color The color for the graphic object’s border
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The properties for the Indicator Light are listed below:

Property Description Limits

Name The name for the graphic object

Address The direct address (or the name of a symbol 
(variable)) to monitor

See Note 1,Notes, 
page 192

Data Type The data type of the direct address or symbol 
(variable)

See Note 2,Notes, 
page 192

Background The background color for the graphic object

Label The label to be displayed as part of the graphic 
object

Label Color The color for the label

Label Font The font for the label

Off Word The text to show when the input value is off

Off Word 
Background

The background color of the light when the Off 
Word is shown

Off Word Color The color for the Off Word text

Off Word Font The font for the Off Word text

On Word The text to show when the input value is on

On Word 
Background

The background color of the light when the On 
Word is shown

On Word Color The color for the On Word font

On Word Font The font for the On Word text

Flash Interval The flashing time period (in milliseconds) of the 
light when the input value is on. Set to zero for no 
flashing.

200 to 2000

Shape The shape (circle, rectangle, etc.) of the light

Input Inverted If TRUE, inverts the input value. (Light will show 
the Off Word when input value is on.)

Border Width The width (in pixels) for the graphic object’s 
border

0 to 32

Border Color The color for the graphic object’s border

PLC Value A simulated input value for testing the graphic 
object

See Note 3,Notes, 
page 192
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Motor Control Station
The Motor Control Station is designed to mimic the typical start/stop push button 
station that is often used to control motors. This graphic object is essentially a 
composite of two Push Buttons and an Indicator Light. In order to make it easier to 
set this object’s many properties, a Customizer is provided. All of the properties 
(except Name) are set with its Customizer, not with the Graphic Editor’s Property 
Sheet.

The properties for the Motor Control Station are listed below:

Analog Meter
An Analog Meter provides an analog representation of the value of a symbol 
(variable) or direct address in a PLC by drawing a pointer on a circular dial whose 
position is proportional to the value as a percentage of its range in engineering units. 
The size of the meter’s circular dial (degrees sweep of a circle), the colors for the 
dial, and the style of the pointer can all be set.

Property Description Limits

Name The name for the graphic object

Background The background color for the graphic object

Label The label to be displayed as part of the graphic object

Label Color The color for the label

Label Font The font for the label

Border Width The width (in pixels) for the graphic object’s border 0 to 32

Border Color The color for the graphic object’s border

LED Same properties as the Indicator Light graphic object, 
excluding the common properties listed above

Top Push Button Same properties as the Push Button graphic object, 
excluding the common properties listed above

Bottom Push 
Button

Same properties as the Push Button graphic object, 
excluding the common properties listed above
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The properties for the Analog Meter are listed below:

Property Description Limits

Name The name for the graphic object

Address The direct address (or the name of a symbol 
(variable)) to monitor

See Note 1,Notes, 
page 192

Data Type The data type of the direct address or symbol 
(variable)

See Note 2,Notes, 
page 192

Background The background color for the graphic object

Label The label to be displayed as part of the graphic 
object

Label Color The color for the label

Label Font The font for the label

Major Scale 
Divisions

The number of major (labeled) scale divisions 0 to 100

Minor Scale 
Divisions

The number of minor (unlabeled) scale divisions 0 to 100

Scale Color The color for the scale and its labels

Scale Font The font for scale labels

Scale Precision The number of fractional digits to be shown for 
scale labels (Set to -1 to use a general 
exponential format.)

-1 to 6

Maximum EU 
Value

The maximum value, in engineering units, of the 
direct address or symbol (variable)

Minimum EU 
Value

The minimum value, in engineering units, of the 
direct address or symbol (variable)

Maximum PLC 
Value

The maximum raw (unscaled) value of the direct 
address or symbol (variable) in the PLC

See Note 3,Notes, 
page 192

Minimum PLC 
Value

The minimum raw (unscaled) value of the direct 
address or symbol (variable) in the PLC

See Note 3,Notes, 
page 192

Dial Degrees 
Sweep

The amount of a circular arc to use for drawing the 
dial

60 to 300

Pointer Type The type (needle, arrow head, etc.) of pointer to 
use

Pointer Color The color for the pointer

Dial Color The color for the dial (that part that is within the 
High/Low limits)

High High Limit 
Value

The value in engineering units for the ‘High’ limit

High High Limit 
Color

The color for the indicator bar when scaled value 
is greater than the ‘High High’ limit
184 35016143 12/2011



Monitoring
Rotary Slider
A Rotary Slider provides an analog representation of the value of a symbol (variable) 
or direct address in a PLC by drawing a knob on a circular dial whose position is 
proportional to the value as a percentage of its range in engineering units. The size 
of the circular dial (degrees sweep of a circle) and knob color can be set. With a 
mouse, a user can change the position of the knob and cause a new value to be sent 
to the PLC.

The properties for the Rotary Slider are listed below:

High Limit Value The value in engineering units for the ‘High’ limit

High Limit Color The color for the indicator bar when scaled value 
is greater than the ‘High’ limit

Low Limit Value The value in engineering units for the ‘Low’ limit

Low Limit Color The color for the indicator bar when scaled value 
is less than the ‘Low’ limit

Low Low Limit 
Value

The value in engineering units for the ‘Low Low’ 
limit

Low Low Limit 
Color

The color for the indicator bar when scaled value 
is less than the ‘Low Low’ limit

Border Width The width (in pixels) for the graphic object’s 
border

0 to 32

Border Color The color for the graphic object’s border

PLC Value A simulated, raw (unscaled) input value for testing 
the graphic object

See Note 3,Notes, 
page 192

Property Description Limits

Property Description Limits

Name The name for the graphic object

Address The direct address (or the name of a symbol 
(variable)) to monitor

See Note 1,Notes, 
page 192

Data Type The data type of the direct address or symbol 
(variable)

See Note 2,Notes, 
page 192

Background The background color for the graphic object

Label The label to be displayed as part of the graphic 
object

Label Color The color for the label

Label Font The font for the label

Major Scale 
Divisions

The number of major (labeled) scale divisions 0 to 100
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Rotary Selector
A Rotary Selector allows a user to make a selection from a set of choices. When a 
selection is made, the value corresponding to the choice is sent to the PLC. The 
choices are shown as labels of a "scale," with the current selection indicated by the 
position of the knob. The size of the circular dial (degrees sweep of a circle) and 
knob color can be set.

The properties for the Rotary Selector are listed below:

Minor Scale 
Divisions

The number of minor (unlabeled) scale divisions 0 to 100

Scale Color The color for the scale and its labels

Scale Font The font for scale labels

Scale Precision The number of fractional digits to be shown for 
scale labels (Set to -1 to use a general 
exponential format.)

-1 to 6

Dial Degrees 
Sweep

The amount of a circular arc to use for drawing the 
dial

60 to 300

Dial Color The color for the dial

Knob Color The color for the knob

Maximum EU 
Value

The maximum value, in engineering units, of the 
direct address or symbol (variable)

Minimum EU 
Value

The minimum value, in engineering units, of the 
direct address or symbol (variable)

Maximum PLC 
Value

The maximum raw (unscaled) value of the direct 
address or symbol (variable) in the PLC

See Note 3,Notes, 
page 192

Minimum PLC 
Value

The minimum raw (unscaled) value of the direct 
address or symbol (variable) in the PLC

See Note 3,Notes, 
page 192

Border Width The width (in pixels) for the graphic object’s 
border

0 to 32

Border Color The color for the graphic object’s border

Property Description Limits

Property Description Limits

Name The name for the graphic object

Address The direct address (or the name of a symbol 
(variable)) to monitor

See Note 1,Notes, 
page 192

Data Type The data type of the direct address or symbol 
(variable)

See Note 2,Notes, 
page 192

Background The background color for the graphic object
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Trend Recorder
A Trend Recorder provides a continuous, time-based charting of the value of up to 
six symbol (variable)s or direct addresses in a PLC. A Trend Recorder emulates a 
strip-chart recorder, with the pens on the right, and the "paper" moving from right to 
left. A vertical scale can be shown on the left side of the chart for showing the range 
of the values being recorded, and a horizontal scale can be shown below the chart 
for showing the time span of the chart. The rate at which the chart is updated, and 
the appearance of the chart can be set.

In order to make it easier to set this object’s many properties, a Customizer is 
provided. All properties (except Name) are set with its Customizer, not with the 
Graphic Editor’s Property Sheet.

The following table describes properties for the Trend Recorder. Properties 
available for each pen are described in the next table:

Choices The choices for the selector. Each choice is given 
as a ‘label=value’ entry (when a user selects 
‘label,’ ‘value’ is sent to PLC)

Minimum of two 
choices required

Label The label to be displayed as part of the graphic 
object

Label Color The color for the label

Label Font The font for the label

Scale Visible Indicates whether a "scale," labeled with the 
choices, is to be shown

Scale Color The color for the scale and its labels

Scale Font The font for scale labels

Dial Degrees 
Sweep

The amount of a circular arc to use for drawing the 
dial

60 to 300

Knob Color The color for the knob

Border Width The width (in pixels) for the graphic object’s 
border

0 to 32

Border Color The color for the graphic object’s border

Property Description Limits

Property Description Limits

Name The name for the graphic object

Background The background color for the graphic object

Label The label to be displayed as part of the graphic 
object

Label Color The color for the label

Label Font The font for the label
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These Trend Recorder properties are available for each pen:

Major Scale 
Divisions

The number of major (labeled) scale divisions 0 to 100

Minor Scale 
Divisions

The number of minor (unlabeled) scale divisions 0 to 100

Scale Color The color for the scale and its labels

Scale Font The font for scale labels

Scale Precision The number of fractional digits to be shown for 
scale labels (Set to -1 to use a general 
exponential format.)

-1 to 6

Maximum EU 
Value

The maximum value, in engineering units, of the 
direct address or symbol (variable)

Minimum EU 
Value

The minimum value, in engineering units, of the 
direct address or symbol (variable)

Update Period The update interval (in seconds) for the chart 0.5 to 120

Time Scale 
Divisions

The number of horizontal scale divisions 0 to 6

Chart Background The color for the chart area

Grid Color The color of the grid drawn in the chart area

Vertical Grid 
Divisions

The number of vertical divisions for the grid 0 to 100

Border Width The width (in pixels) for the graphic object’s 
border

0 to 32

Border Color The color for the graphic object’s border

Property Description Limits

Address The direct address (or the name of a symbol 
(variable)) to monitor.

See Note 1,Notes, 
page 192

Data Type The data type of the direct address or symbol 
(variable).

See Note 2,Notes, 
page 192

Maximum PLC 
Value

The maximum raw (unscaled) value of the direct 
address or symbol (variable) in the PLC.

See Note 3,Notes, 
page 192

Minimum PLC 
Value

The minimum raw (unscaled) value of the direct 
address or symbol (variable) in the PLC.

See Note 3,Notes, 
page 192

Pen Color The color of the "pen" used to record the scaled 
value.

Pen Label The label used to identify the pen.

Property Description Limits
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Display Link
A Display Link is a special graphic object that allows the user to switch to another 
graphic display by clicking on it with a mouse. To indicate to the user that the object 
is a link to another display, the text label for the link is underlined and the mouse 
cursor changes to a hand icon when the mouse is moved over it. This object is 
especially useful when the Graphic Editor is used in its view mode, where no drop-
down list of graphic displays is available for selecting a display.

A Display Link can also be used as a hyperlink to an HTML file. If a URL is entered 
as the Link Display Name, the URL can be opened in a new browser window if the 
user presses the SHIFT key while they click the link; otherwise, the existing browser 
window is replaced with the URL when the link is clicked.

If the Link Display Name is blank, then the Label will be shown as not underlined, 
and the displayed object becomes a simple text label.

The properties for the Display Link are listed below:.

Datalogging History
A Datalogging History provides a continuous, time-based charting of the value of up 
to six symbols (variables) coming from the log file of the Datalogging service. A 
Datalogging History emulates a strip-chart recorder, with the pens on the right, and 
the "paper" moving from right to left. A vertical scale can be shown on the left side 
of the chart for showing the range of the values being recorded, and a horizontal 
scale can be shown below the chart for showing the time span of the chart.

NOTE: In order to plot the Datalogging History, you must select the Timestamp 
option in the Datalogging Service (see page 111) configuration window.

In order to make it easier to set this object’s many properties, a Customizer is 
provided. All properties (except Name) are set with its Customizer, not with the 
Graphic Editor’s Property Sheet.

3 buttons are available in edition and animation mode:
Reload: the Datalogging History object is a static widget. This button enables to 
refresh the value used to build the chart.
+: zoom on the trend. It decreases the time scale in order to have a better vision 
of a part of the trend.
-: zoom out on the trend. It increases the time scale in order to have a larger vision 
of the trend.

Property Description Limits

Label The label for the link

Link Display Name The name of the graphic display to be loaded 
when the link is clicked, or a URL of a Web page

Label Color The color for the label

Label Font The font for the label
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If you place the mouse cursor on a point of the trend, a tooltip appears displaying 
the exact value at that point. Stay pressed and rollover several points to display the 
tooltips of all of those points.

Releasing the mouse button and rolling over any point will cleanup existing tooltips 
and display a new one.

Right click on it to make it disappear.

The following table describes properties for the Datalogging History. Properties 
available for each pen are described in the next table:

Property Description Limits

Name The name for the graphic object

Background The background color for the graphic object

Label The label to be displayed as part of the graphic object

Label Color The color for the label

Label Font The font for the label

Major Scale 
Divisions

The number of major (labeled) scale divisions 0 to 100

Minor Scale 
Divisions

The number of minor (unlabeled) scale divisions 0 to 100

Scale Color The color for the scale and its labels

Scale Font The font for scale labels

Scale Precision The number of fractional digits to be shown for scale 
labels (Set to -1 to use a general exponential format.)

-1 to 6

Maximum EU 
Value

The maximum value, in engineering units, of the symbol 
(variable)

Minimum EU 
Value

The minimum value, in engineering units, of the symbol 
(variable)

Time Scale 
Divisions

The number of horizontal scale divisions 0 to 6

Chart Background The color for the chart area

Grid Color The color of the grid drawn in the chart area

Vertical Grid 
Divisions

The number of vertical divisions for the grid 0 to 100

Border Width The width (in pixels) for the graphic object’s border 0 to 32

Border Color The color for the graphic object’s border

Zoom Coefficient Set a coefficient for the zoom. In example, if the zoom 
coefficient is set to 2, the timescale will be divided by 2 
by clicking + in animation mode.
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These Datalogging History properties are available for each pen:

Property Description Limits

Name of the CSV 
file

The name of the CSV file used to build the trend. 
Note: the log file must include timestamps 
(see page 115).

Address The name of a symbol (variable) to monitor.

Data Type The data type of the symbol (variable).
Note: the data type must be numerical.

Maximum PLC 
Value

The maximum raw (unscaled) value of the symbol 
(variable) in the PLC.

See Note 3,Notes, 
page 192

Minimum PLC 
Value

The minimum raw (unscaled) value of the symbol 
(variable) in the PLC.

See Note 3,Notes, 
page 192

Pen Color The color of the "pen" used to record the scaled 
value.

Pen Label The label used to identify the pen.
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Notes
These are the notes for the chapter.

1. If the Address property of a graphic object is a direct address, the Data Type property 
is set to UNDEFINED, a default Data Type (BOOL, INT,DINT or REAL based on the 
implied size of the data value) is used. If the Address property is a symbol (variable) 
name, the Data Type property does not have to be specified and can be set to 
UNDEFINED. However, if the Data Type property is specified for a symbol (variable), 
it must exactly match the symbol (variable)’s actual data type.
If the Address property is a direct address for a discrete PLC reference (Quantum 
0x/1x reference), the Data Type property must be set to BOOL. The Data Type 
property may be set to BOOL only for a discrete PLC reference.

2. The meaning of the possible values of the Data Type property are:

Data Type Meaning

UNDEFINED no data type specified

BOOL 1-bit discrete (Boolean)

SHORT 8-bit signed integer

USHORT 8-bit unsigned integer

INT 16-bit signed integer

UINT 16-bit unsigned integer

DINT 32-bit signed integer

UDINT 32-bit unsigned integer

REAL 32-bit IEEE floating point

TIME 32-bit unsigned integer (in milliseconds)

DATE Date (32-bit BCD)

TOD Time of Day (32-bit BCD)

DT Date and Time (64-bit BCD)

3. The limits for the Maximum PLC Value and Minimum PLC Value properties are the 
natural limits of the Data Type property that is set. A Data Type setting of UNDEFINED 
is treated as a REAL with respect to its limit values.

4. For a Push Button, a minimum of one value must be provided. If the Address property 
is a symbol (variable) name, then only one value will ever be sent to the PLC, and any 
additional values are ignored. If the Address property is a direct address, then all of 
the values provided will be sent to the PLC as an array of values starting at the 
specified direct address.
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Extended Graphic Objects

Overview
The set of extended graphic objects provided in Graphic Editor is intended to 
support building graphic displays that mimic advanced graphic panels. All of the data 
monitoring and control objects have built-in communication capabilities and are 
designed as standalone graphic objects.

Additionally, to support customers who want to put several simple applets on a 
single HTML page, each object in the Graphic Editor set is provided in an applet 
version. When used in conjunction with the LiveBeanApplet, Graphic Editor 
graphic objects can be used in the same way as the LiveLabelApplet.

Be aware, however, that if communication to the device linked to the graphic object 
is lost, the object becomes inoperative without the end device’s knowledge.

For example, say you have programmed a pushbutton object to jog a motor when 
the button is depressed and to stop jogging when the button is released. If 
communications are lost while the button is depressed, the motor will continue to jog 
even when the button is released. Graphic objects should not be used to control 
situations such as this unless other srike interlock methods are installed in the 
system.

WARNING
UNINTENDED EQUIPMENT OPERATION
Do not use graphic objects in situations where loss of communication to the 
module can affect human or material integrity.

Failure to follow these instructions can result in death, serious injury, or 
equipment damage.
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Extended Analog Meter
An extended analog meter provides an analog representation of the value of a 
symbol (variable) or direct address in a PLC. It draws a pointer on a circular dial 
whose position is proportional to the value as a percentage of its range in 
engineering units. The size of the meter’s circular dial (measured in degrees of a 
circle), the dial colors, and the pointer style can all be set.

The properties of the extended analog meter are listed below:

Property Description Limits

Name The name of the graphic object

Address The direct address or the name of a symbol 
(variable) to monitor

See Note 1, Notes, 
page 204

Data Type The data type of the direct address or symbol 
(variable)

See Note 2, Notes, 
page 204

Background The background color of the graphic object

Label The label to be displayed as part of the graphic 
object

Label Color The label color

Label Font The label font

Maximum EU 
Value

The maximum value, in engineering units, of the 
direct address or symbol (variable)

Minimum EU 
Value

The minimum value, in engineering units, of the 
direct address or symbol (variable)

Maximum PLC 
Value

The maximum raw (unscaled) value of the direct 
address or symbol (variable) in the PLC

See Note 3, Notes, 
page 204

Minimum PLC 
Value

The minimum raw (unscaled) value of the direct 
address or symbol (variable) in the PLC

See Note 3, Notes, 
page 204

Bitmap Choices The bitmap to display

Dial Degrees 
Sweep

The range in which degrees vary

Pointer Type The graphic display of the pointer

Pointer Color The color of the pointer

Border Width The width (in pixels) of the graphic object’s border 0 to 32

Border Color The color of the graphic object’s border

PLC Value The default value of the PLC
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ASCII Text Writer
The ASCII Text Writer is based on the message display widget. It allows you to input 
new text.

The properties of the ASCII Text Writer are listed below:

Bar Graph
A bar graph provides an analog representation of the value of a symbol (variable) or 
direct address in a PLC. It draws a vertical bar whose length is proportional to the 
value as a percentage of its range in engineering units.

The properties of the bar graph are listed below:

Property Description Limits

Name The name of the graphic object

Address The direct address or the name of a symbol 
(variable) to monitor

See Note 1, Notes, 
page 204

Max. Text Length The maximum length of the text

Text Color The color of the text

Text Font The font used for the text

Swap Bytes False if target order of bytes is same as PC

Value The text itself

Property Description Limits

Name The name of the graphic object

Address The direct address or the name of a symbol 
(variable) to monitor

See Note 1, 
Notes, page 204

Data Type The data type of the direct address or symbol 
(variable)

See Note 2, 
Notes, page 204

Background The background color of the graphic object

Label The label to be displayed as part of the graphic 
object

Label Color The color of the label

Label Font The font used on the label

Maximum EU 
Value

The maximum value, in engineering units, of the 
direct address or symbol (variable)

Minimum EU 
Value

The minimum value, in engineering units, of the 
direct address or symbol (variable)

Maximum PLC 
Value

The maximum raw (unscaled) value of the direct 
address or symbol (variable) in the PLC

See Note 3, 
Notes, page 204
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Bitmap
The bitmap widget displays a static bitmap on the screen.

The properties of the bitmap widget are listed below:

Minimum PLC 
Value

The minimum raw (unscaled) value of the direct 
address or symbol (variable) in the PLC

See Note 3, 
Notes, page 204

Bar Background The background color of the bar indicator area

Bar Color The color of the indicator bar (when scaled value 
is within High/Low limits)

High High Limit 
Value

The value of the High High limit in engineering 
units

High High Limit 
Color

The color of the indicator bar when the scaled 
value is greater than the High High limit

High Limit Value The value of the High limit in engineering units

High Limit Color The color of the indicator bar when scaled value is 
greater than the High limit

Low Limit Value The value of the Low limit in engineering units

Low Limit Color The color of the indicator bar when the scaled 
value is less than the Low limit

Low Low Limit 
Value

The value of the Low Low limit in engineering 
units

Low Low Limit 
Color

The color of the indicator bar when the scaled 
value is less than the Low Low limit

Limit Deadband The deadband (as percentage of EU range) to 
apply to High/Low limit checking

0 to 10

Border Width The width (in pixels) of the graphic object’s border 0 to 32

Border Color The color of the graphic object’s border

PLC Value A simulated, raw (unscaled) input value for testing 
the graphic object

See Note 3, 
Notes, page 204

Property Description Limits

Property Description Limits

Name The name of the graphic object

Background The background color of the graphic object See Note 1, 
Notes, page 204

Label The label to be displayed as part of the graphic 
object

Label Color The color of the label

Label Font The font used for the label
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Adding Images
You can add images into the module in one of the following way:

Add your images into the images.zip file (path: FLASH1/wwwroot).
Create a directory into the module (i.e. FLASH1/wwwroot/bitmaps). Copy your 
images into this directory. In this case, you need to specify the path of the images 
you want to use (i.e. FLASH1/wwwroot/bitmaps/key.gif).

Generic Bitmap
The generic bitmap widget lets you display one static bitmap for each distinct value 
of a PLC variable. It can be used to display dynamic animations, for instance the 
changing level in a tank.

The properties of the Generic Bitmap widget are listed below:

Border Width The width (in pixels) of the graphic object’s border

Border Color The color of the graphic object’s border

Bitmap Choices File names of custom bitmaps to display.
Refer to the next paragrah for information on 
adding images into the module.

Property Description Limits

Step Action

1 Create an images folder on your PC.

2 Copy the images you want to use in this folder.

3 Import the user.jar file from the module to the PC (path: 
NAND/FLASH1/wwwroot/classes) using a FTP client.

4 Open the user.jar file using a file archiver.

5 Drag and drop the images folder in the user.jar file. Make sure the relative path 
of the image files is ‘images/’.

6 Transfer the user.jar file back to the module using a FTP client.

Property Description Limits

Name The name of the graphic object

Address The direct address or the name of a symbol 
(variable) to monitor

See Note 1, Notes, 
page 204

Data Type The data type of the direct address or symbol 
(variable)

See Note 2, Notes, 
page 204

Background The background color of the graphic object See Note 1, Notes, 
page 204

Label The label to be displayed as part of the graphic 
object
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Graphic Link
A graphic link is a special graphic object that lets you switch to another graphic 
display by clicking on it. Graphic links can also be recognized by their underlined 
labels, and the mouse cursor changes to a hand icon when the mouse moves over 
them. This object is especially useful when Graphic Editor is used in view mode, 
where no drop-down list of graphic displays is available.

A graphic link can also be used as a hyperlink to an HTML file. If a URL is entered 
as the Link Display Name, the URL can be opened in a new browser window by 
simultaneously pressing the SHIFT key and clicking the link. Otherwise, the URL 
opens in the existing browser window when the link is clicked.

If the Link Display Name is blank, then the label is not underlined, and the 
displayed object becomes a simple text label.

The properties of the display link are listed below:

Label Color The color of the label

Label Font The font used for the label

Bitmap Choices File names of custom bitmaps to display.
Refer to the next paragrah for information on 
adding images into the module.

Border Width The width (in pixels) of the graphic object’s border

Border Color The color of the graphic object’s border

PLC Value A simulated input value for testing the graphic 
object behavior

Property Description Limits

Property Description Limits

Label The link label

Link Display Name The name of the graphic display to be loaded 
when the link is clicked, or the URL of a Web page

Label Color The color of the label

Label Font The font used for the label

Bitmap Choices The filename of the bitmap on which to click
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Indicator Light
The indicator light displays the value of a symbol (variable) or direct address in a 
PLC with two possible states. An input value of 0 is considered off and a non-zero 
value is considered on. If the Flash Interval property is set to a value greater than 
0, the light flashes while the input value is on. There is a bitmap for the on state and 
a different one for the off state.

The properties of the indicator light are listed below:

Property Description Limits

Name The name of the graphic object

Address The direct address or the name of a symbol 
(variable) to monitor

See Note 1, Notes, 
page 204

Data Type The data type of the direct address or symbol 
(variable)

See Note 2, Notes, 
page 204

Background The background color of the graphic object

Label The label to be displayed as part of the graphic 
object

Label Color The color of the label

Label Font The font used for the label

OFF Word The text to display when the input value is off

OFF Bitmap 
Choice

The light bitmap when the OFF word is displayed

OFF Word Color The color of the OFF word font

OFF Word Font The font used for the OFF word text

ON Word The text to display when the input value is on

ON Bitmap Choice The light bitmap when the ON word is displayed

ON Word Color The color of the ON word font

ON Word Font The font used for the ON word text

Flash Interval The flashing time period (in ms) of the light when 
the input value is on. Set to 0 for no flashing.

200 to 2000

Input Inverted If true, inverts the input value. (Light will show the 
OFF word when input value is on.)

Border Width The width (in pixels) of the graphic object’s border 0 to 32

Border Color The color of the graphic object’s border

PLC Value A simulated input value for testing the graphic 
object

See Note 3, Notes, 
page 204
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Motor
The motor widget displays the value of a symbol (variable) or direct address in a PLC 
with three possible states. An input value of 0 is considered off, a value of 1 is 
considered on, and other values are considered default. The three states are 
represented by different bitmaps.

The properties of the motor widget are listed below:

Property Description Limits

Name The name of the graphic object

Address The direct address or the name of a symbol 
(variable) to monitor

See Note 1, Notes, 
page 204

Data Type The data type of the direct address or symbol 
(variable)

See Note 2, Notes, 
page 204

Background The background color of the graphic object

Label The label to be displayed as part of the graphic 
object

Label Color The color of the label

Label Font The font used for the label

OFF Word The text to display when the input value is off

OFF Bitmap 
Choice

The motor bitmap when the OFF word is 
displayed

OFF Word Color The color of the OFF word font

OFF Word Font The font used for the OFF word text

ON Word The text to display when the input value is ON

ON Bitmap Choice The motor bitmap when the ON word is displayed

ON Word Color The color of the ON word font

ON Word Font The font used for the ON word text

DEFAULT Word The text to display when the input value is ON

DEFAULT Bitmap 
Choice

The motor bitmap when the DEFAULT word is 
displayed

DEFAULT Word 
Color

The color of the DEFAULT word font

DEFAULT Word 
Font

The font used for the DEFAULT word text

Border Width The width (in pixels) of the graphic object’s border 0 to 32

Border Color The color of the graphic object’s border

PLC Value A simulated input value for testing the graphic 
object

See Note 3, Notes, 
page 204
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Pipe
The pipe displays the value of a symbol (variable) or direct address in a PLC with 
two possible states. An input value of 0 is considered off and a non-zero value is 
considered on. There is a bitmap for the on-state and a different one for the off-state.

The properties of the pipe are listed below:

Property Description Limits

Name The name of the graphic object

Address The direct address or the name of a symbol 
(variable) to monitor

See Note 1, Notes, 
page 204

Data Type The data type of the direct address or symbol 
(variable)

See Note 2, Notes, 
page 204

Background The background color of the graphic object

Label The label to be displayed as part of the graphic 
object

Label Color The color of the label

Label Font The font used for the label

OFF Word The text to display when the input value is off

OFF Bitmap 
Choice

The pipe bitmap when the OFF word is displayed

OFF Word Color The color of the OFF word font

OFF Word Font The font used for the OFF word text

ON Word The text to display when the input value is on

ON Bitmap Choice The pipe bitmap when the ON word is displayed

ON Word Color The color of the ON word font

ON Word Font The font used for the ON word text

Border Width The width (in pixels) of the graphic object’s border 0 to 32

Border Color The color of the graphic object’s border

PLC Value A simulated input value for testing the graphic 
object

See Note 3, Notes, 
page 204
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Push Button
A push button sends preset value(s) to a PLC when the user clicks it with the mouse.

The properties of the Push Button are listed below:

Property Description Limits

Name The name of the graphic object

Address The direct address or the name of a symbol 
(variable) to monitor

See Note 1, Notes, 
page 204

Data Type The data type of the direct address or symbol 
(variable)

See Note 2, Notes, 
page 204

Background The background color of the graphic object

Values The value(s) to send to the PLC See Note 4, Notes, 
page 204

Reset Values The value(s) to send to the PLC after the reset 
delay time has expired. If no reset values are 
provided, no reset action will occur.

Reset Delay The delay time (in milliseconds) that the Push 
Button should use after sending the value(s) to 
the PLC before sending the reset value(s).

0-2000

Label The label to be displayed as part of the graphic 
object

Label Color The color of the label

Label Font The font used for the label

Button Label The text label for the button

Button Label 
Color

The color of the button label

Button Label Font The font used for the button label

OFF Bitmap 
Choice

The button bitmap when the OFF state is 
displayed

ON Bitmap Choice The button bitmap when the ON state is displayed

Border Width The width (in pixels) of the graphic object’s border 0 to 32

Border Color The color of the graphic object’s border
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Valve
The valve displays the value of a symbol (variable) or direct address in a PLC with 
two possible states. An input value of 0 is considered off and a non-zero value is 
considered on. There is a bitmap for the on state and a different one for the off state.

The properties of the valve are listed below:

Property Description Limits

Name The name of the graphic object

Address The direct address or the name of a symbol 
(variable) to monitor

See Note 1, Notes, 
page 204

Data Type The data type of the direct address or symbol 
(variable)

See Note 2, Notes, 
page 204

Background The background color of the graphic object

Label The label to be displayed as part of the graphic 
object

Label Color The color of the label

Label Font The font used for the label

OFF Word The text to display when the input value is off

OFF Bitmap 
Choice

The valve bitmap when the OFF word is displayed

OFF Word Color The color of the OFF word font

OFF Word Font The font used for the OFF word text

ON Word The text to display when the input value is ON

ON Bitmap Choice The valve bitmap when the ON word is displayed

ON Word Color The color of the ON word font

ON Word Font The font used for the ON word text

Flash Interval The flashing time period (in ms) of the light when 
the input value is on. Set to 0 for no flashing.

200 to 2000

Border Width The width (in pixels) of the graphic object’s border 0 to 32

Border Color The color of the graphic object’s border

PLC Value A simulated input value for testing the graphic 
object

See Note 3, Notes, 
page 204
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Notes
These are the notes for the chapter.

1. If the address property of a graphic object is a direct address and the data type 
property is set to UNDEFINED, a default data type (BOOL, INT, DINT, or REAL 
based on the implied size of the data value) is used. If the address property is a 
symbol (variable) name, the data type property does not have to be specified and can 
be set to UNDEFINED. However, if the data type property is specified for a symbol 
(variable), it must match the symbol’s (variable’s) actual data type exactly.
If the address property is a direct address for a discrete PLC reference (Quantum 
0x/1x reference), the data type property must be set to BOOL. The data type property 
may be set to BOOL only for a discrete PLC reference.

2. The meaning of the possible values of the Data Type property are:

Data Type Meaning

UNDEFINED no data type specified

BOOL 1-bit discrete (Boolean)

SHORT 8-bit signed integer

USHORT 8-bit unsigned integer

INT 16-bit signed integer

UINT 16-bit unsigned integer

DINT 32-bit signed integer

UDINT 32-bit unsigned integer

REAL 32-bit IEEE floating point

TIME 32-bit unsigned integer (in milliseconds)

DATE Date (32-bit BCD)

TOD Time of Day (32-bit BCD)

DT Date and Time (64-bit BCD)

3. The limits for the Maximum PLC Value and Minimum PLC Value properties are the 
natural limits of the Data Type property that is set. A Data Type setting of 
UNDEFINED is treated as REAL with respect to its limit values.

4 For a Push Button, a minimum of one value must be provided. If the Address property 
is a symbol (variable) name, then only one value will ever be sent to the PLC, and 
any additional values will be ignored. If the Address property is a direct address, then 
all of the values provided will be sent to the PLC as an array, starting at the specified 
direct address.
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8.3 Operator Screens

Scope of this Section
You can import and display operator screens created with UnityPro in the website. 
This feature enables you to visualize and access operator screens during run time 
using a simple Web browser. This section shows you how to import operator 
screens as well as the method of access.

What’s in this Section?
This section contains the following topics:

Topic Page

Importing Operator Screens 206

How to Access the Operator Screens 207
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Importing Operator Screens

Introduction
FactoryCast HMI enables you to see operator screens created with UnityPro or PL7 
in a Web browser. The following part shows you how to import operator screen with 
Web Designer for FactoryCast HMI.

NOTE: 
You can use hyperlinks to link operator screen together. In this case, carefully 
select the screens you import. If you only import screen1 that is linked to screen2, 
the link is lost and a message appears. Schneider-Electric recommends you to 
import all the operator screens that are linked together. 
Explicit exchange graphic objects are not supported.

Importing Screens
This procedure shows you how to import operator screen:

Step Action

1 Launch Web Designer for FactoryCast HMI and open or create a project.

2 Double-click the device with which the screen is linked in the Devices directory.

3 Click the operator screen tab.
Result: The operator screen window appears. It displays a list of the already 
imported screens or an empty list.

4 Click Import operator screen.
Result: The following dialog box appears.

5 Select the operator screen (.xcr file) you want to import and click Open.
Result: The operator screen appears in the operator screen list.

6 Click the operator screen that you want to display in the list.
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How to Access the Operator Screens

Introduction
An operator screen is a window just as any other editor (configuration, language, 
data editor). You can access these pages using a Web browser. 

Methodology
The following table lists the operations to perform in order to access operator 
screens.

Example of Screen
The following screen shows an example of operator screens.

Step Action

1 Launch your Web browser.

2 Connect to the embedded website of the module.

3 Click Monitoring in the horizontal menu.

4 Click Operator Screens in the vertical menu.
Result: A list of the imported screen(s) appears.

5 Select a screen in the list by clicking it.
Result: The selected operator screen appears.
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8.4 PLC Program Viewer

PLC Program Viewer

Presentation
The PLC program viewer feature enables you to visualize and monitor UnityPro 
programs in run mode using a Web Designer. The PLC programs are displayed and 
animated as they are in UnityPro

PLC programs developed in any languages supported by UnityPro can be 
visualized:

Ladder (LD)
Instruction List (IL)
Function Block Diagram (FBD)
Structured Text (ST)
Sequential Function Chart (SFC)

Accessing the PLC Program Viewer

Step Action

1 Double click the PLC (Devices directory) you want to monitor in the 
Web Designer navigator.

2 Click the PLC Programs tab.
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Importing PLC Programs
The following procedure shows you how to import PLC programs from UnityPro to 
Web Designer.

Step Action

1 Click Import on the right side of the PLC Program window.
Result: the Open window appears.
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2 Select the UnityPro file (.XEF) containing PLC Programs data.
Click Open.
Result: the Import PLC Programs window appears.

3 Select the sections of the PLC program you want to monitor using the checkbox.
Click Browse to select the STU or .XVM file associated to the .XEF for variables 
animation.
Note: if you select a .XVM file, only elementary types of variables are animated.

Click Import.
Result: the sections of the PLC program selected appear in the navigation tree of 
the PLC Program tab.

Step Action
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Accessing an Animated PLC Program

Step Action

1 Select a target in a project.

2 Click Target → Connect → Simulation (Alt + S) to switch to simulation 
mode or,
click Target → Connect → Target (Alt + C) to switch to run mode.

3 Extend the target directory.

4 Select a device in the Devices directory.

5 Right-click and select Open.
Result: an Internet Explorer window in which the PLC program viewer window 
associated with the selected device appears.

5 Select the PLC program section you want to visualize in the navigation tree.
Result: the PLC program appears in the Display window.
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Representation and Color Convention
The following figure shows you the PLC Program Viewer window:

1 Navigation tree: select the section of the PLC program you want to visualize
2 Display window: this zone display the animated PLC program

Variables animation:
Boolean are displayed in:

green if its value is true
red if its value is false

Other types display the name or the value of the variable in yellow. Use the tool 
tip to see more information as the name of the variable, its type, its address and 
its comment.

Links animation:
Links connected to boolean variables are displayed in green or red depending on 
the value of the variable they are connected to (green if true red if false).
Other links are displayed in black.
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SFC animation:

The colors used for the different elements are: 
for steps: 

green if the step is active,
white if the step is inactive,
yellow if the activity time of the step is less than the minimum programmed 
time,
pink if the activity time of the step is greater than the minimum programmed 
time.

for macro-steps:
when a macro-step becomes active the upper half is shown in green,
when the OUT step of the macro-step is active the whole of the macro-step is 
shown in green,
when the macro-step becomes inactive it is then shown in white.

for transitions associated with a Boolean element or a simple Boolean 
expression:

green if the element or the expression is TRUE,
red if the element or the expression is FALSE.

for transitions associated with a section:
black as long as the previous step remains inactive,
green if the conditions in the section are TRUE, 
red if the conditions in the section are FALSE.
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Tool Tip
The tool tip function is a help bubble which is displayed when you move the cursor 
over a variable. 

It displays information about the value of the variable only if its name is visible in the 
viewer.

Click on the variable to display the bubble permanently. Right click on it to make it 
disappear.

Limitations
Only PLC programs created using UnityPro 4.0 or later can be viewed.
You can only monitor PLC programs, edition is not allowed.
The following objects are not animated, they appear in black:

Objects for which the result depends on an expression
Function blocks without instance for which there is no information on 
input/output variables
Standard DFB (i.e. ALARM_DIA)
Multiple dimension tables
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Web Designer for FactoryCast HMI
Adding Custom Pages to the Site
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Adding Custom Pages to the Site
Overview
You may choose to add your own Web pages to the site on the embedded Server. 
Web Designer allows you to protect these pages with the same passwords as the 
default pages. You can also put them in an unprotected area where anyone can view 
them without a password.

FactoryCast provides you animated graphical objects. These objects are written in 
HTML so you can use them in your own Web pages. They enable you to monitor 
and control PLC variables by associating PLC variables with objects.

This section discusses how to create you own HTML web pages and how to use the 
real time animated objects provided with FactoryCast.

NOTE:  
When planning custom Web pages, be sure to keep them within the limits of the 
memory available for customization:

If you are using a third party software to transfer a website and if you reach the 
limits of the memory, some pages of the website will not appear.
If you are using Web Designer to transfer a website, it will prompt you if your 
website exceeds the memory capacity.

What’s in this Chapter?
This chapter contains the following sections:

Section Topic Page

9.1 Using FactoryCast’s Java Applets Using HTML Code 216

9.2 Using FactoryCast Extension for Microsoft FrontPage or 
Expression Web

230

9.3 Using Graphic Objects Lite 257
215
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9.1 Using FactoryCast’s Java Applets Using HTML 
Code

Overview
This section describes how to use the animated objects (also called Java applets) 
that come with FactoryCast. Use these applets to create custom Web pages. To 
create custom pages, you can use any plain text editor, such as Microsoft Notepad 
or a dedicated HTML editor, such as Microsoft FrontPage.

Creating custom Web pages with HTML makes it possible to view live PLC data in 
your browser.

What’s in this Section?
This section contains the following topics:

Topic Page

Inserting Applets on a Web Page 217

Inserting LiveBeanApplet 218

Inserting LiveBeanApplet using HTML Code 220

Inserting LiveLabelApplet using HTML Code 223

Inserting LiveTableApplet using HTML Code 228
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Inserting Applets on a Web Page

Overview
FactoryCast software includes several graphic objects (or JavaBeans) that are used 
to visualize live PLC data on a graphic display. Generally, an end-user builds a 
graphic display using the Graphic Editor tool that comes with FactoryCast. 
However, you can also build a graphic display using graphic objects inserted into a 
Web page via the LiveBeanApplet. Any of the graphic objects, such as an Analog 
Meter or a Push Button, can be inserted into a Web page so that dynamic data may 
be visualized outside the context of the Graphic Editor.

To view live PLC data with a browser, you may opt for one of two methods to insert 
a FactoryCast applet on a Web page.

(1) Enter the HTML code found in these sections:
Inserting a LiveBeanApplet using HTML code
Inserting a LiveLabelApplet using HTML code
Inserting a LiveTableApplet using HTML code

(2) Insert a Java applet and then fill in the dialog boxes using the FactoryCast 
extension for Microsoft FrontPage or Expression Web.
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Inserting LiveBeanApplet

Overview
This topic discusses general concepts about inserting a LiveBeanApplet. 

NOTE: 
Elsewhere in this guide is information for inserting a LiveBeanApplet using:

HTML (see page 220)
Microsoft’s FrontPage or Expression Web Extension  (see page 241)

NOTE: Prior to inserting a LiveBeanApplet into a Web page, you must create a 
JavaBeans library using the Graphic Editor that comes with the FactoryCast 
software. Generally a user will create a JavaBeans library that has one instance of 
every object that they would like to use in a Web page. Think of this library as a set 
of templates that are copied to and customized for your Web pages. For example a 
library may have one analog meter, one rotary selector, and one push button. 
Multiple instances of each bean can then be added to a Web page, each with a set 
of unique parameters such as an address.

Inserting a LiveBeanApplet
To insert a LiveBeanApplet:

Step Action

1 Using your Web browser, enter your Web server module’s name or IP address and go to the Graphic 
Editor applet found via the Monitoring and Online Editors Web link.
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2 Enter the Edit mode and create a JavaBeans library you want to use on your Web pages. Customize 
each bean with a common set of parameters so that you only have to configure unique parameters, such 
as the register address.

Note: For help using the Graphic Editor applet, see the section Graphic Editor (see page 156).

3 Once you have created your library, click the Done button in the editor window and save your library.

Step Action
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Inserting LiveBeanApplet using HTML Code

Overview
To graphically visualize data, use graphic objects such as Analog Meter or Push 
Button. Before any beans are inserted into a Web page, the special applet called 
LiveBeanMgrApplet must be inserted into the server.

LiveBeanMgrApplet
The LiveBeanMgrApplet allows the Web page to display dynamic data from the 
controller. This applet must be included once on the page if any instances of 
LiveBeanApplet are included in the page.

The LiveBeanMgrApplet can be included on a Web page in two possible forms. 

Invisible applet—if the Web page is used only to monitor PLC values, then no 
input is needed from the user
Icon of a key—if the Web page is used both to send new values and to monitor 
values to the PLC, then input is needed from the user in order to send new values.

NOTE: If the applet is used as an icon of a key, the user enters a password in order 
to send values to the PLC. From the Web browser click on the applet (icon of a key), 
a dialog box appears requesting the user to enter a password; entering the 
password enables the user to write to the PLC.

Here is the HTML code that you use to include the applet on a Web page that is used 
only for monitoring:

<APPLET codebase="/classes"
archive="SAComm.jar,GDE.jar,Widgets.jar"
code="com.schneiderautomation.gde.LiveBeanMgrApplet"
width=0 height=0>
</APPLET>

Here is the HTML code that you use to include the applet on a Web page that is used 
for sending values to a PLC as well as monitoring:

<APPLET codebase="classes"
archive="SAComm.jar,GDE.jar,Widgets.jar"
code="com.schneiderautomation.gde.LiveBeanMgrApplet"
width=32 height=32>
<PARAM name=MODE value="READWRITE">
<PARAM name=AUTO_LOGIN value="FALSE">
</APPLET>

In the above example, if the value of the AUTO_LOGIN parameter is set to TRUE, 
instead of FALSE, then the password is automatically entered and the user is not 
required to enter the password.
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LiveBeanApplet 
The LiveBeanApplet is included one time for each symbol (variable) or direct 
address monitored/controlled on the Web page. For instance, if you are monitoring 
three symbols (variables), you would include the applet three times. 
LiveBeanApplet allows any graphic object/Java Bean that was created with the 
Graphic Editor (see page 156) to be included on a Web page as a separate applet. 
Any graphic object that has been saved as part of a Graphic Editor graphic display 
can be retrieved from the graphic file and presented by the applet.

LiveBeanApplet Parameters
The LiveBeanApplet uses parameters that allow you to specify the graphic object 
to be presented by the applet and to set the applet’s background color.

The applet’s parameters and their meanings are shown below.

In addition to the above parameters, the <APPLET> tag for a LiveBeanApplet 
must include width and height attributes. Normally, the size of a LiveBeanApplet 
is set to match the size of the graphic object that it is presenting. To get the size of 
a graphic object, select the object while the Graphic Editor is in editing mode. The 
selected object’s name and size are shown in the Information Area at the top of the 
Graphic Editor applet.

Parameter... Defines...

LIBRARY The name of the graphic display which contains the graphic object that is 
to be presented by the applet. (This will be the same name that was used 
when the graphic display was saved with the Graphic Editor.)
This parameter is required.

BEAN The name of the graphic object that is to be retrieved from the graphic 
display specified by the LIBRARY parameter. (This will be the name that 
appears as the ‘Name’ property of the graphic object.)
This parameter is required.

BACKGRND The background color for the applet.
Acceptable values are WHITE, LT_GRAY, GRAY, DK_GRAY, BLACK, 
RED, PINK, ORANGE, YELLOW, GREEN, MAGENTA, CYAN, and BLUE.
Also, a RGB color value can be entered using the format "0xRRGGBB" 
where RR, GG, and BB are the hexadecimal values for the red, green, and 
blue components, respectively.
This parameter is optional but is normally set to match the color of the 
HTML page.
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LiveBeanApplet Example
All instances of LiveBeanApplet that are included in a Web page follow the same 
pattern, with only the applet’s parameters and size varying for each instance.

Here is the HTML code for including a LiveBeanApplet that will present the 
graphic object named MyMeter which was saved by the Graphic Editor as part of 
the graphic display, Library1.

<APPLET codebase="/classes"
archive="SAComm.jar,GDE.jar,Widgets.jar"
code="com.schneiderautomation.gde.LiveBeanApplet"
width=180 height=160>
<PARAM name=LIBRARY value="Library1">
<PARAM name=BEAN value="MyMeter">
<PARAM name=BACKGRND value="0xDDEEFF">
</APPLET>

More Information
For more information about creating Java applets and graphic objects to obtain 
runtime data from a PLC, refer to the Software Developer’s Kit included in the 
FactoryCast installation.
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Inserting LiveLabelApplet using HTML Code

Overview
Before any live labels are inserted into a Web page, the special applet called 
LiveLabelMgrApplet must be inserted into the page.

NOTE: However, if a Web page contains both LiveLabelApplet and 
LiveBeanApplet, then that page must contain a single instance of LiveBean-
MgrApplet, not LiveLabelMgrApplet. 

(LiveBeanMgrApplet supports both LiveLabelApplet and 
LiveBeanApplet, while LiveLabelMgrApplet supports only 
LiveLabelApplet.)

LiveLabelMgrApplet
The LiveLabelMgrApplet allows the Web page to display dynamic data from the 
controller. This applet must be included once on the page if any instances of 
LiveLabelApplet are included on the page.

Here is the HTML code that you use to include the applet on a page.

<APPLET>
codebase="/classes" archive="SAComm.jar"
code="com.schneiderautomation.factorycast.LiveLabelMgrApple"
width=0 height=0>
</APPLET>

LiveLabelApplet
Use one LiveLabelApplet for every symbol (variable) or direct-address 
monitored on the Web page used. For example, if you are monitoring three symbols 
(variables), you would include the applet three times.

This applet displays the following three fields.

Field Description

Label Your label for the symbol (variable) or direct address

Value Run-time value of the symbol (variable) or direct address

Units The units you specify for the value
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Data Parameters
The applet’s parameters, their meaning, and the default values are shown below.

Parameter... Defines... With Default Value 
of...

LABEL A text label to identify the data item No label

UNITS A text label to identify the value’s engineering units No units displayed

ADDRESS The name of Concept/PL7/Unity Pro symbol 
(variable) or Quantum/Premium direct address

None

DATATYPE The data type of the symbol (variable) or direct 
address.
Acceptable values for this parameter are

UNDEFINED

SHORT 8-bit signed integer

USHORT 8-bit unsigned integer

INT 16-bit signed integer

UINT 16-bit unsigned integer

DINT 32-bit signed integer

UDINT 32-bit unsigned integer

REAL 32-bit IEEE floating point

TIME 32-bit unsigned integer (in ms)

DATE Date (32-bit BCD)

TOD Time of Day (32-bit BCD)

DT Date and Time 64-bit BCD

BOOL 1-bit discrete (boolean)

NOTES: If the ADDRESS parameter is a direct address, and the DATATYPE parameter is 
not specified, a default DATATYPE (BOOL ,INT,DINT or REAL based on the implied size of 
the data value) is used. 
If ADDRESS is a direct address for a discrete PLC reference (Quantum 0x/1x reference), 
DATATYPE must be set to BOOL. DATATYPE may be set to BOOL only for discrete PLC 
references. 
If the ADDRESS parameter is the name of a Concept, PL7 or Unity Pro symbol (variable), 
the DATATYPE parameter is optional. If the DATATYPE is specified for a symbol (variable), 
it must exactly match its actual data type,TIME is not a valid data type for PL7 Premium.
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FORMAT The display format for the value.
Acceptable values for this parameter are

DEC for most data 
types
TIME for data type 
TIME
BOOL for data type 
BOOL
DATE for data types 
DATE, TOD and DT.

DEC decimal

HEX hexadecimal

BIN binary

ASCII bytes displayed as ASCII 
characters

TIME ‘day_hr_min_sec_ms’

DATE ‘yyyy-mm-dd-hh and /or hh:mm:ss

BOOL ON_WORD or OFF_WORD (see 
below)

NOTE: If DATA TYPE is REAL, a FORMAT other than DEC will give unpredictable results if 
the value cannot be converted to an integer.

GAIN The gain (multiplier) used for scaling the retrieved 
value to engineering units.

1.0

NOTE: Scaling is to be performed only if GAIN or BIAS is set and FORMAT is DEC. 
Linear scaling is performed by the formula: SCALED_VALUE=GAINxRAW_VALUE+BIAS

BIAS The bias (offset) used for scaling the retrieved value 
to engineering units. See NOTE for GAIN.

0.0

ON_WORD A text value to be shown when value is non-zero
(Use only if the FORMAT is BOOL).

ON

OFF_WORD A text value to be shown when value is zero 
(Use only if the FORMAT is BOOL).

OFF

FOREGRND Foreground color of the applet.
Acceptable values are: WHITE, LT_GRAY, 
DK_GRAY, BLACK, RED, PINK, ORANGE, 
YELLOW, GREEN, MAGENTA, CYAN, and BLUE
Also, a RGB color value can be entered using the 
format "0xRRGGBB" where RR, GG, and BB are the 
hexadecimal values for the red, green, and blue 
components, respectively.

BLACK

BACKGRND Background color for the applet.
For acceptable values, see FOREGRND.

LT_GRAY

ERROR_ 
COLOR

Foreground color of the VALUE field when unable to 
retrieve the value from the PLC.
For acceptable values, see FOREGRND.

MAGENTA

LABEL_ 
ALIGN

Alignment of the text in the LABEL field, if the width 
of the field is greater than the length of the text.
Acceptable values are: LEFT, CENTER, and 
RIGHT.

LEFT

Parameter... Defines... With Default Value 
of...
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Size Parameters
The size of a LiveLabelApplet is specified in the width and height attributes of 
its <APPLET> tag. Unless the width of Label or Units field is set with the 
LABEL_WIDTH or UNITS_WIDTH parameters, the LABEL and UNITS fields of the 
applet will always take the width required to display the text values of their 
associated applet parameters. The remaining width of the applet is given to its 
VALUE field.

VALUE_ 
ALIGN

Alignment of the text in the VALUE field, if the width 
of the field is greater than the length of the text.
Acceptable values are: LEFT, CENTER, and 
RIGHT.

LEFT

UNITS_ 
ALIGN

Alignment of the text in the UNITS field, if the width 
of the field is greater than the length of the text.
Acceptable values are: LEFT, CENTER, and 
RIGHT.

LEFT

FONT_ 
NAME

Name of the font used by the applet.
Acceptable values are: SERIF, SANSSERIF, and 
MONOSPACE.

SANSSERIF

FONT_ 
BOLD

If set, displays all text in the applet as bold.
Acceptable values are: TRUE and FALSE.

FALSE

FONT_ 
ITALIC

If set, displays all text in the applet in italics.
Acceptable values are: TRUE and FALSE.

FALSE

FONT_SIZE Sets the point size of the font used by the applet. 12

LABEL_ 
WIDTH

The width of the LABEL field.

UNITS_ 
WIDTH

The width of the UNITS field.

Parameter... Defines... With Default Value 
of...
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LiveLabelapplet Example #1
The applet example in this section contains almost every applet parameter. Here is 
the HTML code for this example.

<APPLET codebase="/classes" archive="SAComm.jar"
code="com.schneiderautomation.factorycast.LiveLabelApplet"
width=300 height=30>
<PARAM name=LABEL value="Reactor 1 Temperature">
<PARAM name=UNITS value="F">
<PARAM name=ADDRESS value="40101">(ForPremium value="%MW100")
<PARAM name=DATATYPE value="UINT">
<PARAM name=FORMAT value="DEC">
<PARAM name=GAIN value="2.0">
<PARAM name=BIAS value="100.0">
<PARAM name=FOREGRND value="WHITE">
<PARAM name=BACKGRND value="BLACK">
<PARAM name=ERROR_COLOR value="RED">
<PARAM name=FONT_NAME value="SERIF">
<PARAM name=FONT_BOLD value="TRUE">
<PARAM name=FONT_ITALIC value="FALSE">
<PARAM name=FONT_SIZE value="10">
</APPLET>

LiveLabelApplet Example #2
This is an example of a minimal applet, using default values for most parameters. 
Here is the HTML code for this example.

<APPLET codebase="/classes" archive="SAComm.jar"
code="com.schneiderautomation.factorycast.LiveLabelApplet"
width=300 height=30>
<PARAM name=LABEL value="Reactor 1 Pressure">
<PARAM name=UNITS value="PSI">
<PARAM name=ADDRESS value="PT_101">
</APPLET>
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Inserting LiveTableApplet using HTML Code

Overview
LiveTableApplet is used to display dynamic, runtime PLC data on a Web page, 
and LiveTableApplet operates in a manner similar to LiveLabelApplet. 
However, there is a difference: LiveTableApplet can show multiple input values 
using a tabular format. Only a single input value can be shown with 
LiveLabelApplet.

LiveTableApplet
LiveTableApplet supports applet parameters for

Setting the number of rows in its table (N_ROWS)
Default settings for a row’s properties
Unique settings for each row’s properties

The properties (default or unique) that can be set for a row of LiveTableApplet 
are the same properties that can be set for LiveLabelApplet. (The parameter 
names are the same as those for LiveLabelApplet, except that Rx_ prefixes 
them, where x equals the applicable row number. A default setting is specified by 
not including the Rx_ prefix.

LiveTableApplet Example
This is an example of LiveTableApplet that has two rows and an overall width of 
200. The common row properties set the width of the Label field to 100 and the width 
of the Units field to 40 (leaving a width of 60 for the Value field). Also, every row has 
a black background with white text of size-10 font. The Label text is centered; the 
Value text is right-aligned; and the Units text is left-aligned. The address, data type, 
and the text for the Label and Units fields are set individually for each of the two 
rows.
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Here is the HTML code for this example.

<APPLET codebase="/classes" archive="SAComm.jar"
code="com.schneiderautomation.factorycast.LiveTableApplet"
width="200" height="40">
<PARAM name=N_ROWS value="2">
<PARAM name=LABEL_WIDTH value="100">
<PARAM name=UNITS_WIDTH value="40">
<PARAM name=BACKGRND value="BLACK">
<PARAM name=FOREGRND value="WHITE">
<PARAM name=FONT_SIZE value="10">
<PARAM name=LABEL_ALIGN value="CENTER">
<PARAM name=VALUE_ALIGN value="RIGHT">
<PARAM name=UNITS_ALIGN value="LEFT">

<PARAM name=R1_LABEL value="Reactor Pressure">
<PARAM name=R1_UNITS value="PSIG">
<PARAM name=R1_ADDRESS value="400101">
» (for Premium value="%MW101")
<PARAM name=R1_DATATYPE value="INT">

<PARAM name=R2_LABEL value="Reactor Temperature">
<PARAM name=R2_UNITS value="F">
<PARAM name=R2_ADDRESS value="400102">
» (for Premium value="%MW102")
<PARAM name=R2_DATATYPE value="INT">
</APPLET>
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9.2 Using FactoryCast Extension for Microsoft 
FrontPage or Expression Web

Overview
The Using FactoryCast’s Java Applets section described how to add FactoryCast’s 
Java applets to a HTML document using any text editor. This section describes 
using an extension for Microsoft’s FrontPage or Expression Web application. The 
extension allows a user of FrontPage or Expression Web to easily insert 
FactoryCast applets to view real-time PLC data on a Web page.

What’s in this Section?
This section contains the following topics:

Topic Page

Installing FactoryCast’s Microsoft Expression Web Extension 231

Installing FactoryCast Extension for Microsoft FrontPage 235

Inserting LiveBeanApplet Using FrontPage or Expression Web 241

Inserting LiveLabelApplet Using FrontPage 249

Inserting LiveTableApplet Using FrontPage or Expression Web 253
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Installing FactoryCast’s Microsoft Expression Web Extension

Overview
This section describes how to install/remove the FactoryCast extension for Microsoft 
Expression Web (MS Expression Web).

Installing FactoryCast
MS Expression Web installed before Web Designer for FactoryCast HMI 1.7:
During the installation of Web Designer for FactoryCast HMI 1.7, the FactoryCast 
Extension for MS Expression Web is automatically installed as a MS Expression 
Web "Macro File." If this is the case, then proceed to the next section, which 
provides instructions for adding the extension to MS Expression Web’s menu.

MS Expression Web installed after Web Designer for FactoryCast HMI 1.7:
The extension can be installed by either re-installing Web Designer for FactoryCast 
HMI 1.7 or manually copying the macro file to MS Expression Web’s macro folder. 
For manual installation, after installing MS Expression Web, the following will install 
the extension:

Copy the file "Microsoft Expression Web.wdmacro" from CD-ROM to the following 
folder (create the final ’Macros’ folder, if it does not already exist): 
C:\Documents and Settings\<username>\Application Data\Microsoft\Expression\M
acros

NOTE: MS Expression Web uses this address by default. For a custom installation, 
you can determine this address by typing SET from a Command Prompt.

Adding FactoryCast Extension
To add the FactoryCast Extension to the MS Expression Web Insert menu, do the 
following. 

Step Action

1 Start MS Expression Web.

2 Click Customize on the Tools menu.
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3 Click the Commands tab, and then select Macros from the Categories list.

4 Drag the entry Custom Menu Item from the Commands list to the Insert menu, 
beneath the Symbol command (the Insert menu will automatically expand 
when the pointer rolls over it.).

Step Action
232 35016143 12/2011



Adding Custom Pages to the Site
5 Click Modify Selection, change the name to FactoryCast Applet, and then 
press ENTER key.

6 Click Modify Selection again, and then choose Assign Macro.

Step Action
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Removing FactoryCast Extension
To remove the FactoryCast Extension from the MS Expression Web menu, proceed 
as follow:

Editing Applets
There are two ways to edit an applet that has been inserted into your Web page:

You can double-click on the object and make changes via dialog boxes.
You can switch to the HTML editor in MS Expression Web and do your editing in 
this environment.

NOTE: It is suggested you edit via the first approach unless you are comfortable 
programming in the HTML language used to build Web pages.

7 Choose FactoryCast_Applet from the list, and then click OK.

8 Click Close.
Result: The FactoryCast Applet command is added to the Insert 
menu.

Step Action

Step Action

1 In MS Expression Web, click Customize on the Tools menu.

2 Click the Insert menu, and then select FactoryCast Applet.

3 Right click, and then select Delete from the popup menu.
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Installing FactoryCast Extension for Microsoft FrontPage

Overview
This section describes how to install/remove the FactoryCast Extension for 
Microsoft FrontPage 2000.

Installing FactoryCast
During the installation of Web Designer, if FrontPage 2000 has been installed on the 
same PC, then the FactoryCast Extension for FrontPage 2000 is automatically 
installed as a FrontPage "Macro File". If this is the case, then proceed to the next 
section, which provides instructions for adding the Extension to FrontPage’s menu.

However, if FrontPage 2000 is installed after Web Designer has been installed, then 
the Extension can be installed by either re-installing Web Designer or manually 
copying the macro file to FrontPage’s macro folder. For manual installation, after 
installing FrontPage 2000, the following will install the Extension:

Copy the file Microsoft FrontPage.fpm from CD-ROM to the folder 
%USERPROFILE%\Application Data\Microsoft\FrontPage\Macros (create the final 
’Macros’ folder, if it does not already exist).

Adding FactoryCast Extension
To add the FactoryCast Extension to the FrontPage Insert menu, do the following. 

Step Action

1 Start FrontPage 2000.

2 Click Customize on the Tools menu.
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3 Click the Commands tab, and then select Macros from the Categories list.

Step Action
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4 Drag and drop the entry Custom Menu Item from the Commands list to the 
Insert menu, beneath the Advanced command. (The Insert menu will 
automatically drop down when you drag over it.)

Step Action
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5 Click Modify Selection, change the name to FactoryCast Applet, and then 
press ENTER key.

Step Action
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6 Click Modify Selection again, and then choose Assign Macro.

7 Choose FactoryCast_Applet from the list, and then click OK.

Step Action
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Removing FactoryCast Extension
To remove the FactoryCast Extension from the FrontPage menu, do the following.

Editing Applets
There are two ways to edit an applet that has been inserted into your Web page. 
First, you can double-click on the object and make changes via dialog boxes. Or you 
can switch to the HTML editor in FrontPage and do your editing in this environment. 
It is suggested you edit via the first approach unless you are comfortable 
programming in the HTML language used to build Web pages. 

8 Click Close.
The FactoryCast Applet command is added to the Insert menu.

Step Action

Step Action

1 In FrontPage, click Customize on the Tools menu.

2 Click the Insert menu, and then select FactoryCast Applet.

3 Right click, and then select Delete from the popup menu.
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Inserting LiveBeanApplet Using FrontPage or Expression Web

Overview
NOTE: The following procedure shows you how inserting LiveBeanApplet using 
Frontpage. Use the same procedure if you use Expression Web.

Inserting a LiveBeanApplet

Step Action

1 In FrontPage, Select Insert | FactoryCast Applet to view the FactoryCast 
applet selection window.
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2 Note: The LiveBeanMgrApplet is a special applet that is inserted one time 
only into your Web page.
Select the applet LiveBeanMgrApplet and then click the OK button.

Step Action
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3 Configure the Mode and Auto Login parameters and then click the OK button.

Step Action
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4 A window will appear showing the Java code that will be inserted into your 
HTML document.

Select the Insert button to finish inserting this applet.
Note: Though a gray box with a blue letter "J" will appear on your Web page 
during editing, this applet will only be visible on your loaded Web page if you 
configured the Mode parameter as ReadWrite (it will appear as a Key when 
viewed via your browser). Otherwise, if Mode (see page 223) is set as 
ReadOnly then the width and height of the applet will be set to zero and you will 
not see it in your browser.

Step Action
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5 Select the LiveBeanApplet from the FactoryCast applet selection window and 
then click the OK button.

6 Enter the library name and the name of a particular bean in this library that you 
want to show. If none of the bean’s properties, such as address, need to be 
customized, then click the OK button.

Step Action
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7 Usually at a minimum the address property will need to be customized for your 
beans. Thus after entering the library name and bean name, select the object 
type from the Object Type box.

Click the Edit button when finished.

8 In the properties edit window, change only those parameters, such as address, 
that are unique to this bean. All other parameters will be set to that of the saved 
bean in your library. Click the OK button when finished.

Step Action
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9 Click the OK button. A window will appear showing the Java code that will be 
inserted into your HTML document. Select the Insert button to finish inserting 
this bean.

10 Continue to add instances of LiveBeanApplet to your Web page. Once you 
have inserted your last applet, click the Cancel button on the FactoryCast 
applet selection window to return to editing your Web page.

Step Action
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11 Save the customized Web page.

12 Transfer the customized Web page to the NOE Web server.

13 Test the application.

Step Action
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Inserting LiveLabelApplet Using FrontPage

Overview
This section describes inserting LiveLabelApplet into a Web page.

NOTE: The following procedure shows you how inserting LiveTableApplet using 
Frontpage. Use the same procedure if you use Expression Web.

Inserting LiveLabelApplet
To insert a LiveLabelApplet, do the following.

Step Action

1 Select Insert | FactoryCast to view the FactoryCast applet selection window.
35016143 12/2011 249



Adding Custom Pages to the Site
2 Select the applet LiveLabelMgrApplet and then click the OK button.

Note: The LiveLabelMgrApplet is a special applet that is inserted one time 
only into your Web page. Though a gray box with a blue letter "J" will appear on 
your Web page during editing, this applet will not be visible when you view your 
Web page from the Web server module.

3 Select the applet LiveLabelApplet and then click the OK button. The 
Parameters edit window appears.

Step Action
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4 Fill in the parameters for the label and then click the OK button.

Note: For a description on each parameter, see Using FactoryCast’s Java 
Applets Using HTML Code, page 216.

5 A window will appear showing the HTML code that will be inserted into your 
HTML document. Click the Insert button to finish inserting this applet.

Step Action
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6 Continue to add additional instances of LiveLabelApplet to your Web page. 
Once you have inserted your last applet, click the Cancel button on the 
FactoryCast applet selection window to return to editing your Web page.

Step Action
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Inserting LiveTableApplet Using FrontPage or Expression Web

Overview
NOTE: The following procedure shows you how inserting LiveTableApplet using 
Frontpage. Use the same procedure if you use Expression Web.

Inserting LiveTableApplet

Step Action

1 Select Insert | FactoryCast to view the FactoryCast applet selection window.

2 Select the applet LiveLabelMgrApplet and then click the OK button.
Note: The LiveLabelMgrApplet is a special applet that is inserted one time 
only into your Web page.
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3 Select the LiveTableApplet and then click the OK button.

Step Action
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4 Click the Common button to configure all the parameters that are common to 
all rows of the table. 

This procedure speeds configuration by simultaneously entering many values 
that have the same parameter fields. You many still edit parameters for rows 
individually during the add process.

Step Action
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5 Click the Add button to add a row to your table. The parameters edit dialog 
window appears. Configure parameters and then click the Add button when you 
are done.

6 Continue to add rows using the Add button. You may also select a row and 
move it up or down the rows of your table using the Move Up and Move Down 
buttons. When you are finished adding and editing rows in your table, click the 
OK button from the Rows List window.

7 A window will appear showing the HTML code that will be inserted into your 
HTML document. Click the Insert button to finish inserting this applet.

Step Action
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9.3 Using Graphic Objects Lite

Overview
This section describes how to use the Graphic Objects Lite library. This library uses 
a modem and allows faster download of the graphical interface by the user. This is 
a lighter version of the standard graphical library.

What’s in this Section?
This section contains the following topics:

Topic Page

Downloading the Graphic Objects Lite Library 258

Description of Graphic Objects Lite 259
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Downloading the Graphic Objects Lite Library

 Overview 
You must download the Graphic Objects Lite library before you use it. Use the 
Transfer Web File utility provided with Web Designer, and transfer the file 
widgetslite.jar to the module’s Web site.

NOTE: The widgetslite.jar file is located in the installation folder, in the subdirectory 
/addons/jar.
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Description of Graphic Objects Lite

Presentation
The set of graphic objects provided in the FactoryCast_Applet can help you create 
graphic displays similar to the human-machine interface (HMI) screens. All the data 
control and monitoring objects have integrated communication functions and are 
designed as standalone graphic objects.

LiveLabel AppletLite Setup
The LiveLabel AppletLite window displays the direct address value of a Modbus 
slave in a text field.

The properties of this widget are as follows:

Property Description Limits

Address Address of the PLC variable Note 1 (see page 275)

Data type PLC address data type Note 2 (see page 275)

PLC Type Type of PLC Premium or Quantum

Label Label displayed as part of the graphic object Note 5 (see page 275)

Label Width Width of label

Unit Width Width of unit

Polling rate [ms] Scanning value
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The HTML code with the parameters of the widget above is as follows:

Gain The gain (multiplier) is used for the scale of the 
value retrieved in physical units

1.0

Bias The bias (multiplier) is used for the scale of the 
value retrieved in physical units

0.0

ON_Word Text value displayed when the value is not 
zero (use if the data type is binary)

ON

OFF_Word Text value displayed when the value is not 
zero (use if the data type is binary)

OFF

Foregrnd Color of the applet foreground BLACK

Backgrnd Color of the applet background LT_GRAY

Error_Color Color of the applet foreground if the address 
value cannot be retrieved

MAGENTA

Label_Align Alignment of text in the Label field if the size is 
greater than the text length

LEFT

Value_Align Alignment of text in the Value field if the size is 
greater than the text length

LEFT

Units_Align Alignment of text in the Units field if the size is 
greater than the text length

LEFT

Font_Name Font name for the applet text SANSSERIF

Font_Bold Applet text is bold if configured as TRUE FALSE

Font_Italic Applet text is italic if configured as TRUE FALSE

Font_Size Applet text size 12

Property Description Limits
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Horizontal or Vertical Indicator Setup
The horizontal or vertical indicator gives an analog representation of the value of a 
direct address of a Modbus slave. It is a horizontal or vertical bar whose length is 
proportional to the value. It represents a percentage of its range in physical units.

The properties of the indicator are as follows:

Property Description Limits

Address Address of the PLC variable Note 1 
(see page 275)

Data type PLC address data type Note 2 
(see page 275)

Label Label displayed as part of the graphic object Note 5 
(see page 275)

Major scale 
gradation

Number of major gradations (marked) in the scale 0 to 100

Minor scale 
gradation

Number of minor gradations (not marked) in the 
scale

0 to 100

Scale precision Number of decimal places shown for the scale 
gradations (set to -1 to use a general exponential 
format)

-1 to 6

Maximum EU Value Maximum value of the direct address for scaling, 
in physical units

Minimum EU Value Minimum value, in physical units, of the direct 
address for scaling
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Maximum PLC 
Value

Gross maximum value (without scale) of the direct 
address in the PLC

Note 3 
(see page 275)

Minimum PLC 
Value

Gross minimum value (without scale) of the direct 
address in the PLC

Note 3 
(see page 275)

Limit Deadband[%] Neutral range (as a percentage of the UP range) 
to apply to verification of the High/Low limit

0 to 10

High High Limit 
Value

Value expressed in physical units of the "High 
High" limit

High Limit Value Value expressed in physical units of the "High" 
limit

Low Limit Value Value expressed in physical units of the "Low" 
limit

Low Low Limit 
Value

Value expressed in physical units of the "Low 
Low" limit

High High Limit 
Value Color

Color of the indicator bar if the scale value is 
greater than the "High High" limit

High Limit Value 
Color

Color of the indicator bar if the scale value is 
greater than the "High" limit

Low Limit Value 
Color

Color of the indicator bar if the scale value is less 
than the "Low" limit

Low Low Limit 
Value Color

Color of the indicator bar if the scale value is less 
than the "Low Low" limit

Border Width Width of border

PLC Type Type of PLC Quantum or 
Premium

Polling rate [ms] Scanning value

Property Description Limits
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The HTML code with the parameters of the widget above is as follows:
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Horizontal or Vertical Slider Setup
A horizontal or vertical slider gives an analog representation of the direct address of 
a Modbus device. It is a cursor that is proportional to the value, and it represents a 
percentage of its range in physical units. Using the mouse, you can change the 
value of the slider and trigger, and you can send a new value to the Modbus slave.

The properties of the slider are as follows:

Property Description Limits

Address Address of the PLC variable Note 1 
(see page 275)

Data type Data type of the PLC address Note 2 
(see page 275)

Label Label displayed as part of the graphic object Note 5 
(see page 275)

Major Scale 
Division

Number of major gradations (marked) in the scale 0 to 100

Minor Scale 
Division

Number of minor gradations (not marked) in the 
scale

0 to 100

Scale Precision Number of decimal places shown for the scale 
gradations (set to -1 to use a general exponential 
format)

-1 to 6

Maximum EU value Maximum value, in physical units, of the direct 
address for scaling

Minimum EU Value Minimum value of the direct address for scaling, in 
physical units
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The HTML code with the parameters of the widget above is as follows:

Maximum PLC 
Value

Gross maximum value (without scale) of the direct 
address in the PLC

Note 3 
(see page 275)

Minimum PLC 
Value

Gross minimum value (without scale) of the direct 
address in the PLC

Note 3 
(see page 275)

Unit Increment Amount by which the scale value is modified when 
you click on the slider arrows

Block Increment Amount by which the scale value is modified when 
you click on the slide area of the bar

Border Width Width (in pixels) of the border of the graphic object

PLC Type Type of PLC Premium or 
Quantum

Polling rate [ms] Scanning value

Read Only TRUE = read value, FALSE = read/write value

Property Description Limits
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Horizontal or Vertical Selector
A horizontal or vertical selector allows the user to choose from a number of options. 
Once the selection has been made, the value corresponding to the choice is sent to 
the PLC. The choices are represented by marks on a "scale", the current selection 
being indicated by the position of the cursor on a slider.

The properties of the slider are as follows:

Property Description Limits

Address Address of the PLC variable Note 1 
(see page 275)

Data type PLC address data type Note 2 
(see page 275)

Label Label displayed as part of the graphic object Note 5 
(see page 275)

Choices Setpoints to apply to the address value

Border Width Width (in pixels) of the border of the graphic object

PLC Type Type of PLC Premium or 
Quantum

Polling rate [ms] Scanning value

Read Only True = read value, False = read/write value
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The HTML code with the parameters of the widget above is as follows:

Push Button Setup
You can send a preset value to one or more Modbus slaves with a push button. A 
push button is activated with the mouse.
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The properties of the push button are as follows:

The HTML code with the parameters of the widget above is as follows:

Property Description Limits

Address Address of the PLC variable Note 1 
(see page 275)

Data type PLC address data type Note 2 
(see page 275)

Label Label displayed as part of the graphic object Note 5 
(see page 275)

Values Setpoints to apply to the address value when the 
button is pressed

Note 4 
(see page 275)

Reset Values Value to apply when the Reset Delay ends

Reset Delay [ms] Time in ms counted down after the button is 
pressed

Button Label Label to display on the button

Border Width Width (in pixels) of the border of the graphic object

PLC Type Type of PLC Premium or 
Quantum

Polling rate [ms] Scanning value
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NOTE: In this example, when you press the button, the value 10 is applied to 
address 1 and the value 50 is applied to address 2 for 15,000 ms. After 15,000 ms, 
the two addresses are reset to 0.

Direct Output Window
With the Direct Output Window applet, you can enter a value in a text input field 
directly from the keyboard. If you enter a numerical value between the upper and 
lower preset limits, an OK button is activated. The value is sent to the Modbus slave 
each time you click OK or press the ENTER key (if the input field is active for 
keyboard input).

The direct output properties are as follows:

Property Description Limits

Address Address of the PLC variable Note 1 
(see page 275)

Data type PLC address data type Note 2 
(see page 275)

Label Label displayed as part of the graphic object Note 5 
(see page 275)

Maximum EU Value Maximum value, in physical units, of the direct 
address for scaling

Minimum EU Value Minimum value, in physical units, of the direct 
address for scaling

Maximum PLC 
Value

Gross maximum value (without scale) of the direct 
address in the PLC

Note 3 
(see page 275)

Minimum PLC 
Value

Gross minimum value (without scale) of the direct 
address in the PLC

Note 3 
(see page 275)

Maximum Input 
[EU]

Maximum setpoint for the input
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The HTML code with the parameters of the widget above is as follows:

Minimum Input [EU] Minimum setpoint for the input

Border Width Width (in pixels) of the border of the graphic object

PLC Type Type of PLC Premium or 
Quantum

Polling rate [ms] Scanning value

Property Description Limits
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Indicator Light Setup
The indicator light provides a dual indication of the value of a direct address in a 
PLC. If the Input inverted property is not set to TRUE, a 0 input value is declared 
OFF, and a non-zero value is declared ON. If the Flash Interval property is set to a 
positive value, the indicator light flashes when the input value is equivalent to ON.

The properties of the indicator light are as follows:

Property Description Limits

Address Address of the PLC variable Note 1 
(see page 275)

Data type PLC address data type Note 2 
(see page 275)

Label Label displayed as part of the graphic object Note 5 
(see page 275)

OFF Word Text displayed when the input value is OFF

ON Word Text displayed when the input value is ON

OFF Background 
Color

Background color of the indicator light when OFF 
Word is displayed

ON Background 
Color

Background color of the indicator light when ON 
Word is displayed

OFF Foreground 
Color

OFF Word text color

ON Foreground 
Color

ON Word text color

Flash Interval The flashing time for the indicator light (expressed 
in ms) when the input value is ON. Set to zero for 
no flashing

200 to 2000
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The HTML code with the parameters of the widget above is as follows:

Input inverted On TRUE, inverts the input value (the indicator 
light displays the OFF Word when the input value 
is ON)

Border Width Width (in pixels) of the border of the graphic object

Border Color Color of the border

Shape Shape (circular, rectangular, etc.) of the indicator 
light

PLC Type Type of PLC Premium or 
Quantum

Polling rate [ms] Scanning value

Property Description Limits
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Rotary Slider Setup
A rotary slider gives an analog representation of the direct address of a Modbus 
device. It draws a position proportional to the value of the address and represents a 
percentage of its range in physical units on a circular dial. The size of the circular 
dial (cycle in degrees of a circle) and the button color can be configured. Using the 
mouse, the user can change the value of the rotary slider and trigger sending a new 
value to the PLC.

The properties of the slider are as follows:

Property Description Limits

Address Address of the PLC variable Note 1 
(see page 275)

Data type PLC address data type Note 2 
(see page 275)

Label Label displayed as part of the graphic object Note 5 
(see page 275)

Major scale 
gradation

Number of major gradations (marked) in the scale 0 to 100

Minor scale 
gradation

Number of minor gradations (not marked) in the 
scale

0 to 100

Scale precision Number of decimal places in the scale gradations 
(set to -1 to use a general exponential format)

-1 to 6

Dial Degrees 
Sweep

Portion of circular dial used to draw the scale 60 to 300

Maximum EU Value Maximum value of the direct address for scaling, 
in physical units

Minimum EU Value Minimum value of the direct address for scaling, in 
physical units
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The HTML code with the parameters of the widget above is as follows:

Maximum PLC 
Value

Gross maximum value (without scale) of the direct 
address in the PLC

Note 3 
(see page 275)

Minimum PLC 
Value

Gross minimum value (without scale) of the direct 
address in the PLC

Note 3 
(see page 275)

Border Width Width (in pixels) of the border of the graphic object

PLC Type Type of PLC Premium or 
Quantum

Polling rate [ms] Scanning value

Read Only True = read value, False = read/write value

Property Description Limits
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Notes

1. The address can be:

%MW IEC internal word

%MD IEC double word

%M IEC internal bit

400000 Concept integer

100000 Concept boolean

2. The various values of the Data type property have the following meaning:

Data type Meaning

INT integer

DINT double integer

BOOL boolean

3. The limits of the Maximum PLC Value and Minimum PLC Value properties are the 
natural limits of the configured Data type property.

4. Specify at least one value for a push button. If several values are entered, they will 
be assigned to an address table starting with the direct address indicated.

5. If you specify param name="label" value="$data$’ in the HTML code, the 
applet displays the numerical value of the data in place of a label.
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Setting Up an External Tool
Setting Up an External Tool

Overview
This function enables you to setup an external tool that will be used by 
Web Designer. For example, you can setup FrontPage to edit the files of your 
website.

The following part shows you how setup FrontPage to open the files of the website, 
however the procedure is the same if you use another software. 
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Example
The following table shows how to set up a HTML editor. Here, hostname is used as 
an example:

Step Action

1 Click Options → Configuration of an external tool → External tools.
Result: the setup window for external tools appears.
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2 Click New.
Result: the following window appears.

3 Enter a name for the external software (i.e. FrontPage).

4 In the Location area, click Browse File System.
Result: a file explorer opens.

5 Select the path of the .exe file of the external software (i.e. 
C:\windows\frontpage\frontpage.exe).

6 In the Working Directory area, click Browse File System.
Result: a file explorer opens.

7 Specify the directory that contains the files you want to open with your external 
tool (i.e. C:\workspace\WD_project\website.

Step Action
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8 In the Arguments area, click Variables....
Result: the Select Variables window appears.

9 Select the ressource_loc variable that returns the absolute file system path of a 
resource.

10 Click Apply.

11 Click Close.

12 Select a file of the website in your Web Designer navigator.

13 Click Options → Configuration of an external tool → FrontPage. 
Result: FrontPage opens automatically the selected file.

Step Action
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Changing the Workspace 
Directory
Changing the workspace directory.

Presentation
The workspace is the space where projects are stored. Only those located in the 
current workspace are accessible when open. Projects are automatically created in 
the current workspace. It’s possible to have several workspaces and to pass from 
one to another.

This function enables you to change the path to the workspace.

To do this, select Change Workspace... in the Options menu.
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Formatting and Re-Starting a 
Module
Re-start/Format a Module

Introduction
Re-starting is necessary to take into account the modifications made to the 
application.

Formatting deletes the website on the module and restores the default website 
(Website, GraphicScreens and DataTables directories). Formatting allows you to 
delete all the modifications made to the website of a module, in order to start a fresh 
one from a defined status. It does not modify the system configuration.
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Re-start the Module
The following table shows how to re-start a module:

Format the Module
The following table shows how to format a module:

Step Action

1 In the menu tree, select a module.

2 In the Target menu, click Reboot target. 

Step Action

1 In the menu tree, select a module.

2 In the Target menu, click Format target. 
Result: the Configuration Password window appears if a configuration 
password has already been set. Otherwise the formatting starts.

3 Enter the configuration password and click OK.
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Subject of this Chapter
This chapter explains how to manage the security for a website using firewall, 
access rights and password protection. 

What’s in this Chapter?
This chapter contains the following topics:

Topic Page

Internal Security 286

External Security 287

Variable Access Security, Symbol, Direct Address 289

Changing Passwords 290
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Internal Security

Overview
Web Designer provides 2 mechanisms to allow that only authorized users view and 
modify your data:

password entry,
write restrictions.

Anyone who has access to a configuration tool and to your embedded server can 
override your security settings and download new settings to the server. 
Unauthorized or incorrect changes to data may change the behavior of your 
application in ways that may be undesirable or even hazardous.

Password Entry
Although you may add unprotected Web pages to the site, the default Web pages 
and any other pages you choose to protect can only be viewed by users who supply 
the correct user name and password.

Restrictions 
Restrictions are applied overall.

When you create a website and you want to protect it, you must place it in the folder 
called secure.

WARNING
UNINTENDED OPERATION
Keep strict control of access to the embedded server:

Change passwords monthly,
Do not use simple user names and passwords,
Disable default passwords before commissioning the module.

Failure to follow these instructions can result in death, serious injury, or 
equipment damage.
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External Security

Overview
If your network has been configured to enable users to consult your Internet site, 
your security system is the same as that of an intranet site, only you have an 
additional security measure: a firewall.

Architecture of a Firewall
A firewall forms a gateway between Internet and your embedded server. You can 
use a firewall to restrict or forbid access to your website.

A firewall can be configured to authorize network connections to a limited range of 
ports, or to authorize traffic to or from certain IP addresses. 

Types of Firewalls
There are two types of firewalls:

Network firewalls
Application firewalls

Network Firewalls
Network firewalls are often installed between the Internet and a single entry point to 
an intranet or internal protected network.
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Application-Level Firewalls
An application firewall works for an application, for example FTP. It intercepts all 
traffic sent to this application, and decides whether or not to transmit this traffic to 
the application. Application firewalls are located on individual host computers.

Firewall Configuration
Web Designer uses HTTP, FTP and Schneider Electric Modbus application protocol 
(MBAP) to access embedded server pages and files. If you want viewers to be able 
to access your site from the Internet and your embedded server is protected by a 
firewall, you must configure the firewall to authorize HTTP, FTP and MBAP traffic.

NOTE:  
The default FTP name and password are USER/USER.
The FactoryCast client follows the "Firewall Friendly FTP" standard, RFC 1579. 
It issues an FTP PASV command to the FactoryCast server before any attempt 
to establish an FTP data connection.
The online mode of the configuration tool is not operational if the module is 
protected by a firewall. The ports in this mode are dynamically assigned.

Port Protocol Access to...

21 FTP Protected embedded server files

Higher than 1024

80 HTTP Web pages

502 MBAP Operational data
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Variable Access Security, Symbol, Direct Address

Presentation
Users who enter the write password can only modify variables (symbols) and direct 
addresses which are write-enabled. When you create a Web-enabled database of 
variables and direct addresses, you can designate each element as read-only or 
write-enabled.

Unauthorized or incorrect modifications made to symbols and direct addresses may 
have undesirable or even dangerous effects on the behavior of your application.

WARNING
UNINTENDED EQUIPMENT OPERATION
 

Carefully select the symbols and direct addresses you authorize to be modified 
online.
Do not authorize online modifications of critical process variables.

Failure to follow these instructions can result in death, serious injury, or 
equipment damage.
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Changing Passwords

Introduction
This page enables you to modify the different user names and passwords that are 
used for identification.

Modify Passwords
This table describes how to change passwords:

Step Action

1 In the browser, select the target.

2 In the Target menu, click Properties.
Result: the Target Properties window appears.

3 Select Security.
Result: the following window appears.
290 35016143 12/2011



Security
Function
This table shows the fields in the various windows used to modify passwords:

4 Click Modify to change a password. Refer to next paragraph for a description of 
each passwords.
Result: the Password window appears.

5 Enter a new password and confirm it by typing it in the Confirm new password 
field.
If it’s an HTTP password, the login is also requested.

6 Click OK in the Password window. 
Note: if you leave any fields empty during the modification, you will be asked to 
confirm the replacement of the current password by an empty password.

7 Repeat actions 4...6 for each password to modify.

8 Click OK in the Properties window of the target to close the window.

Step Action

Window Function

Secure HTTP 
Password

Required for connecting to the secure pages of the module website 
via a browser.

Write Password Required to write variables in animation mode.

Configurator 
Password

Required to access the configuration parameters of the module.

FTP Password Not available.
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Scope of this Appendix
This appendix shows the menus of the high application and the contextual menus. 
It also gives you recommandations on datalogging service.

What’s in this Appendix?
The appendix contains the following chapters:

Chapter Chapter Name Page

A Flash Recommendation 295

B Menu 297
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Flash Recommendation
Recommendation on Datalogging Service

Size of the Log File
The following table shows you an estimation of the log file size in bytes depending 
on the number of variables logged and the number of logs:

NOTE: To prolong the internal Flash life, rerun the log file at intervals greater than 
30 minutes. 

Number 
of logs

Number of variables

1 2 5 10 20 50 100

1 65 110 245 470 920 2270 4520

2 130 220 490 940 1840 4540 9040

5 325 550 1225 2350 4600 11350 22600

10 650 1100 2450 4700 9200 22700 45200

20 1300 2200 4900 9400 18400 45400 90400

50 3250 5500 12250 23500 46000 113500 226000

100 6500 11000 24500 47000 92000 227000 452000
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Subject of this Chapter
This chapter describes the menus for Web Designer functions. 

What’s in this Chapter?
This chapter contains the following topics:

Topic Page

Menu 298

Contextual Menu 300
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Menu
Menu

Overview
The following table shows the complete menu system when all functions are 
supported:

Menu Sub-menu Overview

Project New Create a new project:
Creating a new module/device/data table/graphic page.
Creating a service.
Creating files and folders.

Open project Open an existing project.

Close project Close current project.

Save all Save all items modified in the project.

Import Importing an existing (.zip) project or converting a 
FactoryCast or FactoryCast HMI project.

Export Exporting the current project to a .zip file.

Global transfer Downloading all the project’s modules (and all the files).

Project Validation Verifying the project before transfer.

Refresh Updating the window and menu tree.

Properties View/modify the project’s properties (passwords, 
comments, etc.).

Exit Exit application

Edit Undo Cancel last action.

Cut Destruction of the selected object and putting it on the 
clipboard (the object can be a project, a module, a 
device, a graphic object, a file, a variable etc.).

Copy Copy the object to the clipboard.

Paste Paste the clipboard.

Delete Delete the selected object.

Find... Search for text in the project.
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Target Transfer Transfer all files, either from your PC to the destination, 
or from the destination to your PC.

Connect Connecting to the module (if the module authorizes the 
connection) or to the simulator.

Disconnect Disconnecting from the module or from the simulator

Stop all services Shutting down all the services (for targets using 
services).

Start all services Starting all the services (for targets using services).

Site Explorer Display a view of the website in the window on the 
bottom.

Reboot target Rebooting the connected module (for modules that 
authorize).

Format target Formatting the connected module (for modules that 
authorize).

Set target address Display/modify the IP Address, user name and 
password of the target.

Synchronize with 
PLC database

Synchronize the namespace of your project with a PLC 
database. Not available for FactoryCast HMI targets.

Properties View/modify the target’s properties.

Service Stop Shut down current service.

Run Start current service.

Print Print current service.

Statistics View statistics for the selected service (incoming 
messages, outgoing messages, etc.).

Options Set up an external 
tool

Set up an external tool (for example FrontPage).

Change 
workspace...

Changing a workspace directory.

Default display Restoring the three-dimensional view of the work 
window by default.

Automatic input Fill in automatically the values of a new variable by 
incrementing the values of the last record.

Help Help Access to Web Designer for FactoryCast HMI Help file.

About Information about the version, copyright etc. of Web 
Designer for FactoryCast HMI.

Menu Sub-menu Overview
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Contextual Menu

Table
The following table shows the contextual menu of the file tree.

File tree item Menu (right-
click)

Sub-menu Comment

Project name New Project
Target

Launch the wizard. 1st window.

Edit

Paste Paste project.

Delete Destroy project.

Rename Rename project.

Global transfer Transfer project.

Properties View the project properties.

Module name New Device
Service

Launch the wizard. 2nd window.

Edit

Cut Cut module.

Copy Copy module.

Paste Paste module.

Delete Delete module.

Rename Rename module.

Transfer PC->Target
Target->PC

Transfer web site.

Connect Target
Simulation

Connect module.

Disconnect Disconnect module.

Properties View the module’s properties.

Devices folder New device View the selection window of 
symbols.

Paste Paste device.
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Device 
element

Edit Launch the device display window.

Cut Cut device.

Copy Copy device.

Delete Delete device.

Rename Rename device.

Run Start the service.

Stop Stop the service.

Partial transfer Target>PC Transfer only the folder.

GraphicScreen
s folder

New Graphic 
Page

Launch Graphic Editor.

Paste Paste the graphic.

Partial transfer Target>PC
PC->Target

Transfer only the folder. See note.

GraphicScreen
s item

Edit Graphic Editor.

Open View graphic.

Cut Cut the graphic.

Copy Copy the graphic.

Delete Delete graphic.

Rename Rename gaphic.

Partial transfer Target>PC
PC->Target

Transfer only the folder. See note.

DataTables 
folder 

New data Launch the data editor.

Paste Paste the data table.

Partial transfer Target>PC
PC->Target

Transfer only the folder. See note.

DataTables 
item

Edit Data Editor.

Open Data Viewer.

Cut Cut the data table.

Copy Copy the data table.

Delete Delete the data table.

Rename Rename the data table.

Partial transfer Target>PC
PC->Target

Transfer only the folder. See note.

File tree item Menu (right-
click)

Sub-menu Comment
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 Services folder New service Create a new service.

Paste Paste a service.

Partial transfer Target>PC 
PC->Target

Transfer only the folder. See note.

A Services 
folder
calculation, 
email, 
database, data 
logging, active 
pages

New Launch the service wizard with the 
selected service.

Cut Cut a service.

Copy Copy a service.

Paste Paste a service.

Delete Delete a service.

Partial transfer Target>PC 
PC->Target

Transfer only the folder. See note.

Services item Edit Launch the edit window of the 
service.

Cut Cut the service.

Copy Copy the service.

Delete Delete the service.

Rename Rename the service.

Run Start the service.

Stop Stop the service.

Partial transfer PC->Target Transfer only the folder. See note.

Website folder New Folder
File

Create a new file or folder.

Paste Paste a new file or folder.

Import File Importing an existing website.

Partial transfer Target>PC
PC->Target

Transfer only the website. See note.

File tree item Menu (right-
click)

Sub-menu Comment
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Folder in 
Website

New Folder
File

Create a new file or folder.

Cut Cut the folder.

Copy Copy the folder.

Paste Paste a new file or folder.

Delete Delete the folder.

Rename Rename the folder.

Import File Importing an existing file.

Partial transfer Target>PC
PC->Target

Transfer only the folder. See note.

File in WebSite Open Open the file.

Open with System 
Editor

Launch another window with System 
Editor.

Edit with Notepad Launch the HTML page in Edit mode 
with notepad.

FrontPage Launch the HTML page in Edit mode 
with FrontPage.

Cut Cut the file.

Copy Copy the file.

Delete Delete the file.

Rename Rename the file.

Partial transfer Target>PC
PC->Target

Transfer only the file.

Namespace Open Launch the Namespace window.

Namespace 
Write Access

Edit Launch the author rights Namespace 
window.

File tree item Menu (right-
click)

Sub-menu Comment
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A

applet
Software component that runs in the context of another program, for example a Web 
browser.

ASCII
American Standard Code for Information Interchange.

Pronounced "aski". This is an American code (but now an international standard) 
which allows alphanumerical characters used in English, punctuation marks, some 
graphics characters and various commands to be defined with 7 bits.

AT commands
Also called Hayes Commands: Set of commands for various phone-line 
manipulations, dialing and hanging up for instance.

B

bit
Contraction of Binary Digit.

This is the binary unit of information content, which can represent two separate 
values (or states): 0 or 1.

A field of 8 bits constitutes 1 byte.
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BOOTP
Bootstrap Protocol: Protocol for booting diskless terminals or stations by 
centralized management of network parameters.

C

CF card
CompactFlash card: Type of data storage device, used in portable electronic 
devices.

communication interruption
Communication error detected by the module when the periodic exchanges with the 
PLC stop.

configuration
The configuration comprises the data that defines the device (invariable) and that is 
necessary to the operation of the module.

CPU
Central Processing Unit: The microprocessor. This comprises the entire control 
unit and the arithmetic unit. The purpose of the control unit is to extract the execution 
instruction from the central memory along with the data needed to execute this 
instruction, to establish electrical connections in the arithmetic and logic unit and to 
start the processing of this data in the unit. ROM or RAM memories are sometimes 
included on the same chip, and sometimes I/O interfaces or buffers.

CRC
Cyclic Redundancy Check: Type of hash function used to produce a checksum – 
a small, fixed number of bits – against a block of data, such as a packet of network 
traffic or a block of a computer file.

D

DHCP
Dynamic Host Configuration Protocol: Protocol allowing a station connected to 
the network to obtain its configuration dynamically.
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DNS
Domain Name System: It stores and associates many types of information with 
domain names and it translates domain names (computer hostnames) to IP 
addresses.

driver
Program which informs the operating system of the presence and characteristics of 
a peripheral.

F

FactoryCast HMI
Active Web server that executes HMI functions integrated in a PLC module. When 
you use the active Web server, you do not need to communicate via polling to 
update the HMI/SCADA database.

FDR
Faulty Device Replacement: Automatic configuration recovery service provided by 
the module. 

firewall
Information technology (IT) security device which is configured to permit, deny or 
proxy data connections set and configured by the organization’s security policy.

Flash memory
Form of non-volatile computer memory that can be electrically erased and 
reprogrammed. 

FTP/TFTP
File Transfer Protocol/Trivial File Transfer Protocol: Network file transfer 
protocol.

G

GPRS
General Packet Radio Service: A radio technology for GSM networks that adds 
packet-switching protocols and shorter set-up time for ISP connections.
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H

HMI
Human Machine Interface: The aggregate of means by which people (the users) 
interact with a particular machine, device, computer program or other complex tool 
(the system).

HTML
HyperText Markup Language: the predominant markup language for the creation 
of web pages. It provides a means to describe the structure of text-based 
information in a document and to supplement that text with interactive forms, 
embedded images, and other objects.

HTTP
HyperText Transfer Protocol: Network transfer protocol for documents written in 
hypertext (links).

I

IP
Internet Protocol: Data-oriented protocol used for communicating data across a 
packet-switched internetwork (i.e. the Internet).

IP Address
Unique address that devices use in order to identify and communicate with each 
other on a computer network utilizing the Internet Protocol standard (IP)—in simpler 
terms, a computer address.

ISO
International Standards Organization. Formats, symbols, transmission rules are 
covered by ISO standards. AFNOR is a member of ISO.

ISP
Internet Service Provider: Business or organization that sells to consumers access 
to the Internet and related services.
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M

MIB
Management Information Base: Database used by the SNMP protocol for network 
management and containing information on data transmission, station or router 
components, etc.

MIB II: standard MIB
Schneider Automation MIB: private MIB

N

NAT
Network Address Translation: is the translation of an Internet Protocol address (IP 
address) used within one network to a different IP address known within another 
network.

NTP
Network Time Protocol: Protocol for synchronizing the clocks of computer systems 
over packet-switched, variable-latency data networks.

O

operating mode
The rules governing the behavior of the module when it is running.

P

PAP
Password Authentication Protocol: Password identification protocol used for 
remote modem connections.

PL7
Schneider Automation PLC programming software.
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PLC
Programmable Logic Controller: It is a small computer used for automation of 
industrial processes, such as control of machinery on factory assembly lines.

PPP
Point-to-Point Protocol: Point-to-point communication protocol used for modem 
connections.

Premium
Family of Schneider Automation PLCs.

PSTN/RTC
Public Switched Telephone Network: The network of the world’s public circuit-
switched telephone networks.

Q

Quantum
Family of Schneider Automation PLCs.

R

RGB
Additive model in which red, green, and blue (often used in additive light models) are 
combined in various ways to reproduce other colors.

RS232
Serial communication standard that in particular defines the following operating 
voltage:

A signal of +3 to +25V indicates a logic 0

A signal of -3V to -25V indicates a logic 1

Between +3V and -3V the signal is regarded as invalid.

RS 232 connections are relatively sensitive to interference. The standard 
recommends not exceeding a distance of 15 meters and a speed of 20,000 baud 
(bps) maximum.
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RS485
Serial connection standard operates at +/-5V differential. The connection uses 
separate wires for transmission and receipt. Their "3-status" outputs allow them to 
switch to listening mode when transmission is completed.

RTU
Remote Terminal Unit.

RUN
Function used to start execution of the application program in the PLC.

S

SCADA
Supervisory Control And Data Acquisition: Software that, interfacing with a 
programmable logic controller, gathers and analyzes information used to monitor 
and control commercial equipment.

SMTP
Simple Mail Transfer Protocol: Application protocol used to transmit messages via 
the Internet and direct them to a mailbox.

SNMP
Simple Network Management Protocol: Network management protocol for 
controlling a network remotely by polling the stations for their status and modifying 
their configuration, performing security tests and viewing information relating to data 
transmission. It can also be used to manage software and databases remotely.

SQL
Structured Query Language: Used to query (request data from) a relational 
database.

T

TCP
Transmission Control Protocol: Virtual circuit protocol that is one of the core 
protocols of the Internet protocol suite, often simply referred to as TCP/IP.
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TCP/IP
The set of communications protocols that implement the protocol stack on which the 
Internet and many commercial networks run.

Time Out
Expiry of a waiting time. Stops the application or disconnects after a lengthy period 
of non-use.

U

UDP
User Datagram Protocol: One of the core protocols of the Internet protocol suite. 
Using UDP, programs on networked computers can send short messages 
sometimes known as datagrams to one another.

URL
Uniform Resource Locator: The global address of documents and other resources 
on the World Wide Web.

V

VPN
Virtual Private Network: A private network that is configured within a public 
network. It uses encryption and other security mechanisms so that only authorized 
users can access the network and that the data cannot be intercepted.

X

XML
Extensible Markup Language: it is aimed to facilitate the sharing of data across 
different information system. It is a simplified subset of the SGML and is designed 
to be relatively human-legible.
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C
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D
Data Editor
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data templates, 148
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datalogging service, 111
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export, 57
external tool

configuration, 277

F
format target, 284

G
getting started, 23

accessing the website, 46
configuring the module, 28
creating services, 32
Data Editor, 38
Graphic Editor, 41
presentation, 24
selecting devices, 26
selecting variables, 30
transfering a project, 43

graphic editor
toolbar, 159

H
HTTP

Graphic Objects, 259
313



Index
I
import, 57
importing a FactoryCast project and web 
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IP address, 64

J
Java applets, 220

M
module

connecting/disconnecting, 72
FTP, 68
IP address, 64

N
namespace, 82

write access, 88

O
online documentation, 68
operator screens

access, 207
import, 206

P
password, 290

configuration, 291
HTTP, 291
write, 291

PC configuration, 15
PLC program viewer, 208
presentation, 14
314
project
device list, 53
global transfer, 68
partial transfer, 68
remove devices, 53
remove items, 55
remove targets, 51
save, 56
selecting devices, 26
target list, 51
target properties, 28
transfer, 65
validation, 69

R
reboot target, 284
recipe database service

configuration, 130
recipe service

configuration, 124

S
security

access, 289
Security

access, 286
firewall, 287
passwords, 286

service
creation, 54

simulation, 76, 79
site explorer, 68
symbol

 name, 82
import from PLC, 83
manual selection, 87

T
transfer status, 70
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variable

Concept, 86
import from PLC, 83
manual selection, 87
name, 82
PL7, 86
selection, 30
Unity Pro, 86

W
Web Designer

close, 56
Workspace directory, 281
write

password, 291
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